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Introduction

1 Introduction
The Texas Instruments® F2806x Firmware Development Package is a collection of device header
files, common source files, helper libraries and example applications for the 2806X line of devices
in the Piccolo portfolio.

The package comes with a complete set of example projects that demonstrate the basics of getting
started with a Piccolo device and working with its different peripheral modules.

Chapter 2 talks about how the software package is structured, how the header files are organized
and used in the example applications. The peripheral bit-field structure approach is presented
in detail along with step-by-step instructions on how to use it in your code. A complete revision
history of the header files is provided at the end of the chapter.

Chapter 3 provides step-by-step instructions on how to create a project from scratch and then go
about debugging it. Its a good place to start if this is your first interaction with a piccolo device.

Chapter 4 covers all the examples provided in the development package; what each example does,
its setup and observation procedures and, in a few cases, the mathematics involved in setting up
control values for peripherals.
The examples for Piccolo(2806x) can be found in the examples\c28 directory. As users move past
evaluation, and get started developing their own application, TI recommends they maintain a similar
project directory structure to that used in the example projects.

Chapter 5 provides details on the prototype CLA compiler including implementation of the C lan-
guage as well as restrictions.

Chapter 6 covers the examples that demonstrate the use of the CLA compiler.

The Appendix covers the following topics

1. Appendix A - describes the default hardware prioritizing of Interrupt Software Routines and
how it can be over-ridden in software.

2. Appendix B - Each factory programmed device from TI has compensation routines in OTP
memory for oscillator drift due to temperature fluctuations. These routines are described here.

3. Appendix C- is the errata to version 6 of the Scale Factor Optimization Library. It describes
updates to any of the SFO v6 library files
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2.1 Device Support

This software package supports 2806x devices. This includes the following: TMS320F28062,
TMS320F28063, TMS320F28064, TMS320F28065, TMS320F28066, TMS320F28067,
TMS320F28068 and TMS320F28069 as well as the PLC and USB variants of these devices.
Throughout this document, TMS320F28062, TMS320F28063, TMS320F28064, TMS320F28065,
TMS320F28066, TMS320F28067, TMS320F28068 and TMS320F28069 are abbreviated as
F28062, F28063, F28064, F28065, F28066, F28067, F28068 and F28069 respectively.

2.2 Introduction

The F2806x C/C++ peripheral header files and example projects facilitate writing in C/C++ Code
for the Texas Instruments TMS320xF2806x devices. The code can be used as a learning tool or as
the basis for a development platform depending on the current needs of the user.

1. Learning Tool
This download includes several example Code Composer StudioTM v 6.0+ 1 projects for a
F2806x development platform.
These examples demonstrate the steps required to initialize the device and utilize the on-chip
peripherals. The provided examples can be copied and modified giving the user a platform to
quickly experiment with different peripheral configurations.
These projects can also be migrated to other devices by simply changing the memory alloca-
tion in the linker command file.

2. Development Platform
The peripheral header files can easily be incorporated into a new or existing project to provide
a platform for accessing the on-chip peripherals using C or C++ code. In addition, the user
can pick and choose functions from the provided code samples as needed and discard the
rest.

To get started this document provides the following information:

1. Overview of the bit-field structure approach used in the F2806x C/C++ peripheral header files.
1Code Composer Studio is a trademark of Texas Instruments (www.ti.com).
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2. Overview of the included peripheral example projects.

3. Steps for integrating the peripheral header files into a new or existing project.

4. Troubleshooting tips and frequently asked questions.

5. Migration tips for users moving from the 280x header files to the F2806x header files.

Finally, this document does not provide a tutorial on writing C code, using Code Composer Studio,
or the C28x Compiler and Assembler. It is assumed that the reader already has a F2806x hardware
platform setup and connected to a host with Code Composer Studio installed. The user should have
a basic understanding of how to use Code Composer Studio to download code through JTAG and
perform basic debug operations.

2.2.1 Revision History(Summary)

1. Version 2.04.00.00

New Example and bug fix. 2.9.

2. Version 2.03.00.00

Examples and common source files bug fixes. 2.9.

3. Version 2.02.00.00

Header, example, and common file bug fixes. 2.9.

4. Version 2.01.00.00

Added Launchpad example and minor documentation corrections. 2.9.

5. Version 2.00.00.00

F2806x package updated and enhanced for C2000Ware. A detailed revision history can
be found in 2.9.

6. Version 1.51

Updates to examples and common files. Updates to MWare USB library. A detailed
revision history can be found in 2.9.

7. Version 1.50

Updates to examples and common files. Several USB library fixes and updates. A detailed
revision history can be found in 2.9.

8. Version 1.41

Header, example, and common file bug fixes from previous version. A detailed revision
history can be found in 2.9.

9. Version 1.40

Header and common file bug fixes from previous version. A detailed revision history can
be found in 2.9.

10. Version 1.36

Examples were portede to CCSv6. Bug fixes from previous version. A detailed revision
history can be found in 2.9.

11. Version 1.35

The source files were updated to support 90MHz operation. A detailed revision history
can be found in 2.9.

12. Version 1.30
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Bug fixes to the source files. A detailed revision history can be found in 2.9.

13. Version 1.20

Release of the C compiler for the CLA - New examples demonstrating the programming
model of the C compiler are available in this version with accompanying documentation.
A detailed revision history can be found in 2.9.

14. Version 1.15

This version includes a new USB bootloader. A detailed revision history can be found in
2.9.

15. Version 1.10

This version includes code corrections and comment fixes to the header files and exam-
ples, and also adds new examples. A detailed revision history can be found in 2.9.

16. Version 1.00

This version is the first release of the F2806x header files and examples. It is an internal
release used for customer trainings and tools releases.

2.2.2 Directory Structure

As installed, the F2806x C/C++ Header Files and Peripheral Examples is partitioned into a well-
defined directory structure(see figure 2.1).

Table 2.1 describes the contents of the main directories used by F2806x header files and peripheral
examples:
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Figure 2.1: F2806x Main Directory Structure

Under the headers and common directories the source files are further broken down into sub-
directories each indicating the type of file. Table 2.2 lists the sub-directories and describes the
types of files found within each:

2.3 Understanding The Peripheral Bit-Field Structure Ap-
proach

The following application note includes useful information regarding the bit-field peripheral structure
approach used by the header files and examples. This method is compared to traditional #define
macros and topics of code efficiency and special case registers are also addressed. The informa-
tion in this application note is important to understand the impact using bit fields can have on your
application code.

Programming TMS320x28xx and 28xxx Peripherals in C/C++ (SPRAA85)
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Directory Description
<base> Base install directory
<base>\docs Documentation including the revision history from the previous

release.
<base>\headers Files required to incorporate the peripheral header files into a

project. The header files use the bit-field structure approach de-
scribed in Section 2.3. Integrating the header files into a new or
existing project is described in Section 2.5.

<base>\examples\c28 Example Code Composer Studio v6 projects. These example
projects illustrate how to configure many of the on-chip peripher-
als. An overview of the examples is given in Section 2.4.

<base>\examples\cla CLA examples(Built with CLA C compiler). These example
projects illustrate the programming model of the CLA in C.

<base>\common Common source files shared across example projects to illustrate
how to perform tasks using header file approach. Use of these
files is optional, but may be useful in new projects. A list of these
files is in Section 2.8.

<base>\MWare Specific peripheral(e.g. USB) libraries, code and header files.

Table 2.1: F2806x Main Directory Structure

Sub-Directory Description
headers\cmd Linker command files that allocate the bit-field structures de-

scribed in Section 2.3.
headers\source Source files required to incorporate the header files into a new or

existing project.
headers\include Header files for each of the on-chip peripherals.
common\cmd Example memory command files that allocate memory on the

devices.
common\include Common .h files that are used by the peripheral examples.
common\source Common .c files that are used by the peripheral examples.
common\targetConfigs Common target configuration (.ccxml) files that are used by the

peripheral examples.

Table 2.2: F2806x Sub-Directory Structure(without MWare)

2.4 Peripheral Example Projects

This section describes how to get started with and configure the peripheral examples included in
the F2806x Header Files and Peripheral Examples software package.

2.4.1 Getting Started in Code Composer Studio v6.0+

To get started, follow these steps to load the 32-bit CPU-Timer example. Other examples are set-up
in a similar manner.

1. Have a hardware platform connected to a host with Code Composer Studio installed
NOTE: As supplied, the F2806x example projects are built for the F28069 device. If
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you are using another F2806x device, the memory definition in the linker command file
(.cmd) will need to be changed and the project rebuilt.

2. Open the example project Each example has its own project directory which is “im-
ported”/opened in Code Composer Studio v6. To open the F2806x CPU-Timer example
project directory, follow the following steps:

In Code Composer Studio v 6.x: Project->Import Existing CCS/CCE Eclipse Project.
Next to “Select Root Directory”, browse to the CPU Timer example directory: exam-
ples\c28\cpu_timer. Select the Finish button. This will import/open the project in the
CCStudio v6.x C/C++ Perspective project window.

3. Edit F2806x_Device.h Edit the F2806x_Device.h file and make sure the appropriate device
is selected. By default the F28069 is selected.

/********************************************************************
headers\include\F2806x_Device.h

********************************************************************/

#define TARGET 1

//
// User To Select Target Device:
//
#define DSP28_28062P 0
#define DSP28_28062UP 0
#define DSP28_28062PZ 0
#define DSP28_28062UPZ 0
...
...
...
#define DSP28_28069P 0
#define DSP28_28069UP 0
#define DSP28_28069PZ 0
#define DSP28_28069UPZ TARGET

4. Edit F2806x_Examples.h Edit F2806x_Examples.h and specify the clock rate, the PLL control
register value (PLLCR and DIVSEL). These values will be used by the examples to initialize
the PLLCR register and DIVSEL bits.
The default values will result in a 90MHz SYSCLKOUT frequency.

/********************************************************************
common\include\F2806x_Examples.h

********************************************************************/
/*-------------------------------------------------------------------
Specify the PLL control register (PLLCR) and divide
select (DIVSEL) value.
--------------------------------------------------------------------*/
//#define DSP28_DIVSEL 0 // Enable /4 for SYSCLKOUT(default at reset)
//#define DSP28_DIVSEL 1 // Disable /4 for SYSCKOUT
#define DSP28_DIVSEL 2 // Enable /2 for SYSCLKOUT
//#define DSP28_DIVSEL 3 // Enable /1 for SYSCLKOUT

#define DSP28_PLLCR 16 // Uncomment for 80 MHz devices
// [80 MHz = (10MHz * 16)/2]
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//#define DSP28_PLLCR 15
//#define DSP28_PLLCR 14
//#define DSP28_PLLCR 13
//#define DSP28_PLLCR 12
...
...
//#define DSP28_PLLCR 3
//#define DSP28_PLLCR 2
//#define DSP28_PLLCR 1
//#define DSP28_PLLCR 0 // PLL is bypassed in this mode
//-------------------------------------------------------------------

In F2806x_Examples.h, also specify the SYSCLKOUT rate. This value is used to scale a delay
loop used by the examples. The default value is for a 80 MHz SYSCLKOUT.

/********************************************************************
common\include\F2806x_Examples.h

********************************************************************/
...
#define CPU_RATE 12.500L // for a 80MHz CPU clock speed (SYSCLKOUT)
//#define CPU_RATE 16.667L // for a 60MHz CPU clock speed (SYSCLKOUT)
//#define CPU_RATE 20.000L // for a 50MHz CPU clock speed (SYSCLKOUT)
//#define CPU_RATE 25.000L // for a 40MHz CPU clock speed (SYSCLKOUT)
...

5. Review the comments at the top of the main source file: Example_2806xCpuTimer.c A
brief description of the example and any assumptions that are made and any external hard-
ware requirements are listed in the comments at the top of the main source file of each exam-
ple. In some cases you may be required to make external connections for the example to work
properly.

6. Perform any hardware setup required by the example Perform any hardware setup indi-
cated by the comments in the main source. The CPU-Timer example doesn’t require any
hardware to be setup. Other examples may require additional hardware configuration such
as connecting pins together or pulling a pin high or low. Table 2.3 shows a listing of the boot
mode pin settings for your reference. Table 2.4 and Table 2.5 list the EMU boot modes (when
emulator is connected) and the Get Mode boot mode options (mode is programmed into OTP)
respectively. Refer to the documentation for your hardware platform for information on config-
uring the boot mode pins. For more information on the F2806x boot modes refer to the device
specific Boot ROM chapter in the Technical Reference Manual.

GPIO37 GPIO34 TRSTn Mode
TDO CMP2OUT

X X 1 EMU Mode
0 0 0 Parallel I/O
0 1 0 SCI
1 0 0 Wait
1 1 0 “Get Mode”

Table 2.3: F2806x Boot Mode Settings

When the emulator is connected for debugging: TRSTn = 1, and therefore the device is in
EMU boot mode. In this situation, the user must write the key value of 0x55AA to EMU_KEY
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EMU_KEY EMU_BMODE Boot Mode Selected
0x0D00 0x0D01

!= 0x55AA x Wait

0x55AA

0x0000 Parallel I/O
0x0001 SCI
0x0002 Wait
0x0003 Get Mode
0x0004 SPI
0x0005 I2C
0x0006 OTP
0x0007 eCAN
0x000A Boot to RAM
0x000B Boot to FLASH
Other Wait

Table 2.4: F2806x EMU Boot Modes (Emulator Connected)

OTP_KEY OTP_BMODE Boot Mode Selected
0x3D7BFB 0x3D7BFE
!= 0x55AA x Get Mode - Flash

0x55AA

0x0001 Get Mode - SCI
0x000B Get Mode - Flash
0x0004 Get Mode - SPI
0x0005 Get Mode - I2C
0x0006 Get Mode - OTP
0x0007 Get Mode - eCAN
Other Get Mode - Flash

Table 2.5: F2806x GET Boot Modes (Emulator Disconnected)

at address 0x0D00 and desired EMU boot mode value to EMU_BMODE at 0x0D01 via the
debugger window according to Table 2.4.
When the emulator is not connected for debugging: SCI or Parallel I/O boot mode can be
selected directly via the GPIO pins, or OTP_KEY at address 0x3D7BFB and OTP_BMODE at
address 0x3D7BFE can be programmed for the desired boot mode per Table 2.5.

7. Build and Load the code
Once any hardware configuration has been completed, in Code Composer Studio v6, go to
Run->Debug. Your program should halt at the main function. This will load the compiled .OUT
image to the device.

8. Run the example, add variables to the watch window or examine the memory contents
At the top of the code in the comments section, there should be a list of “Watch variables”.
To add these to the watch window, highlight them and right-click. Then select Add Watch
expression. Now variables of interest are added to the watch window.

9. Experiment, modify, re-build the example If you wish to modify the examples it is suggested
that you make a copy of the entire header file packet to modify or at least create a backup of
the original files first. New examples provided by TI will assume that the base files are as
supplied.
Sections 2.4.2 and 2.4.2.3 describe the structure and flow of the examples in more detail.

10. When done, delete the project from the Code Composer Studio v6 workspace
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Go to View->C/C++ Projects to open up your project view. To remove/delete the project from
the workspace, right click on the project’s name and select delete. Make sure the Do not
delete contents button is selected, then select Yes. This does not delete the project itself. It
merely removes the project from the workspace until you wish to open/import it again.
The examples use the header files in the headers directory and shared source in the common
directory. Only example files specific to a particular example are located within the example
directory.
NOTE: Most of the example code included uses the “.bit” field structures to access
registers. This is done to help the user learn how to use the peripheral and device.
Using the bit fields has the advantage of yielding code that is easier to read and modify.
This method will result in a slight code overhead when compared to using the “.all”
method. In addition, the example projects have the compiler optimizer turned off. The
user can change the compiler settings to turn on the optimizer if desired.

2.4.2 Example Program Structure

Figure 2.2: Example Program Structure

Each of the example programs has a very similar structure. This structure includes unique source
code, shared source code, header files and linker command files.

/********************************************************************
examples\c28\cpu_timer\Example_2806xCpuTimer.c

********************************************************************/

#include "DSP28x_Project.h" // Device Headerfile and Examples Include File

DSP28x_Project.h
This header file includes F2806x_Cla_typedefs.h, F2806x_Device.h and F2806x_Examples.h.
Because the name is device-generic, example/custom projects can be easily ported between
different device header files. This file is found in the <base>\common\include directory.
F2806x_Cla_typedefs.h
This file redefines the ANSI C standard data types like int, short etc to fit the native bit-width
of the CLA architecture. This file is found in the <base>\common\include directory.
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F2806x_Device.h
This header file is required to use the header files. This file includes all of the required periph-
eral specific header files and includes device specific macros and typedef statements. This
file is found in the <base>\headers\include directory.

F2806x_Examples.h
This header file defines parameters that are used by the example code. This file is not required
to use just the F2806x peripheral header files but is required by some of the common source
files. This file is found in the <base>\common\include directory.

2.4.2.1 Source Code

Each of the example projects consists of source code that is unique to the example as well as
source code that is common or shared across examples.

F2806x_GlobalVariableDefs.c
Any project that uses the F2806x peripheral header files must include this source file. In
this file are the declarations for the peripheral register structure variables and data section
assignments. This file is found in the <base>\headers\source directory.

Example specific source code
Files that are specific to a particular example have the prefix Example_2806x in their
filename. For example Example_2806xCpuTimer.c is specific to the CPU Timer exam-
ple and not used for any other example. Example specific files are located in the
<base>\examples\c28\<example> directory.

Common source code
The remaining source files are shared across the examples. These files contain common
functions for peripherals or useful utility functions that may be re-used. Shared source files
are located in the common\source directory. Users may choose to incorporate none, some, or
the entire shared source into their own new or existing projects.

2.4.2.2 Linker Command Files

Each example uses two linker command files. These files specify the memory where the linker will
place code and data sections. One linker file is used for assigning compiler generated sections
to the memory blocks on the device while the other is used to assign the data sections of the
peripheral register structures used by the F2806x peripheral header files.

Memory block linker allocation
The linker files shown in Table 2.6 are used to assign sections to memory blocks on the device.
These linker files are located in the <base>\common\cmd directory. Each example will use one
of the following files depending on the memory used by the example.

Header file structure data section allocation
Any project that uses the header file peripheral structures must include a linker command file
that assigns the peripheral register structure data sections to the proper memory location.
These files are described in Table 2.7.
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Memory Linker Command Location Description
File Examples
28062_RAM_lnk.cmd common\cmd 28062 SARAM memory linker com-

mand file.
28063_RAM_lnk.cmd common\cmd 28063 SARAM memory linker com-

mand file.
28064_RAM_lnk.cmd common\cmd 28064 SARAM memory linker com-

mand file.
28065_RAM_lnk.cmd common\cmd 28065 SARAM memory linker com-

mand file.
28065_RAM_CLA_lnk.cmd common\cmd 28065 SARAM CLA memory linker

command file.
28065_RAM_CLA_C_lnk.cmd common\cmd 28065 SARAM CLA C compilermem-

ory linker command file.
28066_RAM_lnk.cmd common\cmd 28066 SARAM memory linker com-

mand file.
28067_RAM_lnk.cmd common\cmd 28067 SARAM memory linker com-

mand file.
28068_RAM_lnk.cmd common\cmd 28068 SARAM memory linker com-

mand file.
28069_RAM_lnk.cmd common\cmd 28069 SARAM memory linker com-

mand file.
28069_RAM_CLA_lnk.cmd common\cmd 28069 SARAM CLA memory linker

command file. Includes CLA message
RAM.

28069_RAM_CLA_C_lnk.cmd common\cmd 28069 SARAM CLA C compiler mem-
ory linker command file. Includes CLA
message RAM.

28065_RAM_CLA_lnk.cmd common\cmd 28065 SARAM CLA memory linker
command file.

F28062.cmd common\cmd F28062 memory linker command file.
Includes all Flash, OTP and CSM
password protected memory locations.

F28063.cmd common\cmd F28063 memory linker command file.
F28064.cmd common\cmd F28064 memory linker command file.
F28065.cmd common\cmd F28065 memory linker command file.
F28066.cmd common\cmd F28066 memory linker command file.
F28067.cmd common\cmd F28067 memory linker command file.
F28068.cmd common\cmd F28068 memory linker command file.
F28069.cmd common\cmd F28069 memory linker command file.

Table 2.6: Included Memory Linker Command Files

2.4.2.3 Documentation

This document is linked into each project so it can easily be opened through the project view. To
do this, right click on the document within CCS, select “open with” and “system editor”.
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Header File Linker Location Description
Command File
F2806x_Headers_BIOS.cmd headers\cmd Linker .cmd file to assign the header

file variables in a BIOS project. This file
must be included in any BIOS project
that uses the header files. Refer to sec-
tion 2.5.2.

F2806x_Headers_nonBIOS.cmd headers\cmd Linker .cmd file to assign the header
file variables in a non-BIOS project.
This file must be included in any non-
BIOS project that uses the header files.
Refer to section 2.5.2.

Table 2.7: F2806x Peripheral Header Linker Command File

2.4.3 Example Program Flow

All of the example programs follow a similar recommended flow for setting up a F2806x device.
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Figure 2.3: Flow for Example Programs

2.4.4 Included Examples

See Chapter 4 for a complete listing and description of available examples

2.4.5 Executing the Examples From Flash

Most of the F2806x examples execute from SARAM in “boot to SARAM” mode. One example,
examples\c28\flash_f28069, executes from flash memory in “boot to flash” mode. This example is
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the PWM timer interrupt example with the following changes made to execute out of flash:

1. Change the linker command file to link the code to flash
Remove 28069_RAM_lnk.cmd from the project and link one of the flash based linker files (ex:
F28069.cmd). These files are located in the <base>common\cmd directory.

2. Link the common\source\F2806x_CSMPasswords.asm to the project
This file contains the passwords that will be programmed into the Code Security Module (CSM)
password locations. Leaving the passwords set to 0xFFFF during development is recom-
mended as the device can easily be unlocked. For more information on the CSM refer to the
appropriate System Control and Interrupts chapter of the Technical Reference Manual.

3. Modify the source code to copy all functions that must be executed out of SARAM from
their load address in flash to their run address in SARAM
In particular, the flash wait state initialization routine must be executed out of SARAM. In the
F2806x, functions that are to be executed from SARAM have been assigned to the ramfuncs
section by compiler CODE_SECTION #pragma statements as shown in the example below.

/********************************************************************
common\source\F2806x_SysCtrl.c

********************************************************************/

#pragma CODE_SECTION(InitFlash, "ramfuncs");

The ramfuncs section is then assigned to a load address in flash and a run address in SARAM
by the memory linker command file as shown below:

/********************************************************************
common\include\F28069.cmd

********************************************************************/
SECTIONS
{

ramfuncs : LOAD = FLASHA,
RUN = RAML0,
LOAD_START(_RamfuncsLoadStart),
LOAD_END(_RamfuncsLoadEnd),
RUN_START(_RamfuncsRunStart),
LOAD_SIZE(_RamfuncsLoadSize),
PAGE = 0

}

The linker will create symbols for the block “ramfuncs”. These are described in the Table 2.8.

Address Symbol
Load start address RamfuncsLoadStart
Load end address RamfuncsLoadEnd
Run start address RamfuncsRunStart
Load Size RamfuncsLoadSize

Table 2.8: Linker Symbol assignment

These symbols can then be used to copy the functions from the Flash to SARAM using the C
library standard memcpy() function.
To perform this copy from flash to SARAM using the included example memcpy() function:
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(a) Include string.h at the top of the file.
NOTE: IF RUNNING FROM FLASH, PLEASE COPY OVER THE SECTION “ramfuncs”
FROM FLASH TO RAM PRIOR TO CALLING InitSysCtrl() or InitAdc(). THIS PRE-
VENTS THE MCU FROM THROWING AN EXCEPTION WHEN A CALL TO DELAY_US()
IS MADE.

(b) Add the following variable declaration to your source code to tell the compiler that these
variables exist. The linker command file will assign the address of each of these variables
as specified in the linker command file as shown in step 3. For the F2806x example code
this has is already done in F2806x_GlobalPrototypes.h.
/********************************************************************
common\include\F2806x_GlobalPrototypes.h

********************************************************************/

extern Uint16 RamfuncsLoadStart;
extern Uint16 RamfuncsLoadEnd;
extern Uint16 RamfuncsRunStart;
extern Uint16 RamfuncsLoadSize;

(c) Modify the code to call the example memcpy function for each section that needs to be
copied from flash to SARAM.
/********************************************************************
examples\c28\Flash source file

********************************************************************/

memcpy(&RamfuncsRunStart, &RamfuncsLoadStart, (Uint32)&RamfuncsLoadSize);

4. Modify the code to call the flash initialization routine
This function will initialize the wait states for the flash and enable the Flash Pipeline mode.

/********************************************************************
F2806x peripheral example .c file

********************************************************************/

InitFlash();

5. Set the required jumpers for “boot to Flash” mode The required jumper settings for each
boot mode are shown in Table 2.3, Table 2.4, and Table 2.5.

6. Program the device with the built code
In Code Composer Studio v6, when code is loaded into the device during debug, it automati-
cally programs to flash memory.
This can also be done using SDFlash available from Spectrum Digital’s website (Spectrum
Digital).
These tools will be updated to support new devices as they become available. Please check
for updates.

7. In Code Composer Studio v3, to debug, load the project in CCS, select File->Load
Symbols->Load Symbols Only
It is useful to load only symbol information when working in a debugging environment where
the debugger cannot or need not load the object code, such as when the code is in ROM or
flash. This operation loads the symbol information from the specified file.
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2.5 Steps for Incorporating the Header Files and Sample
Code

Follow these steps to incorporate the peripheral header files and sample code into your own
projects. If you already have a project that uses the DSP280x or DSP281x header files then also
refer to Section 2.7 for migration tips.

2.5.1 Before you begin

Before you include the header files and any sample code into your own project, it is recommended
that you perform the following:

1. Load and step through an example project
Load and step through an example project to get familiar with the header files and sample
code. This is described in Section 2.4.

2. Create a copy of the source files you want to use
headers: code required to incorporate the header files into your project common: shared
source code much of which is used in the example projects. examples\c28: F806x floating-
point compiled example projects that use the header files and shared code.

2.5.2 Including the F2806x Peripheral Header Files

Including the F2806x header files in your project will allow you to use the bit-field structure approach
in your code to access the peripherals on the DSP. To incorporate the header files in a new or
existing project, perform the following steps:

1. #include “F2806x_Device.h” (or #include “DSP28x_Project.h” ) in your source files
The F2806x_Device.h include file will in-turn include all of the peripheral specific header files
and required definitions to use the bit-field structure approach to access the peripherals.

/********************************************************************
User’s source file

********************************************************************/

#include "F2806x_Device.h"

Another option is to #include “DSP28x_Project.h” in your source files, which in-turn includes
“F2806x_Cla_typedefs.h”,“F2806x_Device.h” and “F2806x_Examples.h” (if it is not necessary
to include common source files in the user project, the #include “F2806x_Examples.h” line
can be deleted). Due to the device-generic nature of the file name, user code is easily ported
between different device header files.

/********************************************************************
User’s source file

********************************************************************/

#include "DSP28x_Project.h"
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2. Edit F2806x_Device.h and select the target you are building for
In the below example, the file is configured to build for the 28069 device.

/********************************************************************
headers\include\F2806x_Device.h

********************************************************************/
#define TARGET 1

//
// User To Select Target Device:
//
#define DSP28_28062P 0
#define DSP28_28062UP 0
#define DSP28_28062PZ 0
#define DSP28_28062UPZ 0
...
...
...
#define DSP28_28069P 0
#define DSP28_28069UP 0
#define DSP28_28069PZ 0
#define DSP28_28069UPZ TARGET

By default, the 28069 device is selected.

3. Add the source file F2806x_GlobalVariableDefs.c to the project
This file is found in the headers\source directory and includes:

Declarations for the variables that are used to access the peripheral registers.
Data section #pragma assignments that are used by the linker to place the variables in
the proper locations in memory.

4. Add the appropriate F2806x header linker command file to the project. As described in
Section 2.4, when using the F2806x header file approach, the data sections of the peripheral
register structures are assigned to the memory locations of the peripheral registers by the
linker.
To perform this memory allocation in your project, one of the following linker command files
located in headers\cmd must be included in your project:

For non-DSP/BIOS2 projects: F2806x_Headers_nonBIOS.cmd
For DSP/BIOS projects: F2806x_Headers_BIOS.cmd

The method for adding the header linker file to the project depends on preference
Method #1:

Right-click on the project in the project window of the C/C++ Projects perspective.
Select Link Files to Project...
Navigate to the headers\cmd directory on your system and select the desired .cmd file.

Note: The limitation with Method #1 is that the path to <install direc-
tory>\headers\cmd\<cmd file>.cmd is fixed on your PC. If you move the installation
directory to another location on your PC, the project will “break” because it still expects
the .cmd file to be in the original location. Use Method #2 if you are using “linked
variables” in your project to ensure your project/installation directory is portable
across computers and different locations on the same PC. For more information, see:

2DSP/BIOS is a trademark of Texas Instruments
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C2000 Getting Started with Code Composer Studio v6

Method #2:

Right-click on the project in the project window of the C/C++ Projects perspective.
Select New->File.
Click on the Advanced» button to expand the window.
Check the Link to file in the file system check-box.
Select the Variables... button. From the list, pick the linked variable associated with your
installation directory. (e.g. INSTALLROOT_2806X). For more information on linked vari-
ables, see: C2000 Getting Started with Code Composer Studio v6
Click on the Extend... button. Navigate to the desired .cmd file and select OK.

5. Add the directory path to the F2806x header files to your project
Code Composer Studio 6.x:
To specify the directory where the header files are located:

Open the menu: Project->Properties.
In the menu on the left, select “C/C++ Build”.
In the “Tool Settings” tab, Select “C2000 Compiler -> Include Options:”
In the “Add dir to #include search path (–include_path, -I)” window, select the “Add” icon
in the top right corner.
Select the “File system...” button and navigate to the directory path of headers\include on
your system.

Figure 2.4: Adding device header file directories to the include search path

6. Additional suggested build options The following are additional compiler and linker options.
The options can all be set via the Project-> Properties->Tool Settings sub-menus.

C2000 Compiler
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• -ml Select Runtime Model Options and check -ml Build for large memory model.
This setting allows data sections to reside anywhere within the 4M-memory reach of
the 28x devices.

• -pdr Select Diagnostic Options and check -pdr Issue non-serious warnings. The
compiler uses a warning to indicate code that is valid but questionable. In many
cases, these warnings issued by enabling -pdr can alert you to code that may cause
problems later on.

C2000 Linker
• -w Select Diagnostics and check -w Warn about output sections. This option will

alert you if any unassigned memory sections exist in your code. By default the linker
will attempt to place any unassigned code or data section to an available memory
location without alerting the user. This can cause problems, however, when the section
is placed in an unexpected location.

• -e Select Symbol Management and enter Program Entry Point -e Defines a
global symbol that specifies the primary entry point for the output module. For the
F2806x examples, this is the symbol “code_start”. This symbol is defined in the
common\source\F2806x_CodeStartBranch.asm file. When you load the code in Code
Composer Studio, the debugger will set the PC to the address of this symbol. If you
do not define an entry point using the -e option, then the linker will use _c_int00 by
default.

2.5.3 Including Common Example Code

Including the common source code in your project will allow you to leverage code that is already
written for the device. To incorporate the shared source code into a new or existing project, perform
the following steps:

1. #include “F2806x_Examples.h” (or “DSP28x_Project.h”) in your source files.
The “F2806x_Examples.h” include file will include common definitions and declarations used
by the example code.

/********************************************************************
User’s source file

********************************************************************/

#include "F2806x_Examples.h"

Another option is to #include “DSP28x_Project.h” in your source files, which in-turn includes
“F2806x_Cla_typedefs.h”,“F2806x_Device.h” and “F2806x_Examples.h”. Due to the device-
agnostic nature of the file name, user code is easily ported between different device header
files.

/********************************************************************
User’s source file

********************************************************************/

#include "DSP28x_Project.h"
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2. Add the directory path to the example include files to your project. To specify the directory
where the header files are located:

Open the menu: Project->Properties.
In the menu on the left, select “C/C++ Build”.
In the “Tool Settings” tab, Select “C2000 Compiler -> Include Options:”
In the “Add dir to #include search path (–include_path, -I)” window, select the “Add” icon
in the top right corner.
Select the “File system...” button and navigate to the directory path of headers\include on
your system.

Figure 2.5: Adding Example header directories to the include search path

3. Link a linker command file to your project.
The following memory linker .cmd files are provided as examples in the common\cmd directory.
For getting started the basic 28069_RAM_lnk.cmd file is suggested and used by most of the
examples.

Memory Linker Command Location Description
File Examples

28062_RAM_lnk.cmd common\cmd 28062 SARAM memory linker com-
mand file.

28063_RAM_lnk.cmd common\cmd 28063 SARAM memory linker com-
mand file.

28064_RAM_lnk.cmd common\cmd 28064 SARAM memory linker com-
mand file.

28065_RAM_lnk.cmd common\cmd 28065 SARAM memory linker com-
mand file.

28066_RAM_lnk.cmd common\cmd 28066 SARAM memory linker com-
mand file.

28067_RAM_lnk.cmd common\cmd 28067 SARAM memory linker com-
mand file.

28068_RAM_lnk.cmd common\cmd 28068 SARAM memory linker com-
mand file.

Continued on next page
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Table 2.9 – continued from previous page
Memory Linker Command Location Description

File Examples
28069_RAM_lnk.cmd common\cmd 28069 SARAM memory linker com-

mand file.
28065_RAM_CLA_C_lnk.cmd common\cmd 28065 SARAM CLA C compilermem-

ory linker command file.
28069_RAM_CLA_lnk.cmd common\cmd 28069 SARAM CLA memory linker

command file. Includes CLA message
RAM.

28065_RAM_CLA_lnk.cmd common\cmd 28065 SARAM CLA memory linker
command file.

28069_RAM_CLA_C_lnk.cmd common\cmd 28069 SARAM CLA C compiler mem-
ory linker command file. Includes CLA
message RAM.

F28062.cmd common\cmd F28062 memory linker command file.
Includes all Flash, OTP and CSM
password protected memory locations.

F28063.cmd common\cmd F28063 memory linker command file.
F28064.cmd common\cmd F28064 memory linker command file.
F28065.cmd common\cmd F28065 memory linker command file.
F28066.cmd common\cmd F28066 memory linker command file.
F28067.cmd common\cmd F28067 memory linker command file.
F28068.cmd common\cmd F28068 memory linker command file.
F28069.cmd common\cmd F28069 memory linker command file.

Table 2.9: Included Main Linker Command Files

4. Set the CPU Frequency In the common\include\F2806x_Examples.h file specify the proper
CPU frequency. Some examples are included in the file.

/********************************************************************
common\include\F2806x_Examples.h

********************************************************************/
...
#define CPU_RATE 12.500L // for a 80MHz CPU clock speed (SYSCLKOUT)
//#define CPU_RATE 16.667L // for a 60MHz CPU clock speed (SYSCLKOUT)
//#define CPU_RATE 20.000L // for a 50MHz CPU clock speed (SYSCLKOUT)
//#define CPU_RATE 25.000L // for a 40MHz CPU clock speed (SYSCLKOUT)
...

5. Link desired common source files to the project The common source files are found in the
common\source directory.

6. Include .c files for the PIE Since all catalog 2806x applications make use of the PIE interrupt
block, you will want to include the PIE support .c files to help with initializing the PIE. The shell
ISR functions can be used directly or you can re-map your own function into the PIE vector
table provided. A list of these files can be found in section 2.8.2.1
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2.6 Troubleshooting Tips and Frequently Asked Ques-
tions

In the examples, what do “EALLOW;” and “EDIS;” do?
EALLOW; is a macro defined in F2806x_Device.h for the assembly instruction EALLOW and
likewise EDIS is a macro for the EDIS instruction. That is EALLOW; is the same as embedding
the assembly instruction __asm(“ EALLOW”);
Several control registers on the 28x devices are protected from spurious CPU writes by the
EALLOW protection mechanism. The EALLOW bit in status register 1 indicates if the protec-
tion is enabled or disabled. While protected, all CPU writes to the register are ignored and only
CPU reads, JTAG reads and JTAG writes are allowed. If this bit has been set by execution of
the EALLOW instruction, then the CPU is allowed to freely write to the protected registers. Af-
ter modifying the registers, they can once again be protected by executing the EDIS assembly
instruction to clear the EALLOW bit.
For a complete list of protected registers, refer to System Control and Interrupts chapter of the
Technical Reference Manual

Peripheral registers read back 0x0000 and/or cannot be written to
There are a few things to check:

• Peripheral registers cannot be modified or unless the clock to the specific peripheral is
enabled. The function InitPeripheralClocks() in the common\source directory shows an
example of enabling the peripheral clocks.

• Some peripherals are not present on all 2806x family derivatives. Refer to the device
datasheet for information on which peripherals are available.

• The EALLOW bit protects some registers from spurious writes by the CPU. If your program
seems unable to write to a register, then check to see if it is EALLOW protected. If it
is, then enable access using the EALLOW assembly instruction. See System Control
and Interrupts chapter in the Technical Reference Manual for a complete list of EALLOW
protected registers.

Memory block L0, L1 read back all 0x0000
In this case most likely the code security module is locked and thus the protected memory
locations are reading back all 0x0000. Refer to the System Control and Interrupts chapter in
the Technical Reference Manual for information on the code security module.

Code cannot write to L0 or L1 memory blocks
In this case most likely the code security module is locked and thus the protected memory
locations are reading back all 0x0000. Code that is executing from outside of the protected
cannot read or write to protected memory while the CSM is locked. Refer to the System
Control and Interrupts chapter in the Technical Reference Manual for information on the code
security module

A peripheral register reads back ok, but cannot be written to
The EALLOW bit protects some registers from spurious writes by the CPU. If your program
seems unable to write to a register, then check to see if it is EALLOW protected. If it is, then
enable access using the EALLOW assembly instruction. See System Control and Interrupts
chapter in the Technical Reference Manual for a complete list of EALLOW protected registers.

I re-built one of the projects to run from Flash and now it doesn’t work. What could be
wrong?
Make sure all initialized sections have been moved to flash such as .econst and .switch. If you
are using SDFlash, make sure that all initialized sections, including .econst, are allocated to
page 0 in the linker command file (.cmd). SDFlash will only program sections in the .out file
that are allocated to page 0.
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Why do the examples populate the PIE vector table and then re-assign some of the
function pointers to other ISRs?
The examples share a common default ISR file. This file is used to populate the PIE vector
table with pointers to default interrupt service routines. Any ISR used within the example is
then remapped to a function within the same source file. This is done for the following reasons:

• The entire PIE vector table is enabled, even if the ISR is not used within the example. This
can be very useful for debug purposes.

• The default ISR file is left unmodified for use with other examples or your own project as
you see fit.

• It illustrates how the PIE table can be updated at a later time.

When I build the examples, the linker outputs the following: warning: entry point other
than _c_int00 specified. What does this mean?
This warning is given when a symbol other than _c_int00 is defined as the code entry point
of the project. For these examples, the symbol code_start is the first code that is executed
after exiting the boot ROM code and thus is defined as the entry point via the -e linker option.
This symbol is defined in the F2806x_CodeStartBranch.asm file. The entry point symbol is
used by the debugger and by the hex utility. When you load the code, CCS will set the PC to
the entry point symbol. By default, this is the _c_int00 symbol which marks the start of the C
initialization routine. For the F2806x examples, the code_start symbol is used instead. Refer
to the source code for more information.

When I build many of the examples, the compiler outputs the following: remark: con-
trolling expression is constant. What does this mean?
Some of the examples run forever until the user stops execution by using a while(1) loop. The
remark refers to the while loop using a constant and thus the loop will never be exited.

When I build some of the examples, the compiler outputs the following: warning: state-
ment is unreachable. What does this mean?
Some of the examples run forever until the user stops execution by using a while(1) loop. If
there is code after this while(1) loop then it will never be reached.

I changed the build configuration of one of the projects from “Debug” to “Release” and
now the project will not build. What could be wrong?
When you switch to a new build configuration (Project->Active Build Configuration) the com-
piler and linker options changed for the project. The user must enter other options such as
include search path and the library search path. Open the build options menu (Project-> Op-
tions) and enter the following information:

• C2000 Compiler, Include Options: Include search path
• C2000 Linker, File Search Path: Library search path
• C2000 Linker, File Search Path: Include libraries(i.e. rts2800_ml.lib)

Refer to section 2.5.3 for more details.

In the flash example I loaded the symbols and ran to main. I then set a breakpoint but
the breakpoint is never hit. What could be wrong?
In the Flash example, the InitFlash function and several of the ISR functions are copied out
of flash into SARAM. When you set a breakpoint in one of these functions, Code Composer
will insert an ESTOP0 instruction into the SARAM location. When the ESTOP0 instruction is
hit, program execution is halted. CCS will then remove the ESTOP0 and replace it with the
original opcode. In the case of the flash program, when one of these functions is copied from
Flash into SARAM, the ESTOP0 instruction is overwritten by code. This is why the breakpoint
is never hit. To avoid this, set the breakpoint after the SARAM functions have been copied to
SARAM.
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The eCAN control registers require 32-bit write accesses
The compiler will instead make a 16-bit write accesses if it can in order to improve code size
and/or performance. This can result in unpredictable results.
One method to avoid this is to create a duplicate copy of the eCAN control registers in RAM.
Use this copy as a shadow register. First copy the contents of the eCAN register you want
to modify into the shadow register. Make the changes to the shadow register and then write
the data back as a 32-bit value. This method is shown in the examples\c28\ecan_back2back
example project.

2.6.1 Effects of read-modify-write instructions

When writing any code, whether it be C or assembly, keep in mind the effects of read-modify-write
instructions.
The 28x DSP will write to registers or memory locations 16 or 32-bits at a time. Any instruction
that seems to write to a single bit is actually reading the register, modifying the single bit, and then
writing back the results. This is referred to as a read-modify-write instruction. For most registers
this operation does not pose a problem. A notable exception is:

1. Registers with multiple flag bits in which writing a 1 clears that flag
For example, consider the PIEACK register. Bits within this register are cleared when writing
a 1 to that bit. If more then one bit is set, performing a read-modify-write on the register may
clear more bits then intended.
The below solution is incorrect. It will write a 1 to any bit set and thus clear all of them:

/********************************************************************
User’s source file

********************************************************************/

PieCtrl.PIEACK.bit.Ack1 = 1; // INCORRECT! May clear more bits.

The correct solution is to write a mask value to the register in which only the intended bit will
have a 1 written to it:

/********************************************************************
User’s source file

********************************************************************/

#define PIEACK_GROUP1 0x0001
...

PieCtrl.PIEACK.all = PIEACK_GROUP1; // CORRECT!

2. Registers with Volatile Bits
Some registers have volatile bits that can be set by external hardware.
Consider the PIEIFRx registers. An atomic read-modify-write instruction will read the 16-bit
register, modify the value and then write it back. During the modify portion of the operation a
bit in the PIEIFRx register could change due to an external hardware event and thus the value
may get corrupted during the write.
The rule for registers of this nature is to never modify them during runtime. Let the CPU take
the interrupt and clear the IFR flag.
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2.7 Migration Tips for moving from the TMS320x280x
header files to the TMS320x2806x header files

This section includes suggestions for moving a project from the 280x header files to the 2806x
header files.

1. Create a copy of your project to work with or back-up your current project

2. Open the project file(s) in a text editor
In Code Composer Studio v6.x:
Open the .project and .cproject files in your example folder. Replace all instances of 280x
with 2806x so that the appropriate source files and build options are used. Check the path
names to make sure they point to the appropriate header file and source code directories.
Also replace the header file version number for the paths and macro names as well where
appropriate. For instance, if a macro name was INSTALLROOT_280X for your 280x project
using 280x header files, change this to INSTALLROOT_2806X to migrate to the 2806x header
files. If not using the default macro name for your header file version, be sure to change your
macros according to your chosen macro name in the .project and .cproject files.

3. Load the project into Code Composer Studio
Use the Edit-> find in files dialog to find instances of DSP280x_Device.h and
DSP280x_Example.h for 280x header files. Replace these with F2806x_Device.h and
F2806x_Example.h respectively (or instead with one DSP28x_Project.h file).

4. Make sure you are using the correct linker command files (.cmd) appropriate for your
device and for the F2806x header files
You will have one file for the memory definitions and one file for the header file structure
definitions. Using a 280x memory file can cause issues since the H0 memory block has been
split, renamed, and/or moved on the 2806x.

5. Build the project
The compiler will highlight areas that have changed. If migrating from the TMS320x280x
header files, code should be mostly compatible after all instances of DSP280x are replaced
with F2806x in all relevant files, and the above steps are taken. Additionally, several bits have
been removed and/or replaced. See Table 2.10.

Bit Name
Peripheral Register Old New Comment

SysCtrlRegs XCLK Reserved(bit 6) XCLKINSEL(bit 6) On 2806x devices, XCLKIN can
be fed via a GPIO pin. This
bit selects either GPIO38 (de-
fault) or GPIO19 as XCLKIN in-
put source.

PLLSTS CLKINDIV(bit 1) DIVSEL (bits 8,7) DIVSEL allows more values by
which CLKIN can be divided.

Table 2.10: Summary of Register and Bit-Name Changes from DSP280x to F2806x

Additionally, unlike the DSP280x devices, the F2806x devices run off an internal oscillator (IN-
TOSC1) by default. To switch between the 2 available internal clock sources and the traditional
external oscillator clock source, a new register in the System Control register space - CLKCTL - is
available.
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2.8 Packet Contents

This section lists all of the files included in the release.

2.8.1 Header File Support - headers

The F2806x header files are located in the <base>\headers directory.

2.8.1.1 F2806x Header Files - Main Files

The files listed in Table 2.11 must be added to any project that uses the F2806x header files. Refer
to section 2.5 for information on incorporating the header files into a new or existing project.

File Location Description
F2806x_Device.h headers\include Main include file. Include this

one file in any of your .c source
files. This file in-turn includes
all of the peripheral specific .h
files listed below. In addition the
file includes typedef statements
and commonly used mask val-
ues. Refer to section 2.5.

F2806x_GlobalVariableDefs.c headers\source Defines the variables that are
used to access the periph-
eral structures and data sec-
tion #pragma assignment state-
ments. This file must be in-
cluded in any project that uses
the header files. Refer to section
2.5.

F2806x_Headers_nonBIOS.cmd headers\cmd Linker .cmd file to assign the
header file variables in a non-
BIOS project. This file must
be included in any non-BIOS
project that uses the header
files. Refer to section 2.5.

Table 2.11: F2806x Header Files - Main Files

2.8.1.2 F2806x Header Files - Peripheral Bit-Field and Register Structure Definition Files

The files listed in Table 2.12 define the bit-fields and register structures for each of the periph-
erals on the 2806x devices. These files are automatically included in the project by including
F2806x_Device.h. Refer to section 2.4.2 for more information on incorporating the header files
into a new or existing project.
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File Description
F2806x_Adc.h ADC register structure and bit-field definitions.

F2806x_BootVars.h External boot variable definitions.
F2806x_Cla.h CLA register structure and bit-field definitions

F2806x_Comp.h Comparator register structure and bit-field definitions.
F2806x_CpuTimers.h CPU-Timer register structure and bit-field definitions.
F2806x_DevEmu.h Emulation register definitions

F2806x_Dma.h DMA register structure and bit-field definitions
F2806x_ECan.h eCAN register structures and bit-field definitions.
F2806x_ECap.h eCAP register structures and bit-field definitions.
F2806x_EPwm.h ePWM register structures and bit-field definitions.
F2806x_EQep.h eQEP register structures and bit-field definitions.
F2806x_Gpio.h General Purpose I/O (GPIO) register structures and bit-field def-

initions.
F2806x_HRCap.h High-Resolution Capture register structure and bit-field defini-

tions.
F2806x_I2c.h I2C register structure and bit-field definitions.

F2806x_Mcbsp.h McBSP register structures and bit-field definitions.
F2806x_NmiIntrupt.h NMI interrupt register structure and bit-field definitions

F2806x_PieCtrl.h PIE control register structure and bit-field definitions.
F2806x_PieVect.h Structure definition for the entire PIE vector table.

F2806x_Sci.h SCI register structure and bit-field definitions.
F2806x_Spi.h SPI register structure and bit-field definitions.

F2806x_SysCtrl.h System register definitions. Includes Watchdog, PLL, CSM,
Flash/OTP, Clock registers.

F2806x_Usb.h USB register structure and bit-field definitions.
F2806x_XIntrupt.h External interrupt register structure and bit-field definitions.

Table 2.12: F2806x Header File Bit-Field Register Structure Definition Files(headers\include)

2.8.1.3 Variable Names and Data Sections

This section is a summary of the variable names and data sections allocated by the head-
ers\source\F2806x_GlobalVariableDefs.c file as shown in Table 2.13. Note that all peripherals may
not be available on a particular 2806x device. Refer to the device datasheet for the peripheral mix
available on each 2806x family derivative.

Peripheral Starting Address Structure Variable Name
ADC 0x007100 AdcRegs
ADC Mirrored Result Registers 0x000B00 AdcMirror
CLA1 0x001400 Cla1Regs
Code Security Module 0x000AE0 CsmRegs
Code Security Module Password Locations 0x3F7FF8-0x3F7FFF CsmPwl
COMP1 0x006400 Comp1Regs
COMP2 0x006420 Comp2Regs
COMP3 0x006440 Comp3Regs
CPU Timer 0 0x000C00 CpuTimer0Regs
CPU Timer 1 0x000C08 CpuTimer1Regs

Continued on next page
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Table 2.13 – continued from previous page
Peripheral Starting Address Structure Variable Name
CPU Timer 2 0x000C10 CpuTimer2Regs
Device and Emulation Registers 0x000880 DevEmuRegs
System Power Control Registers 0x00985 SysPwrCtrlRegs
eCAN-A 0x006000 ECanaRegs
eCAN-A Mail Boxes 0x006100 ECanaMboxes
eCAN-A Local Acceptance Masks 0x006040 ECanaLAMRegs
eCAN-A Message Object Time Stamps 0x006080 ECanaMOTSRegs
eCAN-A Message Object Time-Out 0x0060C0 ECanaMOTORegs
ePWM1 0x006800 EPwm1Regs
ePWM2 0x006840 EPwm2Regs
ePWM3 0x006880 EPwm3Regs
ePWM4 0x0068C0 EPwm4Regs
ePWM5 0x006900 EPwm5Regs
ePWM6 0x006940 EPwm6Regs
ePWM7 0x006980 EPwm7Regs
ePWM8 0x0069C0 EPwm8Regs
eCAP1 0x006A00 ECap1Regs
eCAP2 0x006A20 ECap2Regs
eCAP3 0x006A40 ECap3Regs
eQEP1 0x006B00 EQep1Regs
eQEP2 0x006B40 EQep2Regs
External Interrupt Registers 0x007070 XIntruptRegs
Flash OTP Configuration Registers 0x000A80 FlashRegs
General Purpose I/O Data Registers 0x006fC0 GpioDataRegs
General Purpose Control Registers 0x006F80 GpioCtrlRegs
General Purpose Interrupt Registers 0x006fE0 GpioIntRegs
I2C 0x007900 I2caRegs
DMA 0x001000 DmaRegs
HRCAP1 0x006AC0 HRCap1Regs
HRCAP2 0x006AE0 HRCap2Regs
HRCAP3 0x006C80 HRCap3Regs
HRCAP4 0x006CA0 HRCap4Regs
NMI Interrupt 0x7060 NmiIntruptRegs
PIE Control 0x000CE0 PieCtrlRegs
SCI-A 0x007050 SciaRegs
SCI-B 0x007750 ScibRegs
SPI-A 0x007040 SpiaRegs
SPI-B 0x007740 SpibRegs

Table 2.13: F2806x Variable Names and Data Sections
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2.8.2 Common Example Code - common

2.8.2.1 Peripheral Interrupt Expansion (PIE) Block Support

In addition to the register definitions defined in F2806x_PieCtrl.h, this packet provides the basic
ISR structure for the PIE block. These files are shown in Table 2.14.

File Location Description
F2806x_DefaultIsr.c common\source Shell interrupt service routines

(ISRs) for the entire PIE vector
table. You can choose to popu-
late one of functions or re-map
your own ISR to the PIE vector
table. Note: This file is not used
for DSP/BIOS projects.

F2806x_DefaultIsr.h common\include Function prototype state-
ments for the ISRs in
F2806x_DefaultIsr.c. Note: This
file is not used for DSP/BIOS
projects.

F2806x_PieVect.c common\source Creates an instance of the PIE
vector table structure initialized
with pointers to the ISR func-
tions in F2806x_DefaultIsr.c.
This instance can be copied to
the PIE vector table in order to
initialize it with the default ISR
locations.

Table 2.14: Basic PIE Block Specific Support Files

In addition, the files in Table 2.15 are included for software prioritizing of interrupts. These files are
used in place of those above when additional software prioritizing of the interrupts is required. Refer
to the example and documentation in examples\c28\sw_prioritized_interrupts for more information.
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File Location Description
F2806x_SWPrioritizedDefaultIsr.c common\source Default shell interrupt service

routines (ISRs). These are shell
ISRs for all of the PIE interrupts.
You can choose to populate one
of functions or re-map your own
interrupt service routine to the
PIE vector table. Note: This
file is not used for DSP/BIOS
projects.

F2806x_SWPrioritizedIsrLevels.h common\include Function prototype state-
ments for the ISRs in
F2806x_DefaultIsr.c. Note: This
file is not used for DSP/BIOS
projects.

F2806x_SWPrioritizedPieVect.c common\source Creates an instance of the PIE
vector table structure initialized
with pointers to the default ISR
functions that are included in
F2806x_DefaultIsr.c. This in-
stance can be copied to the PIE
vector table in order to initialize
it with the default ISR locations.

Table 2.15: Software Prioritized Interrupt PIE Block Specific Support Files

2.8.2.2 Peripheral Specific Files

Several peripheral specific initialization routines and support functions are included in the peripheral
.c source files in the common\source directory. These files are shown in Table 2.16.
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File Description
F2806x_GlobalPrototypes.h Function prototypes for the peripheral

specific functions included in these
files.

F2806x_Adc.c ADC specific functions and macros.
F2806x_Comp.c Comparator specific functions and

macros
F2806x_CpuTimers.c CPU-Timer specific functions and

macros.
F2806x_Dma.c DMA module specific functions and

macros
F2806x_Dma_defines.h define macros that are used for the

DMA examples
F2806x_ECan.c eCAN module specific functions and

macros
F2806x_ECap.c eCAP module specific functions and

macros.
F2806x_EPwm.c ePWM module specific functions and

macros.
F2806x_EPwm_defines.h define macros that are used for the

ePWM examples
F2806x_EQep.c eQEP module specific functions and

macros.
F2806x_Gpio.c General-purpose IO (GPIO) specific

functions and macros.
F2806x_HRCap.c High-Res Capture specific functions

and macros.
F2806x_I2C.c I2C specific functions and macros.
F2806x_I2c_defines.h define macros that are used for the I2C

examples
F2806x_Mcbsp.c McBSP specific functions and macros.
F2806x_PieCtrl.c PIE control specific functions and

macros.
F2806x_Sci.c SCI specific functions and macros.
F2806x_Spi.c SPI specific functions and macros.
F2806x_SysCtrl.c System control (watchdog, clock, PLL

etc) specific functions and macros.

Table 2.16: Included Peripheral Specific Files

NOTE: The specific routines are under development and may not all be available as of this
release. They will be added and distributed as more examples are developed.
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2.8.2.3 Utility Function Source Files

File Description
F2806x_CodeStartBranch.asm Branch to the start of code execution.

This is used to re-direct code execu-
tion when booting to Flash, OTP or M0
SARAM memory. An option to disable
the watchdog before the C init routine
is included.

F2806x_DBGIER.asm Assembly function to manipulate the
DEBIER register from C.

F2806x_DisInt.asm Disable interrupt and restore interrupt
functions. These functions allow you
to disable INTM and DBGM and then
later restore their state.

F2806x_usDelay.asm Assembly function to insert a delay
time in microseconds. This function is
cycle dependent and must be executed
from zero wait-stated RAM to be accu-
rate. Refer to examples\c28\adc_soc
for an example of its use.

F2806x_CSMPasswords.asm Include in a project to program the
code security module passwords and
reserved locations.

Table 2.17: Included Utility Function Source Files

2.8.2.4 Example Linker .cmd files

Example memory linker command files are located in the common\cmd directory. For getting
started the basic 28069_RAM_lnk.cmd file is suggested and used by many of the included ex-
amples.

The L0 SARAM block is mirrored on these devices. For simplicity these memory maps only include
one instance of these memory blocks(Table 2.9).

2.8.2.5 Example Library .lib Files

Example library files are located in the C2000Ware_<version>\libraries\ directory. For this release
the IQMath library is included for use in the example projects. Please refer to the C28x IQMath
Library - A Virtual Floating Point Engine (SPRC087) for more information on IQMath and the most
recent IQMath library. The SFO libraries are also included for use in the example projects. Please
refer to TMS320x2802x, 2803x HRPWM Reference Guide (SPRUGE8) for more information on
SFO library usage and the HRPWM module(see Table 2.18).
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Main Liner Command Description
File Examples

SFO_TI_Build_V6.lib Please refer to the TMS320x2802x, 2803x HRPWM
Reference Guide (SPRUGE8) for more information
on the SFO V6 library. Requires user code to update
HRMSTEP register with MEP_ScaleFactor value.

SFO_TI_Build_V6b.lib Same as v6 lib file, but now automatically updates
HRMSTEP register with MEP_ScaleFactor value.

SFO_V6.h SFO V6 header file

Table 2.18: Included Library Files

2.9 Detailed Revision History

V2.05.00.00

Added New I2C Example - i2c_Lib_eeprom_interrupt and i2c_Lib_eeprompollingMigratedallexamplestousecompilerv20.2.l.LTS

V2.04.00.00

New Example - CAN Flash Kernel Example (f28069_can_flash_kernel)

F2806x_ECan.c - Corrected bit rate timing values for 90MHz system clock

Renamed f28069_flash_kernel example to f28069_sci_flash_kernel

Corrected build error for MWARE Boot Loader project

V2.03.00.00

New Example - NMI Watchdog usage for missing clock (nmi_watchdog)

SCIA Loopback Interrupts Example - Fixed macro parenthesis and corrected setting of SCIH-
BAUD

MWare FATFS - Corrected value in xmit_datablock()

F2806x_ECan.c - Corrected bit timing for 90MHz system clock and updated initialization to
clear all mailbox registers

All Linker Command Files - Updated FPUTABLE ROM address to align with revB silicon

Device Firmware User Guide - Clarified steps for setting up an example

GPIO Toggle Example - Updated delay loop so that LED toggling is visible

F2806x_SysCtrl.c - Updated IntOsc2Sel() with proper Errata procedure for switching to IN-
TOSC2

ECAP APWM and ECAP Capture PWM Examples - Corrected comments on what GPIOs are
used

F2806x_CpuTimers.c - Corrected clock period data type to Uint32 in ConfigCpuTimer()

HRCAP Capture HRPWM and HRCAP Capture PWM Examples - Added missing "EDIS"

MWare Bootloader project - Removed unsupported/not-implemented AES and CSM code ref-
erences

bl_app example - Corrected "deprecated" folder naming
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V2.02.00.00

Updated all examples and removed deprecated compiler options

Flash Kernel Example - Corrected OTP key and BMODE memory addresses in Boot.h

Fixed MWare boot loader DFU project

SCI Echoback and Loopback Examples - Disabled unneeded interrupts

F2806x_usbWrapper.c - Corrected GPIO for VBUS and interrupt registration procedure

V2.01.00.00

Added F28069M Launchpad example

Updated documentation and file names (changed dashes to underscores)

V2.00.00.00

Updated directories and naming for C2000Ware package

Cleaned up and reformatted source, header, and example code to new comment structure

Libraries moved into C2000Ware libraries directory

Removed CCSv4 example files. Require CCSv5 or newer.

F2806x_Device.h and F2806x_Cla_typedefs.h - Added data type macro guards

V1.51

Changes to F2806x_common Files

1. Updated I2C header file to change max buffer size and updated comments
2. Updated F28069.cmd linker command file
3. Fixed eCan source to remove SAM bit

Changes to Example Files

1. Updated USB examples
2. Fixed eCan example to remove SAM bit

Changes to MWare Files

1. Updated MWare usblib.lib

V1.50

Changes to F2806x_common Files

1. Added two F28069M linker command files

Changes to Example Files

1. Updated examples to build with C28 compiler v6.4.2
2. Fixed example compatibility issue with CCSv5
3. Updated eCAN back2back example description
4. Several updates and fixes for various USB examples

Changes to MWare Files

1. USB library - Initialized specific global variables to zero since RAM isn’t cleared initially.
2. usb.c - Updated USBIntStatus to work around USB stalling due to edge triggering issue
3. Updated USBIntHandlerInternals to accept USBTXIS/USBRXIS status argument to en-

sure the status is handled correctly.
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4. Fixed offsets in USBHSCSIWrite10() of usbhscsi.c to prevent writing of incorrect com-
mands

5. Fixed UARTprintf function in uartstdio.c to support long format

V1.41

Changes to F2806x_common Files

1. Updated ACQPS value and added SOC wait loops in F2806x_Adc.c
2. Updated CLA linker command files for C2000 compiler 6.4.X support

Changes to Example Files

1. Added AdcOffsetSelfCal() to ADC examples
2. Cleaned up CCS warnings in examples
3. Fixed F28069 flash kernel example project file
4. Updated McBSP examples

V1.40

Changes to F2806x_headers Files

1. Removed ABIS bit from McBSP Header files
2. Made PieVectTable volatile

Changes to F2806x_common Files

1. Correct Flash wait states in InitFlash function
2. Added delay to XtalOscSel function
3. Correct DMA trigger defintions for EPWM

Changes to Example Files

1. Corrected use of RUN bit in DMA examples
2. Cleaned up comments in HRCAP examples
3. Added NOP to SW Prioritized Interrupt Example
4. Fixed issues with USB examples and drivers
5. Added code to USB library to correctly handle BOS descriptors
6. Fixed typo in McBSP_DLB_DMA example that prevented channel two from operating cor-

rectly
7. Added F28069 Flash Kernel Example

V1.36

Changes to F2806x_common Files

1. 2806x_RAM_CLA_C_lnk.cmd - Added .bss_cla and .const_cla

Changes to Example Files

1. Ported examples to CCSv5.
2. sci_echoback - Corrected the baud rate.
3. Added new Example -

• Example_2806xHRPWM_Symmetric_Duty_Cycle_SFO_V6.c

V1.35

Changes to F2806x_headers Files

1. F2806x_ECan.h - Corrected byte ordering in comments of CANMDL, CANMDH
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2. F2806x_Cla_typedefs.h -fixed error in redefition of short, consistent macro usage

Changes to F2806x_common Files

1. 2806x_RAM_CLA_C_lnk.cmd - Modified sections Cla1Prog and CLA1mathTables

Changes to Example Files

1. flash_f28069 - FPWR is protected, added the EALLOW, EDIS wrapper to the example
2. All CLA C examples - Modified CLA linker files run start address symbol and generation

of the MVECT tast offsets

V1.30

Changes to F2806x_headers Files

1. F2806x_Device.h -
• All device variants have SCIA and SCIB modules enabled
• 80-pin packages have 1 HRCAP module (i.e. HRCAP2)

2. F2806x_Comp.h - Added slope compensation register defintions

Changes to F2806x_common Files

1. F2806x_Sci.c - InitSciGpio() calls InitScibGpio() when DSP28_SCIB is 1
2. F2806x.c - Correctly set the timer period register

Changes to Example Files

1. Example_2806xClaAdcFir.c - Corrected ePWM1 frequency to match comment

V1.20

Changes to F2806x_headers Files

1. F2806x_Cla_typedefs.h - New header file, re-defines data type for the CLA C compiler
2. F2806x_Adc.h -Corrected ADCOFFTRIM_BITS.OFFTRIM type from Uint16 to int16
3. F2806x_Gpio.h -GPIOXINT_BITS.GPIOSEL is 5 bits wide not 4
4. F2806x_I2c.h -I2CFFTX.TXFFIENA, corrected typo
5. F2806x_Ecap.h -CTR_EQ_PRD1 in ECEINT and ECFLG corrected CTR_EQ_PRD.

Added #define CTR_EQ_PRD1 CTR_EQ_PRD for legacy compatibility
6. F2806x_Mcbsp.h -Fixed comment about clock rate
7. F2806x_SysCtrl.h -

• Added JTAGDEBUG[JTAGDIS] register and bit; (offset 0x1A) to SysCtrlRegs
• Altered comment for INTOSC2TRIM

Changes to F2806x_common Files

1. Removed F2806x_MemCopy.c - The function memcpy from string.h will be used instead
in all places

2. F2806x_Adc.c -added EALLOW and EDIS around AdcRegs.ADCCTL2.bit.CLKDIV2EN
3. IQmath.lib -Removed local copy of IQmath.lib and IQMathLib.h
4. F2806x_SysCtrl.c -

• IntOsc2Sel()/XtalOscSel()/ ExtOscSel() functions - Set WDCLKSRCEL = 0 and IN-
TOSC1OFF = 0

• XCLKOUT will no longer be brought out to the GPIO pin

Changes to Example Files

1. Example_2806xSpi_FFDLB.c - delay_loop function deleted, not used in this example
2. Example_2806xSpi_FFDLB_int.c - Replaced sdata[i]++ with sdata[i] = sdata[i] + 1;
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3. All HRPWM examples -Argument to HRPWMx_Config() changed from int to Uint16
4. All EQEP examples -Fixed relative path to FastRTS library in macros.ini
5. CLA Examples -Added new examples to demo the CLA C compiler

V1.15

Changes to F2806x_headers Files
No Changes

Changes to F2806x_common Files
No Changes

Changes to Example Files

1. Updated all examples to latest code generation tools version (v6.0.1)
2. bl_app - Added Bootloader sample application

Changes to MWare Files

1. bootloader - Added USB DFU flash bootloader
2. rts2800_bl - Added minimal runtime support library with support for 2 flash entry points
3. tools\tiusbdll - Renamed lmusbdll to tiusbdll
4. tools\tidfu - Added tidfu DFU DLL wrapper
5. tools\dfuprog - Added dfuprog DFU programming application
6. windows_drivers - Added DFU driver files

V1.10

Changes to F2806x_headers Files

1. F2806x_Headers_BIOS/nonBIOS.cmd - added entries for HRCAP1,2,3,4 and USB0.
2. F2806x_DevEmu.h - added SYSCLK2DIV2DIS bit in DEVICECNF register for PLL2 out-

put divide by 2.
3. F2806x_Device.h - added new part numbers for USB, added #include for HRCAP and

USB header files, added #defines for HRCAP1,2,3,4 and USB0, included new part num-
bers in #if statements.

4. F2806x_Gpio.h - added GPACTRL2 register with USB I/O enable bit.
5. F2806x_HRCap.h - added new header file.
6. F2806x_PieVect.h - added interrupts for HRCAP1,2,3,4 and USB0.
7. F2806x_SysCtrl.h - added PCLKCR2 register with HRCAP1,2,3,4 clock enable bits,

added USB0 clock enable bit to PCLKCR3, added all registers for PLL2 (PLL2CTRL,
PLL2MULT, PLL2STS, and SYSCLK2CNTR), added JTAGDEBUG register with JTAGDIS
bit.

8. F2806x_Usb.h - added new header file.
9. F2806x_GlobalVariableDefs.c - added entries for HRCAP1,2,3,4 and USB0.

Changes to F2806x_common Files

1. 2806x_RAM_lnk.cmd/2806x_RAM_CLA_lnk.cmd - USB RAM added to memory map.
2. F2806x.cmd - USB RAM added to memory map.
3. F2806x.gel - added USB RAM to GEL_MapAdd section, device cal changed for RevA,

added PLL2 functions.
4. F2806x_DefaultISR.h - added interrupts for HRCAP1,2,3,4 and USB0.
5. F2806x_Dma_defines.h - added #defines for USB0.
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6. F2806x_Examples.h - added #defines for PLL2, added new part numbers for USB de-
vices.

7. F2806x_SWPrioritizedIsrLevels.h - added interrupts for HRCAP1,2,3,4 and USB0, cor-
rected code for Case1 and Case5.

8. IQmath.lib - removed library, library is located in \..\controlSUITE\libs.
9. F2806x_SWPrioritizedPieVect.c - added interrupts for HRCAP1,2,3,4 and USB0.

10. F2806x_SWPrioritizedDefaultIsr.c - added interrupts for HRCAP1,2,3,4 and USB0.
11. F2806x_SysCtrl.c - added code to enable HRCAP1,2,3,4 and USB0 clocks.

Changes to Example Files

1. Example_2806xAdcTempSensor.c - added code to set the ADC nonoverlap bit.
2. Example_2806xAdc_TempSensorConv.c - added code to set the ADC nonoverlap bit.
3. Example_2806xClaAdc.c - added code to set the ADC nonoverlap bit.
4. Example_2806xClaAdcFir.c - changed code to use ADCINA2, added code to set the

ADC nonoverlap bit.
5. Example_2806xClaAdcFirFlash.c - same changes as Example_F2806xClaAdcFir.c.
6. Example_2806xDMA_ram_to_ram.c - updated comments.
7. Example_2806xECanBack2Back.c - updated comments.
8. Example_2806xECap_apwm.c - updated to vary frequency on the PWM output, updated

comments.
9. Example_2806xEPwmDCEventTrip.c - updated comments.

10. Example_2806xEPwmDCEventTripComp.c - updated comments.
11. Example_2806xEPwmDeadBand.c - updated comments.
12. Example_2806xEPwmTripZone.c - updated comments.
13. Example_2806xExternalInterrupt.c - changed GPIOŠs to ones accessible on the 2806x

controlSTICK.
14. Example_2806xGpioSetup.c - updated comments, fixed code mistakes in GPIO10 and

GPIO34 setup.
15. Example_2806xGpioToggle.c - changed code so GPIO28 and GPIO29 do not toggle,

this was causing emulation failure.
16. Example_2806xHRPWM_Duty_SFO_V6.c - updated comments for 80 MHz, updated

comments for number of HRPWM channels.
17. Example_2806xHRPWM_MultiCh_PrdUpDown_SFO_V6.c - updated comments for 80

MHz.
18. Example_2806xHRPWM_PrdUp_SFO_V6.c - updated comments for 80 MHz.
19. Example_2806xHRPWM_PrdUpDown_SFO_V6.c - updated comments for 80 MHz.
20. Example_2806xI2C_eeprom.c - updated comment that referred to wrong ISR.
21. Example_2806xMcBSP_DLB_DMA.c - updated comment to match code on which DMA

accessible RAM section is used.
22. Example_2806xMcBSP_DLB_int.c - updated comments.
23. Example_2806xMcBSP_SPI_DLB.c - updated comments, removed unused variable.
24. Example_2806xOscComp.c - changed comment to match code setting xclkout, added

ADC nonoverlap bit, changed sampling window of ADC, removed code to sample ADC
twice.

25. Example_2806xSci_Echoback.c - fixed code error with SCIHBAUD and SCILBAUD reg-
isters, eliminated repetitive line of code.

26. Example_2806xScia_FFDLB.c - updated comments.
27. Example_2806xSci_FFDLB_int.c - updated comments.
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28. Example_2806xSpi_FFDLB.c - updated comments, deleted unused variable.
29. Example_2806xSpi_FFDLB_int.c - updated comments, deleted unused variable.
30. Example_2806xSWPrioritizedInterrupts.c - updated comments, added missing semi-

colon and missing OR that caused Case9 failure, fixed code mistake in CASE4.
31. Example_2806xHRCap_Capture_HRPwm.c - new HRCAP example.
32. Example_2806xHRCap_Capture_Pwm.c - new HRCAP example.

V1.00

This version is the first release (packaged with development tools and customer trainings) of
the F2806x header files and examples.
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3.1 Introduction

This chapter aims to give you, the user, a step by step guide on how to create and debug projects
from scratch. This guide will focus on the user of a Piccolo controlCARD, but these same ideas
should apply to other boards with minimal translation.

3.2 Project Creation

A typical Piccolo application consists of a single CCS project with multiple source files: C and ASM
files for the C28 and C or ASM files for the CLA.

Project Creation

1. From the main CCS window select File -> New -> CCS Project. Name your project , select
the output type (Executable), set the location of the project. Device Family should be selected
to C2000. Ensure that your window matches the settings below except for perhaps the device
variant. After you are satisfied with these settings select Finish and your project will be created.
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Figure 3.1: Creating a new project

2. Click on Advanced settings to expand it and alter the desired Compiler Version and Runtime
Support library.
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Figure 3.2: Setting advanced project properties

3. Before we can successfully build a project we need to setup some build spe-
cific settings. Right click on your project and select Build Properties. In the
Tool Settings tab look for and select the Include Options. Click on the add di-
rectory icon to add a directory to the search path. Click the File System button
to browse to the common\include folder of your C2000ware installation (typically
C:\TI\c2000\C2000ware_<version>\device_support\f2806x\common\include).
Click ok to add this path, and repeat this same process to add the headers\include
directory.
While you have this window open select the Symbol Management options under C2000 Linker.
Specify the program entry point to be code_start. Select ok to close out of the Build Prop-
erties.
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Figure 3.3: Include path setup

4. Next we need to link in a few files which are used by the header files. To do this right click
on your project in the workspace and select Link Files... Navigate to the headers\source
directory, and select F2806x_GlobalVariableDefs.c. Link in the following files as well:

headers\cmd\F2806x_Headers_nonBIOS.cmd
common\source\F2806x_CodeStartBranch.asm
common\source\F2806x_usDelay.asm
common\cmd\28069_RAM_CLA_lnk.cmd or another appropriate linker command file

At this point your project workspace should look like the following:

Figure 3.4: Linking files to project

In this step we linked a file to the project which only created a symbolic link in the project to
the actual file in the hard drive. This means that if you modify a linked file in CCS you are
modifying the original file in C2000ware. We won’t be modifying the linker command file or
header files, so this is ok.

5. Create a new file by right clicking on the project and selecting New -> File. Name this file
main.c and copy the following code into it:

#include "DSP28x_Project.h"
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void main(void)
{

//
// Disable Protection
//
EALLOW;

//
// Make Port B GPIOs outputs
//
GpioCtrlRegs.GPADIR.all = 0x0000FF00;

while(1)
{

//
// Toggle GPIOs 8-15
//
GpioDataRegs.GPADAT.all = 0x0000FF00;
DELAY_US(100);
GpioDataRegs.GPADAT.all = 0x00000000;
DELAY_US(100);

}

}

6. Save main.c and then build the project by right clicking on it and selecting Build Project. You
have just built your first Piccolo project from scratch.

3.3 Debugging Applications

1. Ensure CCS version 6.x is installed and up to date. You should have C2000 Code Generation
Tools verion 6.0.1 or later.

2. Connect a USB cable from the computer to the USB port on the base board. Windows will
enumerate and try to install drivers. As long as CCS is installed, Windows should automatically
find and install drivers for the emulator.

3. Apply power either via USB or the 5V DC jack on the docking station. If you wish to use the
onboard XDS100v2 emulator you will need to connect the USB cable. Alternatively you could
connect an external JTAG emulator using the available header pins on the base board.

4. Create a new target configuration. Click File -> New -> Target Configuration File and name the
file appropriately (i.e. XDS100v2_Piccolo_F28069_ControlCARD.ccxml). Select the emulator
you intend to use (XDS100v1) from the drop down list, and then select the device variant
present on your board (Piccolo controlCARDs have an Experimenters Kit - Piccolo F28069).
Save the target configuration and close the window.
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Figure 3.5: Piccolo Card Target Configuration Setup

5. Import the desired example projects (or skip this step if you are using projects you created
in the Project Creation section). Click File -> Import, and in the CCS folder select Existing
CCS Eclipse Projects before clicking Next. With the "Select search-directory" radio button
checked, browse to the root of your C2000ware installation. Device specific software as well
as examples are stored in the device_support/device_variant folders. Navigate to the
f2806x directory, and then to the examples\c28 directory. Click OK and CCS will parse all
of the projects in this directory. Import any projects you wish to run into the workspace. Do not
select "Copy projects into workspace". These projects use relative paths to link to external
resouces, so taking them out of C2000ware will break the project.
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Figure 3.6: Importing Piccolo Projects

6. Build each of the example projects. Right click on each project title and select build project.

Figure 3.7: Building Piccolo Projects

7. Launch the previously created target configuration. Click View -> Target Configurations. In the
window that opens, find the desired target configuration, right click on it and select "Launch
Target Configuration".
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Figure 3.8: Launching a CCS Target Configuration

8. Connect to the device. Right click on each core in the debug window and select "Connect
Target. This will connect CCS to the device and will allow you to load code and debug appli-
cations.

Figure 3.9: Connecting to a Target

Figure 3.10: After connection to both cores
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9. Load code onto the device. Select the C28x session in the debug window and then click Target
-> Load Program. A dialog box is displayed which will allow you to select a program to load.

10. At this point the C28 should have code loaded and be halted at main. From this point, users
should be able to debug code. Please keep in mind that any action you take in CCS only has
an effect on the session you currently have selected in the debug window. For instance if the
C28 is selected, the register view will display the registers of the C28 system. The opposite
would be true if the CLA were selected.

Figure 3.11: Projects loaded on the C28

3.4 Troubleshooting

There are a number of things that can cause the user trouble while bringing up a debug session
the first time. This section will try to provide solutions to the most common problems encountered
with the Concerto devices.

"I get a managed make error when I import the example projects"

This occurs when one imports a project for which he or she doesn’t have the code generation tools
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for. Please ensure that you have at least version 6.0.1 of the C2000 Code Generation Tools.

"I cannot build the example projects"

This is caused by linked resources not being where the project expects them to be. For instance, if
you imported the projects and selected "Copy projects to workspace", the projects would no longer
build because the files they refernce aren’t a part of your workspace. Always build and run the
examples directly in the C2000ware tree.

"I cannot connect to the target"

This is most often times caused by either a bad target configuration, or simply the emulator being
physically disconnected. If you are unable to connect to a target check the following things:

1. Ensure the target configuration is correct for the device you have.

2. Ensure the emulator is plugged in to both the computer and the device to be debugged.

3. Ensure that the target device is powered.
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4 Piccolo F2806x Example Applications
These example applications show the user how to make use of various peripherals present on the
Piccolo device. They are intended for demonstration purposes only and a good starting point for
building new applications.

Notes

All examples require the F2806x header files
All examples set up the PLL in x18/2 mode which gives a system clock of 90MHz. This is the
default setting assuming the input clock is derived from the 10MHz internal clock.
Some examples like those related to HRPWM require the use of an external scope to see
the results, while other examples may require external connections between headers on the
baseboard (e.g. adc_soc). Each example will describe the setup procedure that is required to
properly execute it.
As supplied, all projects are configured for "boot to SARAM" operation unless specified other-
wise in the example description. The F2806x Boot Mode table is shown below.

• While an emulator is connected to your device, the TRSTn pin = 1, which sets the device
into EMU_BOOT boot mode. In this mode, the peripheral boot modes are shown in the
table below.

• Write EMU_KEY to 0xD00 and EMU_BMODE to 0xD01 via the debugger with the values
from the table

• Build/Load project, reset the device, and run the example
All USB Examples require the following

• the F2806x header files
• Driverlib (/C2000Ware/device_support/f2806x/MWare/driverlib/)
• Usblib (/C2000Ware/device_support/f2806x/MWare/usblib/)
• USB Capable F2806x

Boot Mode EMU_KEY EMU_BMODE
(0xD00) (0xD01)

Wait !=0x55AA X
I/O 0x55AA 0x0000
SCI 0x55AA 0x0001
Wait 0x55AA 0x0002
Get_Mode 0x55AA 0x0003
SPI 0x55AA 0x0004
I2C 0x55AA 0x0005
OTP 0x55AA 0x0006
eCANA 0x55AA 0x0007
SARAM 0x55AA 0x000A

(Boot to SARAM)
Flash 0x55AA 0x000B
Wait 0x55AA Other

Table 4.1: Boot Modes for Piccolo 2806x

We have provided scripts to automate setting up watch variables and associated graphs called
’SetupDebugEnv.js’ in several example folders. Once you have established a connection to the
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target device in debug mode go to View->Scripting Console. Within the console click the Open
Command file icon in the far right corner of the console window and select the javascript file.

All of these examples reside in the examples\c28 subdirectory of the C2000Ware package.

Examples for the CLA ’C’ compiler are in the examples\cla subdirectory

4.1 ADC Start of Conversion (adc_soc)

This ADC example uses ePWM1 to generate a periodic ADC SOC - ADCINT1. Two channels are
converted, ADCINA4 and ADCINA2.

Watch Variables

Voltage1[10] - Last 10 ADCRESULT0 values
Voltage2[10] - Last 10 ADCRESULT1 values
ConversionCount - Current result number 0-9
LoopCount - Idle loop counter

4.2 ADC Temperature Sensor (adc_temp_sensor)

In this example the ePWM1 is set up to generate a periodic ADC SOC interrupt - ADCINT1. One
channel is converted - ADCINA5, which is internally connected to the temperature sensor.

Watch Variables

TempSensorVoltage[10] - Last 10 ADCRESULT0 values
ConversionCount - Current result number 0-9
LoopCount - Idle loop counter

4.3 ADC Temperature Sensor Conversion
(adc_temp_sensor_conv)

This example shows how to convert a raw ADC temperature sensor reading into deg. C and deg.
K. Internal temperature is sampled continuously through ADCINA5. The coefficients required to
compensate for temperature offset are read from TI OTP.

Note:
THIS EXAMPLE USES VARIABLES STORED IN OTP DURING FACTORY TEST. THESE OTP
LOCATIONS ,0x3D7E90 to 0x3D7EA4, MAY NOT BE POPULATED. ENSURE THAT THESE
MEMORY LOCATIONS IN TI OTP ARE POPULATED WITH VALUES DIFFERENT FROM
0XFFFF

Watch Variables

temp
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degC

degK

4.4 USB Boot Loader Example (boot_demo_usb)

Note:
This example is using older versions of the F2806x USB and Driver Libraries (v141), which are
now deprecated. The source and headers used are located within the "∼/bl_app/deprecated"
directory.

This example application is used in conjunction with the USB boot loader (boot_usb) and turns the
evaluation board into a composite device supporting a mouse via the Human Interface Device class
and also publishing runtime Device Firmware Upgrade (DFU) capability. Dragging a finger or stylus
over the touchscreen translates into mouse movement and presses on marked areas at the bottom
of the screen indicate mouse button press. This input is used to generate messages in HID reports
sent to the USB host allowing the evaluation board to control the mouse pointer on the host system.

Since the device also publishes a DFU interface, host software such as the dfuprog tool can deter-
mine that the device is capable of receiving software updates over USB. The runtime DFU protocol
allows such tools to signal the device to switch into DFU mode and prepare to receive a new soft-
ware image.

Runtime DFU functionality requires only that the device listen for a particular request (DETACH)
from the host and, when this is received, transfer control to the USB boot loader via the normal
means to reenumerate as a pure DFU device capable of uploading and downloading firmware
images.

Windows device drivers for both the runtime and DFU mode of operation can be found in
C:/StellarisWare/windows_drivers assuming you installed StellarisWare in the default di-
rectory.

To illustrate runtime DFU capability, use the dfuprog tool which is part of the Stellaris Win-
dows USB Examples package (SW-USB-win-xxxx.msi) Assuming this package is installed in
the default location, the dfuprog executable can be found in the C:/Program Files/Texas
Instruments/Stellaris/usb_examples directory.

With the device connected to your PC and the device driver installed, enter the following command
to enumerate DFU devices:

dfuprog -e

This will list all DFU-capable devices found and you should see that you have one device available
which is in “Runtime” mode. Entering the following command will switch this device into DFU mode
and leave it ready to receive a new firmware image:

dfuprog -m

After entering this command, you should notice that the device disconnects from the USB bus and
reconnects again. Running “dfuprog -e” a second time will show that the device is now in DFU
mode and ready to receive downloads. At this point, either LM Flash Programmer or dfuprog may
be used to send a new application binary to the device.
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4.5 CLA ADC (cla_adc)

In this example ePWM1 is setup to generate a periodic ADC SOC. Channel ADCINA2 is converted.
When the ADC begins conversion, it will assert ADCINT2 which will start CLA task 2.

Cla Task2 logs 20 ADCRESULT1 values in a circular buffer. When Task2 completes an interrupt to
the CPU clears the ADCINT2 flag.

Watch Variables

VoltageCLA - Last 20 ADCRESULT1 values
ConversionCount - Current result number
LoopCount - Idle loop counter

4.6 CLA ADC FIR (cla_adc_fir)

In this example ePWM1 is setup to generate a periodic ADC SOC. One channel is converted:
ADCINA2 and the results are placed in the ADC RESULT1 register. When the ADC sample window
ends and begins conversion, it will assert ADCINT7. The CLA responds to ADCINT7 and executes
CLA Task 7. CLA Task7 is an FIR filter. The output from the filter is placed in VoltFilt. When Task 7
completes, it fires the CLA1_INT7 interrupt to the main CPU. The main CPU will clear the ADCINT
flag, copy the CLA output to a buffer and record the raw ADCRESULT1 value for comparison After
ADC_BUF_LEN samples are collected, the code will halt on an embedded software breakpoint.
ePWM3 generates a square wave, which can be connected to the ADC for testing.

External Connections

connect a jumper between to ADCINA2 and EPWM3A (GPIO4)

Watch Variables

Uint16 AdcBuf[ADC_BUF_LEN] - Buffer of raw ADC RESULT1 values
Uint16 AdcFiltBuf[ADC_BUF_LEN] - Buffer of CLA FIR filter outputs
Uint16 SampleCount - Current sample number

4.7 CLA ADC FIR FLASH (cla_adc_fir_flash)

This example is the same as the cla_adc_fir example, except code is loaded into flash. Time
critical code and CLA code are copied to RAM for execution. In this example ePWM1 is setup to
generate a periodic ADC SOC. One channel is converted: ADCINA2 and the results are placed
in the ADC RESULT1 register. When the ADC sample window ends and begins conversion, it will
assert ADCINT7. The CLA responds to ADCINT7 and executes CLA Task 7. CLA Task7 is an FIR
filter. The output from the filter is placed in VoltFilt. When Task 7 completes, it fires the CLA1_INT7
interrupt to the main CPU. The main CPU will clear the ADCINT flag, copy the CLA output to a
buffer and record the raw ADCRESULT1 value for comparison After ADC_BUF_LEN samples are
collected, the code will halt on an embedded software breakpoint. ePWM3 generates a square
wave, which can be connected to the ADC for testing.

External Connections
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connect a jumper between to ADCINA2 and EPWM3A (GPIO4)

Watch Variables

Uint16 AdcBuf[ADC_BUF_LEN] - Buffer of raw ADC RESULT1 values

Uint16 AdcFiltBuf[ADC_BUF_LEN] - Buffer of CLA FIR filter outputs

Uint16 SampleCount - Current sample number

4.8 Cpu Timer (cpu_timer)

This example configures CPU Timer0, 1, and 2 and increments a counter each time the timer
asserts an interrupt.

Watch Variables

CpuTimer0.InterruptCount

CpuTimer1.InterruptCount

CpuTimer2.InterruptCount

4.9 DMA RAM to RAM Transfer (dma_ram_to_ram)

Code will perform a block copy from L5 DMARAM to L6 DMARAM of 1024 words. The transfer will
be started by CPU Timer0. This example uses a data size of 32-bits decrease the transfer time. An
interrupt is taken each time a transfer completes (local_DINTCH1_ISR).

Watch Variables:

DMABuf1 - Destination buffer for the DMA

DMABuf2 - Source buffer for the DMA

4.10 eCAN back to back (ecan_back2back)

This example tests eCAN by transmitting data back-to-back at high speed without stopping. The
received data is verified. Any error is flagged. MBX0 transmits to MBX16, MBX1 transmits to
MBX17 and so on....

This example uses the self-test mode of the CAN module. i.e. the transmission/reception happens
within the module itself (even the required ACKnowldege is generated internally in the module).
Therefore, there is no need for a CAN transceiver to run this particular test case and no activity
will be seen in the CAN pins/bus. Because everything is internal, there is no need for a 120-
ohm termination resistor. Note that a real-world CAN application needs a CAN transceiver and
termination resistors on both ends of the bus.

Watch Variables

PassCount
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ErrorCount

MessageReceivedCount

4.11 eCAP APWM (ecap_epwm)

This program sets up the eCAP pins in the APWM mode. eCAP1 will come out on the GPIO5 pin.
This pin is configured to vary between 3 Hz and 6 Hz using the shadow registers to load the next
period/compare values

4.12 eCAP capture PWM (ecap_capture_pwm)

This example configures ePWM3A for:

Up count

Period starts at 2 and goes up to 1000

Toggle output on PRD

eCAP1 is configured to capture the time between rising and falling edge of the ePWM3A output.

External Connections

eCAP1 is on GPIO5

ePWM3A is on GPIO4

Connect GPIO4 to GPIO5

Watch Variables

ECap1PassCount , Successful captures

ECap1IntCount , Interrupt counts

4.13 ePWM Blanking Window (epwm_blanking_window)

This example configures ePWM1 and ePWM2

ePWM1: DCAEVT1 forces EPWM1A high, a blanking window is used EPWM1B toggles on
zero as a reference.

ePWM2: DCAEVT1 forces EPWM2A high, no blanking window is used EPWM2B toggles on
zero as a reference. ePWM1A is set to normally stay low. DCAEVT1 is true when TZ1 is
low and TZ2 is high. When an event is true (DCAEVT1) EPWM1A is configured to be forced
high. A blanking window is applied to keep the event from taking effect around the zero point.
In other words, when the event is taken, EPWM1A will be forced high if there is no event,
EPWM1A will remain low. Notice the blanking window keeps the event from forcing EPWM1A
high around the zero point. ePWM2 is configured the same way as ePWM1 except no blanking
window is applied.
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Initially tie TZ1 (GPIO12) and TZ2 (GPIO13) high. During the test, monitor ePWM1 or ePWM2
outputs on a scope. Create DCAEVT1 by pulling TZ1 low and TZ2 high to see the effect.

External Connections

ePWM1A is on GPIO0

ePWM1B is on GPIO1

ePWM2A is on GPIO2

ePWM2B is on GPIO3

TZ1 is on GPIO12

TZ2 is on GPIO13

4.14 ePWM DC Event Trip (epwm_dcevent_trip)

In this example ePWM1, ePWM2, and ePWM3 are configured for PWM Digital Compare Event Trip
using Trip zone pin inputs. DCAEVT1, DCAEVT2, DCBEVT1 and DCBEVT2 events are all defined
as true when TZ1 is low and TZ2 is high. 3 Examples are included:

ePWM1 has DCAEVT1 as a one shot trip source The trip event will pull ePWM1A high The
trip event will pull ePWM1B low

ePWM2 has DCAEVT2 as a cycle by cycle trip source The trip event will pull ePWM2A high
The trip event will pull ePWM2B low

ePWM3 reacts to DCAEVT2 and DCBEVT1 events The DCAEVT2 event will pull ePWM3A
high The DCBEVT1 event will pull ePWM3B low

Initially tie TZ1 (GPIO12) and TZ2 (GPIO13) high. During the test, monitor ePWM1 or ePWM2
outputs on a scope pull TZ1 low and leave TZ2 high to create a DCAEVT1, DCAEVT2, DCBEVT1
and DCBEVT2. View the EPWM1A/B, EPWM2A/B, EPWM3A/B waveforms on an oscilloscope to
see the effect of the events.

External Connections

EPWM1A is on GPIO0

EPWM1B is on GPIO1

EPWM2A is on GPIO2

EPWM2B is on GPIO3

EPWM3A is on GPIO4

EPWM3B is on GPIO5

TZ1 is on GPIO12

TZ2 is on GPIO13

pull TZ1 low and leave TZ2 high to create a DCAEVT1, DCAEVT2, DCBEVT1 and DCBEVT2.
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4.15 ePWM DC Event Trip Comparator
(epwm_dcevent_trip_comp)

In this example ePWM1 is configured for PWM Digital Compare Event Trip using Comparator1A
and comparator1B pin inputs. DCAEVT1, DCBEVT1 events are triggered by increasing the voltage
on COMP1B pin to be higher than that of COMP1A pin. In this example:

ePWM1 has DCAEVT1 and DCBEVT1 as one shot trip sources DCAEVT1 will pull EPWM1A
high DCBEVT1 will pull EPWM1B low

Initially make the voltage level at COMP1A to be higher than that of COMP1B. Increase voltage
on inverting side of comparator(COMP1B pin) to trigger a DCAEVT1, and DCBEVT1. ePWM1
will react to DCAEVT1 and DCBEVT1 as a 1 shot trip. View the EPWM1A/B waveforms on an
oscilloscope to see the effect of the events.

External Connections

EPWM1A is on GPIO0

EPWM1B is on GPIO1

COMP1A is on ADCA2

COMP1B is on ADCB2

pull COMP1B to a higher voltage level than COMP1A.

4.16 ePWM Deadband Generation (epwm_deadband)

This example configures ePWM1, ePWM2 and ePWM3 for:

Count up/down

Deadband 3 Examples are included:

ePWM1: Active low PWMs

ePWM2: Active low complementary PWMs

ePWM3: Active high complementary PWMs

Each ePWM is configured to interrupt on the 3rd zero event when this happens the deadband is
modified such that 0 <= DB <= DB_MAX. That is, the deadband will move up and down between
0 and the maximum value.

External Connections

EPWM1A is on GPIO0

EPWM1B is on GPIO1

EPWM2A is on GPIO2

EPWM2B is on GPIO3

EPWM3A is on GPIO4

EPWM3B is on GPIO5
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4.17 ePWM Real-Time Interrupt (epwm_real-
time_interrupts)

This example configures the ePWM1 Timer and increments a counter each time an interrupt is
taken. ePWM interrupt can be configured as time critical to demonstrate real-time mode function-
ality and real-time interrupt capability. ControlCard LED2 (GPIO31) is toggled in main loop Control-
Card LED3 (GPIO34) is toggled in ePWM1 Timer Interrupt. FREE_SOFT bits and DBBIER.INT3
bit must be set to enable ePWM1 interrupt to be time critical and operational in real time mode after
halt command. In this example:

ePWM1 is initialized
ePWM1 is cleared at period match and set at Compare-A match
Compare A match occurs at half period
GPIOs for LED2 and LED3 are initialized
Free_Soft bits and DBGIER are cleared
An interrupt is taken on a zero event for the ePWM1 timer

Watch Variables

EPwm1TimerIntCount
EPwm1Regs.TBCTL.bit.FREE_SOFT
EPwm1Regs.TBCTR
DBGIER.INT3

4.18 ePWM Timer Interrupt (epwm_timer_interrupts)

This example configures the ePWM Timers and increments a counter each time an interrupt is
taken. In this example:

All ePWM’s are initialized.
All timers have the same period.
The timers are started sync’ed.
An interrupt is taken on a zero event for each ePWM timer.
ePWM1: takes an interrupt every event.
ePWM2: takes an interrupt every 2nd event.
ePWM3: takes an interrupt every 3rd event.
ePWM4: takes an interrupt every event. Thus the Interrupt count for ePWM1 and ePWM4
should be equal.The interrupt count for ePWM2 should be about half that of ePWM1 and the
interrupt count for ePWM3 should be about 1/3 that of ePWM1.

Watch Variables

EPwm1TimerIntCount
EPwm2TimerIntCount
EPwm3TimerIntCount
EPwm4TimerIntCount

Tue Oct 29 00:38:03 IST 2024 67



Piccolo F2806x Example Applications

4.19 ePWM Trip Zone (epwm_trip_zone)

This example configures ePWM1 and ePWM2 as follows

ePWM1 has TZ1 and TZ2 as one shot trip sources

ePWM2 has TZ1 and TZ2 as cycle by cycle trip sources

Initially tie TZ1 and TZ2 high. During the test, monitor ePWM1 or ePWM2 outputs on a scope. Pull
TZ1 or TZ2 low to see the effect.

External Connections

EPWM1A is on GPIO0

EPWM1B is on GPIO1

EPWM2A is on GPIO2

EPWM2B is on GPIO3

TZ1 is on GPIO12

TZ2 is on GPIO13

4.20 ePWM Action Qualifier Module using Upcount mode
(epwm_up_aq)

This example configures ePWM1, ePWM2, ePWM3 to produce a waveform with independent mod-
ulation on EPWMxA and EPWMxB. The compare values CMPA and CMPB are modified within the
ePWM’s ISR. The TB counter is in upmode.

Monitor the ePWM1 - ePWM3 pins on an oscilloscope.

External Connections

EPWM1A is on GPIO0

EPWM1B is on GPIO1

EPWM2A is on GPIO2

EPWM2B is on GPIO3

EPWM3A is on GPIO4

EPWM3B is on GPIO5

4.21 ePWM Action Qualifier Module using up/down count
(epwm_updown_aq)

This example configures ePWM1, ePWM2, ePWM3 to produce an waveform with independent
modulation on EPWMxA and EPWMxB. The compare values CMPA and CMPB are modified within
the ePWM’s ISR. The TB counter is in up/down count mode for this example.

Monitor ePWM1-ePWM3 pins on an oscilloscope as described
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External Connections

EPWM1A is on GPIO0

EPWM1B is on GPIO1

EPWM2A is on GPIO2

EPWM2B is on GPIO3

EPWM3A is on GPIO4

EPWM3B is on GPIO5

4.22 eQEP, Frequency measurement(eqep_freqcal)

This test will calculate the frequency and period of an input signal using eQEP module.

EPWM1A is configured to generate a frequency of 5 kHz.

See also:
section on Frequency Calculation for more details on the frequency calculation performed in
this example.

In addition to the main example file, the following files must be included in this project:

Example_freqcal.c , includes all eQEP functions

Example_EPwmSetup.c , sets up EPWM1A for use with this example

Example_freqcal.h , includes initialization values for frequency structure.

The configuration for this example is as follows

Maximum frequency is configured to 10KHz (BaseFreq)

Minimum frequency is assumed at 50Hz for capture pre-scalar selection

SPEED_FR: High Frequency Measurement is obtained by counting the external input pulses for
10ms (unit timer set to 100Hz).

SPEED_FR =
Count Delta

10ms

SPEED_PR: Low Frequency Measurement is obtained by measuring time period of input edges.
Time measurement is averaged over 64edges for better results and capture unit performs the time
measurement using pre-scaled SYSCLK

Note that pre-scaler for capture unit clock is selected such that capture timer does not overflow at
the required minimum frequency This example runs forever until the user stops it.

External Connections

Connect GPIO20/EQEP1A to GPIO0/EPWM1A

Watch Variables

freq.freqhz_fr , Frequency measurement using position counter/unit time out

freq.freqhz_pr , Frequency measurement using capture unit
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4.22.1 EPWM Setup(Example_EPwmSetup.c)

This file contains source for the ePWM initialization for the freq calculation module. EPWM1 is set
to operate in up-down count mode at a frequency of 5KHz

4.22.2 Frequency Calculation (Example_freqcal.c)

This file includes the EQEP initialization and frequency calculation functions called by Exam-
ple_2806xEqep_freqcal.c. The frequency calculation steps performed by FREQCAL_Calc()at
SYSCLKOUT = 90 MHz are described below:

1. This program calculates: ∗∗freqhz_fr∗∗

freqhz_fr or v =
x2 − x1

T
..........1

If
max

base
freq = 10kHz => 10kHz =

x2 − x1

(2/100Hz)
..........2

max(x2 − x1) = 200counts = freqScaler_fr

Note:
T = 2

100Hz . 2 is from x2−x1

2 because QPOSCNT counts 2 edges per cycle (rising and falling)

If both sides of Equation 2 are divided by 10 kHz, then:

1 =
x2 − x1

10kHz ∗ (2/100Hz)

where,

[10kHz ∗ 2

100Hz
] = 200

Because
x2 − x1 < 200(max)

x2 − x1

200
< 1

for all frequencies less than max

freq_fr =
x2 − x1

200
or

x2 − x1

10kHz ∗ (2/100Hz)
..........3

To get back to original velocity equation, Equation 1, multiply Equation 3 by 10 kHz

freqhz_fr(or velocity) = 10kHz ∗ x2 − x1

10kHz ∗ (2/100Hz)

=
x2 − x1

(2/100Hz)
..........final equation
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1. ∗∗min freq∗∗ = 1 count
(2/100Hz) = 50Hz

2. ∗∗freqhz_pr∗∗

freqhz_pr or v =
X

t2 − t1
..........4

If
max

base
freq = 10kHz => 10kHz =

(8/2)

T
=

8

2T

where,
8 = QCAPCTL [UPPS] (Unit timeout - once every 8 edges)
2 = divide by 2 because QPOSCNT counts 2 edges per cycle (rising and falling)
T = time in seconds = t2−t1

(100MHz/128) , t2 − t1 = # of QCAPCLK cycles,
and 1 QCAPCLK cycle = 1

(100MHz/128) = QCPRDLAT

So:
10kHz = 8 ∗ (90MHz/128)

2 ∗ (t2 − t1)

t2 − t1 = 8 ∗ (90MHz/128)

10kHz ∗ 2
=

(90MHz/128)

((2 ∗ 10KHz)/8)
..........5

= 250 QCAPCLK cycles = maximum(t2 − t1) = freqScaler_pr

Divide both sides by (t2 − t1), and:

1 =
250

t2 − t1
=

(90MHz/128)/((2 ∗ 10KHz)/8)

t2 − t1

Because (t2 − t1) < 250(max), 250
t2−t1

< 1 for all frequencies less than max

freq_pr =
250

t2 − t1
or

(90MHz/128)/((2 ∗ 10KHz)/8)

t2 − t1
..........6

Now within velocity limits, to get back to original velocity equation, Equation 1, multiply Equation 6
by 10 kHz:

freqhz_fr(or velocity) = 10kHz ∗ (90MHz/128)/((2 ∗ 10KHz)/8)

t2 − t1

=
(90MHz/128) ∗ 8

2 ∗ (t2 − t1)

or
8

2 ∗ (t2 − t1) ∗ (QCPRDLAT )
..........final equation

More detailed calculation results can be found in the Example_freqcal.xls spreadsheet included in
the example folder.
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4.23 eQEP Speed and Position measurement
(eqep_pos_speed)

This example provides position measurement,speed measurement using the capture unit, and
speed measurement using unit time out. This example uses the IQMath library. It is used merely
to simplify high-precision calculations. The example requires the following hardware connections
from EPWM1 and GPIO pins (simulating QEP sensor) to QEP peripheral.

GPIO20/eQEP1A <- GPIO0/ePWM1A (simulates eQEP Phase A signal)
GPIO21/eQEP1B <- GPIO1/ePWM1B (simulates eQEP Phase B signal)
GPIO23/eQEP1I <- GPIO4 (simulates eQEP Index Signal) See DESCRIPTION in Exam-
ple_posspeed.c for more details on the calculations performed in this example. In addition
to this file, the following files must be included in this project:
Example_posspeed.c - includes all eQEP functions
Example_EPwmSetup.c - sets up ePWM1A and ePWM1B as simulated QA and QB encoder
signals
Example_posspeed.h - includes initialization values for pos and speed structure

Note:

Maximum speed is configured to 6000rpm(BaseRpm)
Minimum speed is assumed at 10rpm for capture pre-scalar selection
Pole pair is configured to 2 (pole_pairs)
QEP Encoder resolution is configured to 4000counts/revolution (mech_scaler)
which means: 4000/4 = 1000 line/revolution quadrature encoder (simulated by EPWM1)
EPWM1 (simulating QEP encoder signals) is configured for 5kHz frequency or 300 rpm
(=4∗5000 cnts/sec ∗ 60 sec/min)/4000 cnts/rev)
SPEEDRPM_FR: High Speed Measurement is obtained by counting the QEP input pulses for
10ms (unit timer set to 100Hz).
SPEEDRPM_FR = (Position Delta/10ms) ∗ 60 rpm
SPEEDRPM_PR: Low Speed Measurement is obtained by measuring time period of QEP
edges. Time measurement is averaged over 64edges for better results and capture unit per-
forms the time measurement using pre-scaled SYSCLK
pre-scaler for capture unit clock is selected such that capture timer does not overflow at the
required minimum RPM speed.

External Connections

Connect eQEP1A(GPIO20) to ePWM1A(GPIO0)(simulates eQEP Phase A signal)
Connect eQEP1B(GPIO21) to ePWM1B(GPIO1)(simulates eQEP Phase B signal)
Connect eQEP1I(GPIO23) to GPIO4 (simulates eQEP Index Signal)

Watch Variables

qep_posspeed.SpeedRpm_fr - Speed meas. in rpm using QEP position counter
qep_posspeed.SpeedRpm_pr - Speed meas. in rpm using capture unit
qep_posspeed.theta_mech - Motor mechanical angle (Q15)
qep_posspeed.theta_elec - Motor electrical angle (Q15)
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4.24 External Interrupt (external_interrupt)

This program sets up GPIO0 as XINT1 and GPIO1 as XINT2. Two other GPIO signals are used to
trigger the interrupt (GPIO32 triggers XINT1 and GPIO33 triggers XINT2). XINT1 input is synched
to SYSCLKOUT XINT2 has a long qualification - 6 samples at 510∗SYSCLKOUT each. GPIO34
will go high outside of the interrupts and low within the interrupts. This signal can be monitored on
a scope. On the f28069 controlSTICK, GPIO-34 also toggles a red LED. Each interrupt is fired in
sequence - XINT1 first and then XINT2.

Monitor GPIO34 with an oscilloscope. GPIO34 will be high outside of the ISRs and low within each
ISR.

External Connections

Connect GPIO32 to GPIO0. GPIO0 is assigned to XINT1

Connect GPIO33 to GPIO1. GPIO1 is assigned to XINT2

Watch Variables

Xint1Count - XINT1 interrupt count

Xint2Count - XINT2 interrupt count

LoopCount - idle loop count

4.25 F28069 CAN Flash Kernel (f28069_can_flash_kernel)

This example is for use with the CAN Flash Programmer utility. This application is intended to be
loaded into the device’s RAM via the CAN boot mode. After successfully loaded this program imple-
ments a modified version of the CAN boot protocol that allows a user application to be programmed
into flash

4.26 F28069 SCI Flash Kernel (f28069_sci_flash_kernel)

This example is for use with the SerialLoader2000 utility. This application is intended to be loaded
into the device’s RAM via the SCI boot mode. After successfully loaded this program implements
a modified version of the SCI boot protocol that allows a user application to be programmed into
flash

4.27 ePWM Timer Interrupt From Flash (flash_f28069)

This example runs the ePWM interrupt example from flash. ePwm1 Interrupt will run from RAM
and puts the flash into sleep mode. ePwm2 Interrupt will run from RAM and puts the flash into
standby mode. ePWM3 Interrupt will run from FLASH. All timers have the same period. The timers
are started sync’ed. An interrupt is taken on a zero event for each ePWM timer.GPIO34 is toggled
while in the background loop. Note:
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ePWM1: takes an interrupt every event

ePWM2: takes an interrupt every 2nd event

ePWM3: takes an interrupt every 3rd event Thus the Interrupt count for ePWM1, ePWM4-
ePWM6 should be equal The interrupt count for ePWM2 should be about half that of ePWM1
and the interrupt count for ePWM3 should be about 1/3 that of ePWM1

Follow these steps to run the program.

Build the project

Flash the .out file into the device.

Set the hardware jumpers to boot to Flash (put position 1 and 2 of SW2 on control Card to ON
position).

Use the included GEL file to load the project, symbols defined within the project and the
variables into the watch window.

Steps that were taken to convert the ePWM example from RAM to Flash execution:

Change the linker cmd file to reflect the flash memory map.

Make sure any initialized sections are mapped to Flash. In SDFlash utility this can be checked
by the View->Coff/Hex status utility. Any section marked as "load" should be allocated to
Flash.

Make sure there is a branch instruction from the entry to Flash at 0x3F7FF6 to the beginning
of code execution. This example uses the DSP0x_CodeStartBranch.asm file to accomplish
this.

Set boot mode Jumpers to "boot to Flash"

For best performance from the flash, modify the waitstates and enable the flash pipeline as
shown in this example. Note: any code that manipulates the flash waitstate and pipeline
control must be run from RAM. Thus these functions are located in their own memory section
called ramfuncs.

Watch Variables

EPwm1TimerIntCount

EPwm2TimerIntCount

EPwm3TimerIntCount

4.28 Flash Programming (flash_programming)

This example shows how to program flash using flash API. It shows.

The required software setup before calling the API (setting the PLL, checking for limp mode
etc.),

How to copy the API from flash into SARAM for execution.

How to call the API functions.

NOTE This example runs from Flash. First program the example into flash. The code will then copy
the API’s to RAM and modify the flash.
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4.29 FPU Hardware(fpu_hardware)

The code calculates two y=mx+b equations. The variables are all 32-bit floating-point.

The compiler will generate floating point instructions to do these calculations. To compile the project
for floating point, the following Build Options were used:

Project->Properties-> C/C++ Build window-> Basic Settings-> C2000 Compiler Vx.x
1. in All Options textbox: add "–float_support=fpu32" .
2. OR in Runtime Model Options, under "Specify floating point support (–float_support) pull-

down menu: Select "fpu32".
Project->Properties-> C/C++ Build window-> Basic Settings-> C2000 Linker Vx.x-> File
Search Path
1. In "Include linker file or command file as input (–library, -l)" box, click green plus sign and

add rts2800_fpu32.lib (run-time support library).
Not included in this example: If the project includes any other libraries, they must also be
compiled with floating point instructions.

Watch Variables:

y1 - Ordinate axis values of line 1
y2 - Ordinate axis values of line 2
FPU registers (optional)

4.30 FPU Software Emulation(fpu_software)

The code calculates two y=mx+b equations. The variables are all 32-bit floating-point.

The compiler will only used fixed point instructions. This means the runtime support library will be
used to emulate floating point. This will also run on C28x devices without the floating point unit. To
compile the project for fixed point, the following Build Options were used:

Project->Properties-> C/C++ Build window-> Basic Settings->C2000 Compiler Vx.x
1. in All Options textbox: "–float_support=fpu32" is removed.
2. OR in Runtime Model Options, under "Specify floating point support (–float_support) pull-

down menu: Select "None".
Project->Properties-> C/C++ Build window-> Basic Settings-> C2000 Linker Vx.x-> File
Search Path
1. In "Include linker file or command file as input (–library, -l)" box, click green plus sign and

add rts2800.lib or rts2800_ml.lib (run-time support library).
2. Not included in this example: If the project includes any other libraries, they must also be

compiled with fixed point instructions.

Watch Variables:

y1 - Ordinate axis values of line 1
y2 - Ordinate axis values of line 2
FPU registers (optional)
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4.31 GPIO Setup (gpio_setup)

This example Configures the 2806x GPIO into two different configurations This code is verbose
to illustrate how the GPIO could be setup.In a real application, lines of code can be combined for
improved code size and efficiency.

This example only sets-up the GPIO.. nothing is actually done with the pins after setup.

In general:

All pullup resistors are enabled. For ePWMs this may not be desired.

Input qual for communication ports (eCAN, SPI, SCI, I2C) is asynchronous

Input qual for Trip pins (TZ) is asynchronous

Input qual for eCAP and eQEP signals is synch to SYSCLKOUT

Input qual for some I/O’s and interrupts may have a sampling window

4.32 GPIO Toggle Test (gpio_toggle)

Note:
ALL OF THE I/O’S TOGGLE IN THIS PROGRAM. MAKE SURE THIS WILL NOT DAMAGE
YOUR HARDWARE BEFORE RUNNING THIS EXAMPLE.

Three different examples are included. Select the example (data, set/clear or toggle) to execute
before compiling using the macros found at the top of the code.

Each example toggles all the GPIOs in a different way, the first through writing values to the GPIO
DATA registers, the second through the SET/CLEAR registers and finally the last through the TOG-
GLE register

The pins can be observed using Oscilloscope.

4.33 HRCAP Capture HRPWM Pulses (hrcap_capture_hrpwm)

This program generates a high-resolution PWM output on ePWM1A (with falling edge moving by 8
HRPWM MEP steps per period), and the HRCAP is configured to generate an interrupt on either
rising edges OR falling edges to continuously capture up to 5 PWM periods (5 high pulses and 5
low pulses) and calculate the high resolution pulse widths in integer + fractional HCCAPCLK cycles
in Q16 format.

Monitor pulsewidthlow and pulsewidthhigh in the Watch Window (pulsewidthlow gradually de-
creases and pulsewidthhigh gradually increases as CMPAHR moves the falling edge MEP steps.)
Another option is to monitor periodwidth in the Watch Window, which should not change much
because the period stays the same.

User must set

• #define FALLTEST 1 and RISETEST 0 for falling edge interrupts
• #define RISETEST 1 and FALLTEST 0 for rising edge interrupts

To measure PERIOD, user must set: #define PERIODTEST 1
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To measure high pulse width or low pulse width, user must set: #define PERIODTEST 0

To determine the actual pulse width
period time in pulsewidthlow

pulsewidthhigh period:

pulsewidthinseconds = pulsewidth[n] ∗ (1HCCAPCLKcycle)

(i.e. 1 HCCAPCLK cycle is 8.33 ns for 120 MHz HCCAPCLK)

PLL2 is configured such that:

PLL2 = 60 MHz using INTOSC1 (10 MHz) as source
HCCAPCLK = 120 MHz

Note:
THE FOLLOWING DEFINITION AND STRUCTURE MUST BE DEFINED IN CODE IN
ORDER TO USE THE HCCAL LIBRARY

• #define NUM_HRCAP 5 // # of HRCAP modules + 1 (4 HRCAP’s on 2806x + 1 = 5)
• volatile struct HRCAP_REGS ∗HRCAP[NUM_HRCAP] = {0, &HRCap1Regs,

&HRCap2Regs, &HRCap3Regs, &HRCap4Regs};

Because there is no EMU FREE/STOP support in the HRCAP peripheral, the HRCAP results
cannot easily be seen in "Real-time continuous refresh" debug mode. The only way to see
accurate results of the capture is to set a breakpoint in the HRCAP ISR immediately after
data has been captured. Otherwise the results read at any other time in the program via the
debugger could be mid-capture between one period and the next, and therefore bogus.

External Connections

HRCAP1 is on GPIO27
ePWM1A is on GPIO0
Connect output of ePWM1A to input of HRCAP1 (GPIO0->GPIO27)

Watch Variables

pulsewidthlow
• Pulse Width of Low Pulses (# of HCCAPCLK cycles - int + frac) in Q16 format (i.e. upper

16-bits integer, lower 16-bits fraction)
pulsewidthhigh

• Pulse Width of High Pulses (# of HCCAPCLK cycles - int + frac) in Q16 format (i.e. upper
16-bits integer, lower 16-bits fraction)

periodwidth
• Period Width (# of HCCAPCLK cycles - int + frac) in Q16 format (i.e. upper 16-bits integer,

lower 16-bits fraction)

4.34 HRCAP Non-High Resolution Capture PWM Pulses
(hrcap_capture_pwm)

HRCAP2 is configured for non high-resolution capture mode to capture the time between rising and
falling edges of the PWM1A output. PLL2 clocks HRCAP2’s HCCAPCLK counter.

This example configures ePWM1A for:
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Up count

Period starts at 100 and goes up to 4000 then back down again.

Toggle output on PRD PLL2 is configured such that:

PLL2 = 60 MHz using INTOSC1 (10 MHz) as source

HCCAPCLK = 120 MHz

Note:
On Piccolo-B, the HCCAPCLK frequency is 2 ∗ SYSCLK.EPWM period in up-count mode
is TBPRD + 1 SYSCLK counts. Therefore,
ePWM period(up count mode) = 2 ∗ (TBPRD + 1)HCCAPCLK counts

Because there is no EMU FREE/STOP support in the HRCAP peripheral, the HRCAP
results cannot easily be seen in "Real-time continuous refresh" debug mode. The only way
to see accurate results of the capture is to set a breakpoint in the HRCAP ISR immediately
after data has been captured. Otherwise the results read at any other time in the program
via the debugger could be mid-capture between one period and the next, and therefore
bogus.
PULSEHIGH = (Uint32)(EPwm1Regs.TBPRD + 1) ∗ (HCCAPCLK_FREQ

SY SCLK_FREQ ) −
PWMUpcountperiodinHCSY NCCLKcounts
= TBPRD + 1 SYSCLK counts
=(TBPRD + 1)∗(HCCAPCLK_FREQ

SY SCLK_FREQ ) HCCAPCLK counts
The (HCCAPCLK_FREQ/SYSCLK_FREQ) ratio represents the number of of HCCAPCLK
cycles in 1 SYSCLK cycle

External Connections

HRCAP2 is on GPIO27

ePWM1A is on GPIO0

Connect output of ePWM1A to input of HRCAP2 (GPIO0->GPIO27)

Watch Variables

PULSELOW

• Pulse Width of Low Pulses (# of HCCAPCLK cycles - integer)

PULSEHIGH

• Pulse Width of High Pulses (# of HCCAPCLK cycles - integer)

4.35 High Resolution PWM (hrpwm)

This example modifies the MEP control registers to show edge displacement due to the HRPWM
control extension of the respective EPwm module All EPwm1A,2A,3A,4A channels (GPIO0, GPIO2,
GPIO4, GPIO6) will have fine edge movement due to HRPWM logic

1. PWM Freq = SY SCLK
period=10 ,

ePWM1A toggle low/high with MEP control on rising edge
ePWM1B toggle low/high with NO HRPWM control

1. PWM Freq = SY SCLK
period=20 ,
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ePWM2A toggle low/high with MEP control on rising edge
ePWM2B toggle low/high with NO HRPWM control

1. PWM Freq = SY SCLK
period=10 ,

ePWM3A toggle as high/low with MEP control on falling edge
ePWM3B toggle low/high with NO HRPWM control

1. PWM Freq = SY SCLK
period=20 ,

ePWM4A toggle as high/low with MEP control on falling edge
ePWM4B toggle low/high with NO HRPWM control

External Connections

Monitor ePWM1-ePWM4 pins on an oscilloscope as described below:

ePWM1A is on GPIO0
ePWM1B is on GPIO1

ePWM2A is on GPIO2
ePWM2B is on GPIO3

ePWM3A is on GPIO4
ePWM3B is on GPIO5

ePWM4A is on GPIO6
ePWM4B is on GPIO7

4.36 High Resolution PWM SFO V6 Duty Cycle
(hrpwm_duty_sfo_v6)

This example modifies the MEP control registers to show edge displacement due to the HRPWM
control extension of the respective ePWM module. This example calls the following TI’s MEP Scale
Factor Optimizer (SFO) software library V6 functions:

int SFO();

updates MEP_ScaleFactor dynamically when HRPWM is in use
updates HRMSTEP register (exists only in EPwm1Regs register space but valid for all chan-
nels) with MEP_ScaleFactor value
Returns

• 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion may
not function properly under this condition)

• 1 when complete for the specified channel
• 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code
efficiency. Refer to TI’s Digital power application examples and TI Digital Power Supply software
libraries for details. All ePWM1A-7A channels will have fine edge movement due to the HRPWM
logic
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Note:
This program requires the F2806x header files, which include the following files required
for this example: SFO_V6.h and SFO_TI_Build_V6.lib
For more information on using the SFO software library, see the 2803x High-Resolution
Pulse Width Modulator (HRPWM) Reference Guide

External Connections

Monitor ePWM1A-ePWM4A (GPIO0-GPIO7) pins on an oscilloscope.

Running the Application

1. ∗∗!!IMPORTANT!!∗∗ : in SFO_V6.h, set PWM_CH to the max number of HRPWM channels
plus one. For example, for the F2803x, the maximum number of HRPWM channels is 7.
7+1=8, so set #define PWM_CH 8 in SFO_V6.h. (Default is 8)

2. In this file, set #define AUTOCONVERT to 1 to enable MEP step auto-conversion logic. Oth-
erwise, to manually perform MEP calculations in software, clear to 0.

3. Run this example at maximum SYSCLKOUT (80MHz)

4. Add "UpdateFine" variable to the watch window either manually or using the supplied javascript

5. Activate Real time mode

6. Run the code

7. Watch ePWM A channel waveforms on a Oscilloscope

Watch Variables

UpdateFine

• Set the variable UpdateFine = 1 to observe the ePWMxA output with HRPWM capabilities
(default) Observe the duty cycle of the waveform change in fine MEP steps

• Change the variable UpdateFine to 0, to observe the ePWMxA output without HRPWM
capabilities Observe the duty cycle of the waveform change in coarse SYSCLKOUT cycle
steps.

4.37 High Resolution PWM SFO V6 High-Resolution
Period (Up-Down Count) Multi-channel
(hrpwm_mult_ch_prdupdown_sfo_v6)

This example modifies the MEP control registers to show edge displacement for high-resolution
period/frequency on multiple synchronized ePWM channels in Up-Down count mode due to the
HRPWM control extension of the respective ePWM module.

All period and compare register updates occur in an ISR which interrupts at ePWM1 TBCTR = 0.
This ensures that period and compare register updates across all ePWM modules occur within the
same period. This example calls the following TI’s MEP Scale Factor Optimizer (SFO) software
library V6 functions:

int SFO();

updates MEP_ScaleFactor dynamically when HRPWM is in use
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updates HRMSTEP register (exists only in EPwm1Regs register space but valid for all chan-
nels) with MEP_ScaleFactor value

Returns

• 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion may
not function properly under this condition)

• 1 when complete for the specified channel
• 0 if not complete for the specified channel

All ePWM1A-4A channels will be synchronized to each other (with ePWM1 sync’d to the SWF-
SYNC) and have fine edge period movement due to the HRPWM logic. This example can be used
as a primitive building block for applications which require high resolution frequency control with
synchronized ePWM modules (i.e. resonant converter applications)

Note:
This program requires the F2806x header files, which include the following files required
for this example: SFO_V6.h and SFO_TI_Build_V6.lib
For more information on using the SFO software library, see the High-Resolution Pulse
Width Modulator (HRPWM) section of the Technical Reference Manual

External Connections

Monitor ePWM1A-ePWM4A (GPIO0-GPIO7) pins on an oscilloscope.

Running the Application

1. ∗∗!!IMPORTANT!!∗∗ : in SFO_V6.h, set PWM_CH to the max number of HRPWM channels
used plus one. For this example, the maximum number of HRPWM channels used is 4. 4+1=5,
so set #define PWM_CH 5 in SFO_V6.h. (Default is 5)

2. Run this example at maximum SYSCLKOUT (80 MHz)

3. Add "UpdateFine" and "UpdateCoarse" variables to the watch window either manually or using
the supplied javascript.

4. Activate Real time mode

5. Run the code

6. Watch ePWM A channel waveforms on a Oscilloscope

Watch Variables

UpdateFine

• Set the variable UpdateFine = 1 to observe the ePWMxA output with HRPWM capabilities
(default) Observe the period/frequency of the waveform changes in fine MEP steps

• Change the variable UpdateFine to 0, to observe the ePWMxA output without HRPWM
capabilities

UpdateCoarse

• To change the period/frequency in coarse steps, uncomment the relevant code, re-build
and re-run with UpdateCoarse = 1. Observe the period/frequency of the waveform
changes in coarse SYSCLKOUT cycle steps.
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4.38 High Resolution PWM SFO V6 High-Resolution Pe-
riod (Up Count)(hrpwm_prdup_sfo_v6)

This example modifies the MEP control registers to show edge displacement for high-resolution
period with ePWM in Up count mode due to the HRPWM control extension of the respective ePWM
module. This example calls the following TI’s MEP Scale Factor Optimizer (SFO) software library
V6 functions:

int SFO();

updates MEP_ScaleFactor dynamically when HRPWM is in use
updates HRMSTEP register (exists only in EPwm1Regs register space but valid for all chan-
nels) with MEP_ScaleFactor value
Returns

• 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion may
not function properly under this condition)

• 1 when complete for the specified channel
• 0 if not complete for the specified channel

This example is intended to explain the HRPWM capabilities. The code can be optimized for code
efficiency. Refer to TI’s Digital power application examples and TI Digital Power Supply software
libraries for details. All ePWM1A-7A channels will have fine edge movement due to the HRPWM
logic

Note:
This program requires the F2806x header files, which include the following files required
for this example: SFO_V6.h and SFO_TI_Build_V6.lib
For more information on using the SFO software library, see the High-Resolution Pulse
Width Modulator (HRPWM) section of the Technical Reference Manual

External Connections

Monitor ePWM1A-ePWM4A (GPIO0-GPIO7) pins on an oscilloscope.

Running the Application

1. ∗∗!!IMPORTANT!!∗∗ : in SFO_V6.h, set PWM_CH to the max number of HRPWM channels
plus one. For example, for the F2803x, the maximum number of HRPWM channels is 7.
7+1=8, so set #define PWM_CH 8 in SFO_V6.h. (Default is 8)

2. Run this example at maximum SYSCLKOUT (80 MHz)
3. Add "UpdateFine" variable to the watch window either manually or using the supplied

javascript.
4. Activate Real time mode
5. Run the code
6. Watch ePWM A channel waveforms on a Oscilloscope

Watch Variables

UpdateFine
• Set the variable UpdateFine = 1 to observe the ePWMxA output with HRPWM capabilities

(default) Observe the period/frequency of the waveform changes in fine MEP steps
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• Change the variable UpdateFine to 0, to observe the ePWMxA output without HRPWM ca-
pabilities Observe the period/frequency of the waveform changes in coarse SYSCLKOUT
cycle steps.

4.39 High Resolution PWM SFO V6 High-Resolution Pe-
riod (Up-Down Count)(hrpwm_prdupdown_sfo_v6)

This example modifies the MEP control registers to show edge displacement for high-resolution
period with ePWM in Up-Down count mode due to the HRPWM control extension of the respective
ePWM module. This example calls the following TI’s MEP Scale Factor Optimizer (SFO) software
library V6 functions:

int SFO();

updates MEP_ScaleFactor dynamically when HRPWM is in use

updates HRMSTEP register (exists only in EPwm1Regs register space but valid for all chan-
nels) with MEP_ScaleFactor value

Returns

• 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion may
not function properly under this condition)

• 1 when complete for the specified channel
• 0 if not complete for the specified channel

This example is intended to explain the HRPWM configuration for high resolution period/frequency.
The code can be optimized for code efficiency. Refer to TI’s Digital power application examples
and TI Digital Power Supply software libraries for details. ePWM1A (GPIO0) will have fine edge
movement due to the HRPWM logic

Note:
This program requires the F2806x header files, which include the following files required
for this example: SFO_V6.h and SFO_TI_Build_V6.lib
For more information on using the SFO software library, see the High-Resolution Pulse
Width Modulator (HRPWM) section of the Technical Reference Manual

External Connections

Monitor ePWM1A (GPIO0) pin on an oscilloscope.

Running the Application

1. ∗∗!!IMPORTANT!!∗∗ : in SFO_V6.h, set PWM_CH to the max used HRPWM channel plus one.
For example, for the F2803x, the maximum number of HRPWM channels is 7. 7+1=8, so set
#define PWM_CH 8 in SFO_V6.h. (Default is 5)

2. For this specific example, you could set #define PWM_CH 2 (because it only uses ePWM1),
but to cover all examples, PWM_CH is currently set to a default value of 5.

3. Load the code and add the watch variables to the watch window. See below for a list of watch
variables

4. Run this example at maximum SYSCLKOUT (80 MHz)

5. Activate Real time mode
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6. Run the code
7. Watch ePWM1A waveform on a Oscilloscope

Watch Variables

UpdateFine
• Set the variable UpdateFine = 1 to observe the ePWMxA output with HRPWM capabilities

(default) Observe the period/frequency of the waveform changes in fine MEP steps
• Change the variable UpdateFine to 0, to observe the ePWMxA output without HRPWM ca-

pabilities Observe the period/frequency of the waveform changes in coarse SYSCLKOUT
cycle steps.

PeriodFine
EPwm1Regs.TBPRD
EPwm1Regs.TBPRDHR

4.40 High Resolution PWM with slider(hrpwm_slider)

This example modifies the MEP control registers to show edge displacement due to HRPWM con-
trol blocks of the respective EPwm module, EPwm1A, 2A, 3A, and 4A channels (GPIO0, GPIO2,
GPIO4, and GPIO6) will have fine edge movement due to HRPWM logic.

External Connections

Monitor EPwm1-EPwm4 pins on an oscilloscope as described below.

ePWM1A is on GPIO0
ePWM1B is on GPIO1
ePWM2A is on GPIO2
ePWM2B is on GPIO3
ePWM3A is on GPIO4
ePWM3B is on GPIO5

Running the Application

1. Launch the target configuration and connect to the target first
2. Load the program and set it up to run in real time mode. Do not run yet!
3. Load the Example_2806xHRPWM_slider.gel file (provided in the folder)
4. Select the F2806x HRPWM FineDutySlider from the Scripts menu (debug perspective). A

FineDuty slider graphics will show up in CCS. (See Below)
5. Add "DutyFine" variable to the watch window either manually or using the supplied javascript.

This variable is controlled by the slider
6. Run the example
7. Use the Slider to and observe the EPwm edge displacement for each slider step change. This

explains the MEP control on the EPwmxA channels,
(a) PWMFreq = SY SCLK

period=10

ePWM1A toggle low/high with MEP control on rising edge
PWMFreq = SY SCLK

period=10

ePWM1B toggle low/high with NO HRPWM control
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(b) PWMFreq = SY SCLK
period=20

ePWM2A toggle low/high with MEP control on rising edge
PWMFreq = SY SCLK

period=20

ePWM2B toggle low/high with NO HRPWM control
(c) PWMFreq = SY SCLK

period=10

ePWM3A toggle as high/low with MEP control on falling edge
PWMFreq = SY SCLK

period=10

ePWM3B toggle low/high with NO HRPWM control
(d) PWMFreq = SY SCLK

period=20

ePWM4A toggle as high/low with MEP control on falling edge
PWMFreq = SY SCLK

period=20

ePWM4B toggle low/high with NO HRPWM control

Watch Variables

DutyFine

Figure 4.1: Fine Duty Slider

4.41 High Resolution PWM Symmetric Duty Cycle SFO V6
(Up-Down Count)

This example modifies the MEP control registers to show edge displacement for high-resolution
period/frequency on two ePWM channels (ePWM 1 and ePWM 2) in Up-Down count mode due to
the HRPWM control extension of the respective ePWM module.

All period and compare register updates occur in an ISR which interrupts at ePWM1 TBCTR = 0.
This ensures that period and compare register updates across all ePWM modules occur within the
same period. This example calls the following TI’s MEP Scale Factor Optimizer (SFO) software
library V6 functions:

int SFO();

Tue Oct 29 00:38:03 IST 2024 85



Piccolo F2806x Example Applications

updates MEP_ScaleFactor dynamically when HRPWM is in use

updates HRMSTEP register (exists only in EPwm1Regs register space but valid for all chan-
nels) with MEP_ScaleFactor value

Returns

• 2 if error: MEP_ScaleFactor is greater than maximum value of 255 (Auto-conversion may
not function properly under this condition)

• 1 when complete for the specified channel
• 0 if not complete for the specified channel

Channels ePWM1A and ePWM2A will have fine edge movement due to the HRPWM logic when
the duty cycle is altered. Channels ePWM1B and ePWM2B have a fixed 50% duty cycle.

Note:
This program requires the F2806x header files, which include the following files required
for this example: SFO_V6.h and SFO_TI_Build_V6.lib
For more information on using the SFO software library, see the F2806x High-Resolution
Pulse Width Modulator (HRPWM) Reference Guide

External Connections

Monitor ePWM1A, ePWM1B, ePWM2A and ePWM2B (GPIO0-GPIO3) pins on an oscilloscope.

4.42 I2C EEPROM(i2c_eeprom)

This program requires an external I2C EEPROM connected to the I2C bus at address 0x50. This
program will write 1-14 words to EEPROM and read them back. The data written and the EEPROM
address written to are contained in the message structure, I2cMsgOut1. The data read back will
be contained in the message structure I2cMsgIn1.

Note:
This program will only work on kits that have an on-board I2C EEPROM.

Watch Variables

I2cMsgIn1

I2cMsgOut1

4.43 I2C EEPROM FIFO Interrupt Example
(i2c_eeprom_polling)

This program requires an external I2C EEPROM connected to the I2C bus with address 0x50
(EEPROM_SLAVE_ADDRESS).

This program will write 1-64 bytes, configured with EEPROM_DATA_BYTES, to the I2C EEPROM
and read them back using an interrupt based method. Writes to and reads from the I2C EEPROM
are configured using the EEPROM I2CHandle. The I2CHandle and functions the struct can be
passed to are defined in the i2cLib_FIFO_interrupt files.
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The data written to the EEPROM is contained in the TX message buffer, TxMsgBuffer. The data
read back will be contained in the RX message buffer, RxMsgBuffer.

Note:
This program will only work if an external I2C EEPROM is properly connected to the device’s
I2C SDA/SCL signals.

Watch Variables

TxMsgBuffer

RxMsgBuffer

4.44 I2C EEPROM FIFO Polling Example
(i2c_eeprom_polling)

This program requires an external I2C EEPROM connected to the I2C bus with address 0x50
(EEPROM_SLAVE_ADDRESS).

This program will write 1-64 bytes, configured with EEPROM_DATA_BYTES, to the I2C EEPROM
and read them back using a polling based method. Writes to and reads from the I2C EEPROM are
configured using the EEPROM I2CHandle. The I2CHandle and functions the struct can be passed
to are defined in the i2cLib_FIFO_polling files.

The data written to the EEPROM is contained in the TX message buffer, TxMsgBuffer. The data
read back will be contained in the RX message buffer, RxMsgBuffer.

Note:
This program will only work if an external I2C EEPROM is properly connected to the device’s
I2C SDA/SCL signals.

Watch Variables

TxMsgBuffer

RxMsgBuffer

4.45 LaunchPad Demo (launchxl_f28069m)

This program is the demo program that comes pre-loaded on the F28069M LaunchPad develop-
ment kit. The program starts by flashing the two user LEDs. After a few seconds the LEDs stop
flashing and samples the device’s internal temperature sensor to establish a reference. After this,
any difference between the current temperature and the reference is shown as a change in the
intensity of the two user LEDs.
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4.46 Low Power Modes: Halt Mode and Wakeup
(lpm_haltwake)

This example puts the device into HALT mode. If the lowest possible current consumption in HALT
mode is desired, the JTAG connector must be removed from the device board while the device is in
HALT mode.

The example then wakes up the device from HALT using GPIO0. GPIO0 wakes the device from
HALT mode when a high-to-low signal is detected on the pin. This pin must be pulsed by an external
agent for wakeup.

The wakeup process begins as soon as GPIO0 is held low for the time indicated in the device
datasheet. After the device wakes up, GPIO1 can be observed to go high.

GPIO0 is configured as the LPM wakeup pin to trigger a WAKEINT interrupt upon detection of a
low pulse. Initially, pull GPIO0 high externally. To wake device from halt mode, pull GPIO0 low for
at least the crystal startup time + 2 OSCLKS, then pull it high again.

To observe when device wakes from HALT mode, monitor GPIO1 with an oscilloscope (set to 1 in
WAKEINT ISR)

4.47 Low Power Modes: Device Idle Mode and
Wakeup(lpm_idlewake)

This example puts the device into IDLE mode then wakes up the device from IDLE using XINT1
which triggers on a falling edge from GPIO0.

This pin must be pulled from high to low by an external agent for wakeup. GPIO0 is configured as
an XINT1 pin to trigger an XINT1 interrupt upon detection of a falling edge.

Initially, pull GPIO0 high externally. To wake device from idle mode by triggering an XINT1 interrupt,
pull GPIO0 low (falling edge)

External Connections

To observe the device wakeup from IDLE mode, monitor GPIO1 with an oscilloscope, which goes
high in the XINT_1_ISR.

4.48 Low Power Modes: Device Standby Mode and
Wakeup(lpm_standbywake)

This example puts the device into STANDBY mode. If the lowest possible current consumption in
STANDBY mode is desired, the JTAG connector must be removed from the device board while the
device is in STANDBY mode.

GPIO0 is configured as the LPM wakeup pin to trigger a WAKEINT interrupt upon detection of a
low pulse. Initially, pull GPIO0 high externally. To wake device from standby mode, pull GPIO0 low
for at least (2+QUALSTDBY) OSCLKS, then pull it high again.

The example then wakes up the device from STANDBY using GPIO0. GPIO0 wakes the device
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from STANDBY mode when a low pulse (signal goes high->low->high)is detected on the pin. This
pin must be pulsed by an external agent for wakeup.

As soon as GPIO0 goes high again after the pulse, the device should wake up, and GPIO1 can be
observed to toggle.

External Connections

To observe when device wakes from STANDBY mode, monitor GPIO1 with an oscilloscope (set to
1 in WAKEINT ISR)

4.49 McBSP Loopback (mcbsp_loopback)

Three different serial word sizes can be tested. Before compiling this project, select the serial word
size of 8, 16 or 32 by using the #define statements at the beginning of the code.

This example does not use interrupts. Instead, a polling method is used to check the receive data.
The incoming data is checked for accuracy. If an error is found the error() function is called and
execution stops.

This program will execute until terminated by the user.

8-bit word example:

The sent data looks like this:

00 01 02 03 04 05 06 07 .... FE FF

16-bit word example:

The sent data looks like this:

0000 0001 0002 0003 0004 0005 0006 0007 .... FFFE FFFF

32-bit word example:

The sent data looks like this:

FFFF0000 FFFE0001 FFFD0002 .... 0000FFFF

Watch Variables:

sdata1 - Sent data word: 8 or 16-bit or low half of 32-bit

sdata2 - Sent data word: upper half of 32-bit

rdata1 - Received data word: 8 or 16-bit or low half of 32-bit

rdata2 - Received data word: upper half of 32-bit

rdata1_point - Tracks last position in receive stream 1 for error checking

rdata2_point - Tracks last position in receive stream 2 for error checking

Note:
sdata2 and rdata2 are not used for 8-bit or 16-bit word size

Tue Oct 29 00:38:03 IST 2024 89



Piccolo F2806x Example Applications

4.50 McBSP Loopback with DMA (mcbsp_loopback_dma)

This program is a McBSP example that uses the internal loopback of the peripheral and utilizes the
DMA to transfer data from one buffer to the McBSP, and then from the McBSP to another buffer.

Initially, sdata[] is filled with values from 0x0000- 0x007F. The DMA moves the values in sdata[]
one by one to the DXRx registers of the McBSP. These values are transmitted and subsequently
received by the McBSP. Then, the DMA moves each data value to rdata[] as it is received by the
McBSP.

The sent data buffer will alternate between:

0000 0001 0002 0003 0004 0005 .... 007F

and

FFFF FFFE FFFD FFFC FFFB FFFA ....

Three different McBSP serial word sizes can be tested. Before compiling this project, select the
serial word size of 8, 16 or 32 by using the #define statements at the beginning of the code.

This example uses DMA channel 1 and 2 interrupts. The incoming data is checked for accuracy. If
an error is found the error() function is called and execution stops.

By default for the McBSP examples, the McBSP sample rate generator (SRG) input clock frequency
is LSPCLK (80E6/4) assuming SYSCLKOUT = 80 MHz.

This example will execute until terminated by the user.

Watch Variables:

sdata - Sent data buffer

rdata - Received data buffer

4.51 McBSP Loopback with Interrupts
(mcbsp_loopback_interrupts)

This program is a McBSP example that uses the internal loopback of the peripheral. Both Rx and
Tx interrupts are enabled.

Incrementing values from 0x0000 to 0x00FF are being sent and received.

This pattern is repeated forever.

By default for the McBSP examples, the McBSP sample rate generator (SRG) input clock frequency
is LSPCLK 80E6/4.

Watch Variables:

sdata - Sent data word

rdata - Received data word

rdata_point - Tracks last position in receive stream for error checking
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4.52 McBSP Loopback using SPI mode
(mcbsp_spi_loopback)

This program will execute and transmit words until terminated by the user. SPI master mode transfer
of 32-bit word size with digital loopback enabled.

McBSP Signals - SPI equivalent

MCLKX - SPICLK (master)

MFSX - SPISTE (master)

MDX - SPISIMO

MCLKR - SPICLK (slave - not used for this example)

MFSR - SPISTE (slave - not used for this example)

MDR - SPISOMI (not used for this example)

By default for the McBSP examples, the McBSP sample rate generator (SRG) input clock frequency
is LSPCLK 80E6/4.

Watch Variables:

sdata1 - Sent data word(1)

sdata2 - Sent data word(2)

rdata1 - Received data word(1)

rdata2 - Received data word(2)

4.53 Handling NMI Watchdog (nmi_watchdog)

This example demonstrates how to capture a clock fail NMI when a missing clock is detected.

There are two variations of this example that can be selected by setting the respective "define"
below.

EXAMPLE1 captures the clock fail in the ISR and then re-enables the INTOSC before returning
to the application (No device reset)

EXAMPLE2 captures the clock fail in the ISR and waits for the device to reset. IMPORTANT
make sure to configure emulation boot mode to "boot to RAM". This can be done via GEL
script (In CCS, go to Scripts->EMU Boot Mode Select->EMU_BOOT_SARAM)

4.54 Internal Oscillator Compensation(osc_comp)

This program shows how to use the internal oscillator compensation functions in
F2806x_OscComp.c. The temperature sensor is sampled and the raw temp sensor value is
passed to the oscillator compensation function, which uses this parameter to compensate for
frequency drift of the internal oscillator over temperature
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Note:
This program makes use of variables stored in OTP during factory test on 2806x TMS
devices.
These OTP locations on pre-TMS devices may not be populated. Ensure that the following
memory locations in TI OTP are populated (not 0xFFFF) before use:

• 0x3D7E90 to 0x3D7EA4

Watch Variables

temp

SysCtrlRegs.INTOSC1TRIM

SysCtrlRegs.INTOSC2TRIM

4.55 SCI Echo Back(sci_echoback)

This test receives and echo-backs data through the SCI-A port.

The PC application ’hypterterminal’ can be used to view the data from the SCI and to send infor-
mation to the SCI. Characters received by the SCI port are sent back to the host.

Running the Application

1. Configure hyperterminal: Use the included hyperterminal configuration file SCI_96.ht. To load
this configuration in hyperterminal

(a) Open hyperterminal
(b) Go to file->open
(c) Browse to the location of the project and select the SCI_96.ht file.

2. Check the COM port. The configuration file is currently setup for COM1. If this is not correct,
disconnect (Call->Disconnect) Open the File-Properties dialog and select the correct COM
port.

3. Connect hyperterminal Call->Call and then start the 2806x SCI echoback program execution.

4. The program will print out a greeting and then ask you to enter a character which it will echo
back to hyperterminal.

Note:
If you are unable to open the .ht file, you can create a new one with the following settings

Find correct COM port
Bits per second = 9600
Date Bits = 8
Parity = None
Stop Bits = 1
Hardware Control = None

Watch Variables

LoopCount, for the number of characters sent

ErrorCount
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External Connections

Connect the SCI-A port to a PC via a transceiver and cable.

GPIO28 is SCI_A-RXD (Connect to Pin3, PC-TX, of serial DB9 cable)

GPIO29 is SCI_A-TXD (Connect to Pin2, PC-RX, of serial DB9 cable)

4.56 SCI Digital Loop Back(scia_loopback)

This program uses the internal loop back test mode of the peripheral. Other then boot mode pin
configuration, no other hardware configuration is required.

This test uses the loopback test mode of the SCI module to send characters starting with 0x00
through 0xFF. The test will send a character and then check the receive buffer for a correct match.

Watch Variables

LoopCount , Number of characters sent

ErrorCount , Number of errors detected

SendChar , Character sent

ReceivedChar , Character received

4.57 SCI Digital Loop Back with Inter-
rupts(scia_loopback_interrupts)

This program uses the internal loop back test mode of the peripheral. Other then boot mode pin
configuration, no other hardware configuration is required. Both interrupts and the SCI FIFOs are
used.

A stream of data is sent and then compared to the received stream. The SCI-A sent data looks like
this:

00 01

01 02

02 03

....

FE FF

FF 00

etc..

The pattern is repeated forever.

Watch Variables

sdataA , Data being sent

rdataA , Data received
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rdata_pointA ,Keep track of where we are in the datastream. This is used to check the
incoming data

4.58 SPI Digital Loop Back(spi_loopback)

This program uses the internal loop back test mode of the peripheral. Other then boot mode pin
configuration, no other hardware configuration is required. Interrupts are not used.

A stream of data is sent and then compared to the received stream. The sent data looks like this:

0000 0001 0002 0003 0004 0005 0006 0007 .... FFFE FFFF

This pattern is repeated forever.

Watch Variables

sdata , sent data

rdata , received data

4.59 SPI Digital Loop Back with Inter-
rupts(spi_loopback_interrupts)

This program uses the internal loop back test mode of the peripheral. Other then boot mode pin
configuration, no other hardware configuration is required. Both interrupts and the SPI FIFOs are
used.

A stream of data is sent and then compared to the received stream. The sent data looks like this:

0000 0001

0001 0002

0002 0003

....

FFFE FFFF

FFFF 0000

etc..

This pattern is repeated forever.

Watch Variables

sdata , Data to send

rdata , Received data

rdata_point , Used to keep track of the last position in the receive stream for error checking
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4.60 Software Prioritized Interrupts(sw_prioritized_interrupts)

For most applications, the hardware prioritizing of the the PIE module is sufficient. For applications
that need custom prioritizing, this example illustrates how this can be done through software.

For more information on F2806x interrupt priorities, refer to the "Example ISR Priorities" Appendix
in the Firmware Development Users guide

This program simulates interrupt conflicts by writing to the PIEIFR registers. This will cause multiple
interrupt requests to come into the PIE block at the same time.

The interrupt service routines are software prioritized as per the table found in the
F2806x_SWPrioritizedIsrLevels.h file.

Running the Application

1. Before compiling you must set the Global and Group interrupt priorities in the
F2806x_SWPrioritizedIsrLevels.h file.

2. Select which test case you’d like to run with the #define CASE directive (1-9, default 1).

3. Compile the code, load, and run

4. At the end of each test there is a hard coded breakpoint (ESTOP0). When code stops at the
breakpoint, examine the ISRTrace buffer to see the order in which the ISR’s completed. All
PIE interrupts will be added to the ISRTrace. The ISRTrace will consist of a list of hex values
as shown:
0x00wx <- PIE Group w interrupt x finished first
0x00yz <- PIE Group y interrupt z finished next

5. If desired, set a new set of Global and Group interrupt priorities and repeat the test to see the
change.

Watch Variables

ISRTrace , Trace of ISR’s in the order they complete. After each test, examine this buffer to
determine if the ISR’s completed in the order desired.

4.61 Timer based blinking LED(timed_led_blink)

This example configures CPU Timer0 for a 500 msec period, and toggles the GPIO34 LED once
per interrupt. For testing purposes, this example also increments a counter each time the timer
asserts an interrupt.

Watch Variables

CpuTimer0.InterruptCount

External Connections

Monitor the GPIO34 LED blink on (for 500 msec) and off (for 500 msec) on the 2806x control card.
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4.62 USB Generic Bulk Device (usb_dev_bulk)

This example provides a generic USB device offering simple bulk data transfer to and from the host.
The device uses a vendor-specific class ID and supports a single bulk IN endpoint and a single bulk
OUT endpoint. Data received from the host is assumed to be ASCII text and it is echoed back with
the case of all alphabetic characters swapped.

UART0, connected to the FTDI virtual COM port and running at 115,200, 8-N-1, is used to display
messages from this application.

A Windows INF file for the device is provided on the installation CD. This INF contains informa-
tion required to install the WinUSB subsystem on WindowsXP and Vista PCs. WinUSB is a Win-
dows subsystem allowing user mode applications to access the USB device without the need for a
vendor-specific kernel mode driver.

A sample Windows command-line application, usb_bulk_example, illustrating how to connect to
and communicate with the bulk device is also provided. Project files are included to allow the
examples to be built using Microsoft VisualStudio. Source code for this application can be found in
directory MWare/tools/usb_bulk_example.

4.63 USB HID Keyboard Device (usb_dev_keyboard)

This example application turns the evaluation board into a USB keyboard supporting the Human
Interface Device class. When the push button is pressed, a sequence of key presses is simulated
to type a string. Care should be taken to ensure that the active window can safely receive the text;
enter is not pressed at any point so no actions are attempted by the host if a terminal window is
used (for example). The status LED is used to indicate the current Caps Lock state and is updated
in response to any other keyboard attached to the same USB host system.

Because no USB evaluation kits currently exist the GPIOs for the push button and LED are NOT
implemented. The application can be tested as is by manually modifying the ulButton variable with
a debugger or the software can easily be modified by filling in appropriate code snippets in this file
where you find //TODO: comments.

The device implemented by this application also supports USB remote wakeup allowing it to request
the host to reactivate a suspended bus. If the bus is suspended (as indicated on the application dis-
play), pressing the push button will request a remote wakeup assuming the host has not specifically
disabled such requests.

UART0, connected to the FTDI virtual COM port and running at 115,200, 8-N-1, is used to display
messages from this application.

4.64 USB HID Mouse Device (usb_dev_mouse)

This example application turns the evaluation board into a USB mouse supporting the Human
Interface Device class. The mouse pointer will move in a square pattern for the duration of the time
it is plugged in.

UART0, connected to the FTDI virtual COM port and running at 115,200, 8-N-1, is used to display
messages from this application.
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4.65 USB Serial Device (usb_dev_serial)

This example application turns the evaluation kit into a virtual serial port when connected to the USB
host system. The application supports the USB Communication Device Class, Abstract Control
Model to redirect UART0 traffic to and from the USB host system.

A driver information (INF) file for use with Windows XP, Windows Vista and Windows7 can
be found in MWare/f2806x/windows_drivers. For Windows 2000, the required INF file is in
/MWare/f2806x/windows_drivers/win2K.

4.66 USB HID Keyboard Host (usb_host_keyboard)

This application demonstrates the handling of a USB keyboard attached to the evaluation kit. Once
attached, text typed on the keyboard will appear on the UART. Any keyboard that supports the USB
HID BIOS protocol is supported.

UART0, connected to the FTDI virtual COM port and running at 115,200, 8-N-1, is used to display
messages from this application.

4.67 USB HID Mouse Host (usb_host_mouse)

This application demonstrates the handling of a USB mouse attached to the evaluation kit. Once
attached, the position of the mouse pointer and the state of the mouse buttons are output to the
UART.

UART0, connected to the FTDI virtual COM port and running at 115,200, 8-N-1, is used to display
messages from this application.

4.68 USB Mass Storage Class Host (usb_host_msc)

This example application demonstrates reading a file system from a USB mass storage class de-
vice. It makes use of FatFs, a FAT file system driver. It provides a simple command console via the
UART for issuing commands to view and navigate the file system on the mass storage device.

The first UART, which is connected to the FTDI virtual serial port on the evaluation board, is con-
figured for 115,200 bits per second, and 8-N-1 mode. When the program is started a message will
be printed to the terminal. Type “help” for command help.

For additional details about FatFs, see the following site: http://elm-chan.org/fsw/ff/00index_e.html

4.69 Watchdog interrupt Test(watchdog)

This program exercises the watchdog.

First the watchdog is connected to the WAKEINT interrupt of the PIE block. The code is then put
into an infinite loop.
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The user can select to feed the watchdog key register or not by commenting the following line of
code in the infinite loop: ServiceDog();

If the watchdog key register is fed by the ServiceDog function then the WAKEINT interrupt is not
taken. If the key register is not fed by the ServiceDog function then WAKEINT will be taken.

Watch Variables

LoopCount , for the number of times through the infinite loop

WakeCount , for the number of times through WAKEINT
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5.1 Introduction

The goal of the CLA compiler is to implement enough of the C programming environment to make
it easier to access the capabilities of the CLA architecture and to make it easier to integrate CLA
task code and data into a C28x application.

The purpose of testing the prototype is to:

1. Provide feedback on the compiler implementation and to discover issues
2. Generate sample code that can be integrated into TI’s regression testing

The compiler is available on the Tools download page, CLA Beta Tools , along with each revision’s
README and defect history. Template projects that were part of the regression tests are now
incorporated in the examples\cla folder

All bugs, performance issues should be reported to Compiler Support, either at the forum Compiler
Forum or ClearQuest Report

5.2 Overview

The README.txt file included in the compiler download package contains the latest details on the
CLA compiler’s C language implementation and it is highly recommended that you go over this
document before you begin coding.

5.2.1 How to Invoke the CLA Compiler

The CLA compiler is invoked using the same command used for compiling C28x code
(cl2000[.exe]).

Files that have a .cla extension will be recognized by the compiler as CLA C files. The shell will
invoke separate CLA versions of the compiler passes to generate CLA-specific code. The object
files generated by the compiler can then be linked with C28x objects files to create a C28x/CLA
program.

Usage:

cl2000 -v28 –cla_support=cla0 [other options] file.cla
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NOTE: THE COMPILER DOES NOT SUPPORT COMPILING BOTH CLA AND C28X C FILES IN ONE
INVOCATION.

5.2.2 C Language Implementation

5.2.2.1 Characteristics

Language

Supports C only. No C++ or GCC extension support.

Data Types

(NOTE THE DIFFERENCES FROM C28X DATA TYPES!!)

char,short - 16 bits

int,long - 32 bits (’long long’ data type is not supported)

float, double, long double - 32 bits

pointers - 16 bits

IMPORTANT NOTES:

The CLA and C28x CPU have different type sizes.
•When declaring data that will be shared by both C28x and CLA use
type declarations that will result in objects of the same size
• To avoid ambiguity use typedefs for basic types that include size
information (eg. int32, uint16, etc)

The CLA architecture is oriented for 32-bit data types.
• 16-bit data types incur sign extension overhead and should primarily be used
for load/store operations such as reading/writing 16-bit peripherals.

Pointers are INTERPRETED differently
• Pointers on the C28 are 22-bits wide and require at minimum 2 contiguous 16-bit
locations for storage. As such they are treated as 32-bit data types(since we cannot
allocate 22 bit memory locations)
• The CLA treats pointers as 16-bit data types. Any pointer shared between the C28
and CLA will be interpreted as a 16-bit location by the CLA compiler and this could cause
undesired or bad data accesses by the CLA.

NOTE!! THE CLA COMPILER DOES NOT HAVE 64-BIT TYPE SUPPORT.
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Pragmas

The compiler accepts C28x pragmas except for the FAST_FUNC_CALL

C Standard Library

In general, the C standard library is not supported. abs() and fabs() are supported as intrinsics. An
inline fast floating-point divide is supported.

Keywords

The keywords ’__cregister’,’far’, and ’ioport’ are not recognized

Intrinsics

The following intrinsics are supported:

float __meisqrtf32(float)

float __meinvf32(float)

float __mminf32(float, float)

float __mmaxf32(float, float)

void __mswapf(float, float)

short __mf32toi16r(float)

unsigned short __mf32toui16r(float)

float __mfracf32(float)

__mdebugstop()

__meallow()

__medis()

__msetflg(unsigned short, unsigned short)

__mnop()
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5.2.3 Language Restrictions

Global Initialization

Defining and initializing global data is not supported.

Since the CLA code is executed in an interrupt driven environment there is no C system boot
sequence. As a result, definitions of the form ’int global_var = 5;’ are not allowed for variables that
are defined globally (outside the scope of a function). Initialization of global data must either be
done by the C28x driver code or within a function.

Variables defined as ’const’ can be initialized globally. The compiler will create initialized data sec-
tions named .const_cla to hold these variables. The same restriction applies to variables declared
as ’static’. Even if the variable is defined within a function.

Stack

Local variables and compiler temps are placed into a scratchpad memory area and accessed di-
rectly using the symbols ’__cla_scratchpad_start’ and ’__cla_scratchpad_end’. It is expected
that the user will manage this area and define these symbols using a linker command file.

IMPORTANT NOTES:

Local variables and compiler temps are expected to be placed into a scratchpad
memory area and accessed directly using the symbols ’__cla_scratchpad_start’
and ’__cla_scratchpad_end’.
• It is expected that the user will manage this area and define
these symbols using a linker command file.
• This scratchpad serves as a CLA stack.

To allow debug of local variables, the linker .cmd file has been updated
from that originally distributed
• Please ensure the changes to the .cmd file shown below are made
before proceeding.
• The linker file should look like the code shown below.
• This also required a compiler released after July 21, 2011.

The following is an example of what needs to be added to a linker command file to define the CLA
compiler scratchpad memory:

Define the scratchpad size - CLA_SCRATCHPAD_SIZE is a linker defined symbol that can
added to the application’s linker command file to designate the size of the scratchpad memory.

A SECTION’s directive can reference this symbol to allocate the scratchpad area. This direc-
tive reserves a 0x100 word memory hole to be used as the compiler scratchpad area.

The scratchpad area is named CLAscratch and is allotted to CLA Data RAM 1 (CLARAM1)

The value of CLA_SCRATCHPAD_SIZE can be changed based on the application.

//
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// Define a size for the CLA scratchpad area that will be used
// by the CLA compiler for local symbols and temps
// Also force references to the special symbols that mark the
// scratchpad area.
//

//
// If using --define CLA_SCRATCHPAD_SIZE=0x100, remove next line
//
CLA_SCRATCHPAD_SIZE = 0x100;
--undef_sym=__cla_scratchpad_end
--undef_sym=__cla_scratchpad_start

.....
MEMORY
{
.....
}
SECTIONS
{

//
// Must be allocated to memory the CLA has write access to
//
CLAscratch :

{ *.obj(CLAscratch)
. += CLA_SCRATCHPAD_SIZE;

*.obj(CLAscratch_end) } > CLARAM1, PAGE = 1
}

The scratchpad size can alternatively be defined and altered in the linker options of a project as
shown below

Figure 5.1: Adjusting scratchpad size through the linker options

Function Nesting

Only 2 levels of call stack depth is supported. See Section 5.2.5 for details on the calling conven-
tions.
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Recursion

Recursive function calls are not supported.

Function Pointers

Function pointers are not supported.

Other Operations

The following operations are currently not supported due to lack of instruction set support mak-
ing them expensive to implement. It is not clear that these operations are critical for typical CLA
algorithms.

Integer divide, modulus

Integer unsigned compares

5.2.4 Memory Model - Sections

CLA Program

The CLA compiler will place CLA code into section “Cla1Prog” as per the current convention used
for CLA assembly.

Global Data

Uninitialized global data will be placed in the section “.bss_cla”

Constants

Initialized constant data will be placed in section “.const_cla”

Heap

There is no support for operations such as malloc(). Therefore there is no C system heap for CLA.

5.2.5 Function Structure and Calling Conventions

Function Nesting

The compiler supports 2 level of function calls. Functions declared as interrupts may call leaf
functions only. Leaf function may not call other functions. Functions not declared as interrupt
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will be considered leaf functions. NOTE: THE CLA TASKS ARE PREFIXED WITH THE KEYWORD
’__interrupt’ TO SET THEM APART FROM LEAF FUNCTIONS. THEY ARE NOT TO BE CONFUSED WITH
C28X INTERRUPT SERVICE ROUTINES

Register Calling Convention

The CLA compiler supports calling functions with up to 2 arguments.

Pointer arguments are passed in MAR0/MAR1.

Integer/float arguments are passed in MR0,MR1.

Integer and float return values from functions are passed in MR0.

Pointer or return by reference value from functions are passed in MAR0.

Register Save/Restore

All registers except for MR3 are saved on call. MR3 is saved on entry. NOTE: IF YOU ARE WRITING
AN ASM ROUTINE TO BE CALLED IN THE C CONTEXT IT IS YOUR RESPONSIBILITY TO SAVE/RESTORE
MR3 UPON ENTRY AND EXIT RESPECTIVELY

Local Variables

A static scratchpad area is used as a stack for locals and compiler temporary variables. NOTE:THE
USER IS RESPONSIBLE FOR ENSURING THE SCRATCHPAD AREA IS ALLOCATED INTO THE MEMORY
MAP AND IS LARGE ENOUGH. THIS IS DONE USING THE EITHER THE LINKER COMMAND FILE OR
THROUGH THE PROJECT’S LINKER OPTIONS (SEE ABOVE).

Mixing CLA C and Assembly

When interfacing with CLA assembly language modules use the calling conventions defined above
to interface with compiled CLA code.

5.3 Framework

The CLA examples are in the folder “examples\cla”. Each example within this folder share a similar
structure as shown in the figure below (Fig. 5.2)
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Figure 5.2: Structure of a CLA example

For any given example there are 6 specific files associated with it as described in Table. 5.1.

Source File Description

<example>_main.c implements the main() routine. System and peripheral intialization is done
here along with setting up the CLA configuration registers.

<example>.cla The C implementation of all the CLA tasks. File level data global to the CLA
only(not shared with the C28x) should also be defined in this file.

<example>_run.c Contains routine test_run() called by main(). test_run() determines which CLA
tasks are triggered and if/how any data is passed to the task through the mes-
sage RAMs

<example>_shared.h External declarations for the global data defined in the C28x code and refer-
enced by the CLA task code.

<example>_shared_data.c Variables declared in <example>_shared.h are defined here and allocated to
memory (using #pragma DATA_SECTION). CLA VARIABLES MUST BE ALLO-
CATED TO A MEMORY SPACE THAT THE CLA HAS ACCESS TO, NAMELY THE
CLA<->CPU MESSAGE RAMS OR THE CLA DATA RAMS.

<example>_report.c Implements the routine test_report() which is called by main() after all CLA
tasks run to completion. The convention used for reporting test results is to
have the CLA task write results to a shared variable(s) and have the C28x
driver code call test_report() to compare the data to expected values and to
output the test run status to the CCS console. The convention used to check
the status of a test run is to expect the string “PASS” on success and “FAIL” on
failure. Other information can also be printed (eg. actual results vs expected
result) but the testing harness will expect, at the minimum, either PASS or FAIL
to be output.

Table 5.1: Example specific files

5.4 Getting Started with the CLA Compiler

The C code for the CLA is saved to a file with the .cla extension. At the time of writing this extension
is not natively recognized by either CCS5.
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NOTE: FOR EACH NEW WORKSPACE THE USER MUST CONFIGURE CCS IN THE MANNER DE-
SCRIBED BELOW

1. Go to Windows->Preferences->C/C++->File Types.

2. Select “New”

3. Type in *.cla in the top text box

4. In the drop down menu select C source file(see Fig. 5.3).

5. Select “ok”

Figure 5.3: Configuring CCS5 to recognize the .cla extension

The IDE will now recognize the .cla extension as code to be compiled.

IF YOU CREATE A NEW WORKSPACE YOU WILL NEED TO REPEAT THIS PROCESS. THERE WILL BE A
FUTURE UPDATE TO CCS TO ADD THE ASSOCIATION AUTOMATICALLY.

5.4.1 Creating Your Own Project

The simplest way to start writing code is to copy over an existing project (from the examples folder)
and to edit it. Lets take an example: I would like to create a new project, exp2, from an existing
project, atan.

1. Copy a Project:

Make a copy of the atan folder in the example directory and rename it to exp2

2. Rename Files:

Rename all files atan*.* to exp2*.*. (Notice the naming convention. All files have the test
folder name as a prefix, see Fig. 5.4 below)
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Figure 5.4: Creating a new project from existing examples

3. Edit the Project Files:

Open the .cproject and .project files in any text editor and replace all instances of the word
atan with exp2.
This will ensure all the object files come out with the correct name and any directory
dependencies are taken care of.
Each project has a predefined symbol, TEST_NAME=<test_name>. For e.g. the atan
project will have a predefined symbol, TEST_NAME=atan. By altering the .cproject files
in the manner described you wont have to change the build settings for each new project .

4. Import the Project:

Import the exp2 project into your workspace (see Fig. 5.5).
The files highlighted in the red box are common to all the CLA examples and are linked in
by the .project file. The rest of the source files are specific to each test case

Figure 5.5: Common source files for each CLA example
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5. Modify the Source:

Edit the test specific source files.

5.4.2 Suggested Build Options

The following table lists build options that are useful for CLA C code. You can setup build properties
that apply only to *.cla file by right clicking the file and selecting Properties->C/C++ Build.

Option Notes

Basic Options->Debugging Model->Full Symoblic debug (-g) If you would like to access
watch variables etc while debug-
ging(default setting).

Basic Options->Debugging Model->Suppress symbolic debug information View compiler generated as-
sembly code without all the de-
bug information.

Basic Options->Optimization Level = none - O2
DUE TO THE SMALL NUMBER
OF REGISTERS AVAILABLE LESS
AGGRESSIVE OPTIMIZATION MAY
YIELD BETTER RESULTS (EG. -
O1 VS -O2).

Assembly Options -> Keep generated assembly files (-k) Useful if you want to compare
compiler generated code with
hand coded assembly.

Table 5.2: Suggested Build Options

5.5 Debugging

The user can follow these steps to start debugging their code on the CLA (The project exp2 is used
as an example here)

1. Add __mdebugstop()

Place an __mdebugstop() at the beginning of the CLA task you wish to debug. For exam-
ple, task 1 of exp2.cla.

2. Set build options:

You can setup individual build properties for the *.cla file seperately from the rest of the
application.
Right click the .cla file and select Properties->C/C++ Build.

3. Connect to the CLA:

Once you have built your project and launched the debug session CCS, by default, will
connect to only the C28 core.
To be able to debug CLA code you will need to connect to the CLA core. The action of
connecting to the CLA core enables all software breakpoints and single-stepping abilities.
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IF YOU WISH TO STEP THROUGH C CODE BUILD THE PROJECT WITH -G (FULL SYMBOLIC
DEBUG) TO GENERATE THE SYMBOLS THAT WILL BE LOADED TO THE DEBUGGER.
(a) Click on the CLA debug session (highlighted in Fig. 5.6)
(b) Select Target->Connect to Target or hit Alt-C.
(c) Once the CLA core is connected proceed to load the project symbols by clicking on

Target->Load Symbols-><example>.out (e.g. exp2.out).

Figure 5.6: CLA Debug Session

4. Run the C28x:

In the exp2 example we have enabled task 1 of the CLA and we trigger it in software
on the C28 side. When we run the code on the C28 debug session it seems to stall at
the Cla1ForceTask1andWait() routine. It is waiting for the CLA task 1 to run to comple-
tion. When we switch over to the CLA session we see that execution has stopped at the
__mdebustop() intrinsic

5. Debug the Code:

At this point we can proceed to single step through the code or continue till completion.
There are some restrictions to debugging the CLA and they are discussed next.

5.6 Known Debugging Issues

1. The CLA pipeline is not flushed on a single step and so results may not be visible until a few
instructions later. Please refer to the CLA user guide or the device Technical Reference Man-
ual for more details about the pipeline.
UNLIKE THE C28, SINGLE-STEPPING ON THE CLA DOES NOT FLUSH THE PIPELINE AND EXE-
CUTE AN INSTRUCTION , IT MERELY MOVES THE PIPELINE FORWARD BY ONE STAGE)

2. If you plan to debug (single step) code on the CLA it is necessary that MNOPs are placed prior
to any MSTOP to ensure the instructions prior to the MSTOP proceed through the pipeline
before the MSTOP executes. The compiler will insert these MNOPs if compiling with debug
(-g). The MNOPs are unnecessary if you are not debugging the CLA code.

3. YOU WILL NOT BE ABLE TO EXECUTE THE “RUN TO LINE” OR “STEP OVER” COMMANDS ON
THE CLA. BE SURE TO PLACE __MDEBUGSTOP() INTRINSICS AROUND FUNCTIONS YOU WISH
TO STEP OVER AND HAVE THE CORE RUN TO THESE BREAKPOINTS DIRECTLY
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5.7 Tips and Tricks

5.7.1 Dealing with Pointers

Pointers are interpreted differently on the C28x and the CLA. The C28 treats them as 32-bit data
types(address size is 22-bits) while the CLA can only use an address size of 16 bits. Assume the
following structure is declared in a shared header file(i.e. common to the C28 and CLA) and defined
and allocated to a memory section in a .c file

/********************************************************************
Shared Header File

********************************************************************/
typedef struct{

float a;
float *b;
float *c;

} foo;

/********************************************************************
main.c

********************************************************************/
#pragma(X,"CpuToCla1MsgRam") //Assign X to section CpuToCla1MsgRam
foo X;

/********************************************************************
test.cla

********************************************************************/
__interrupt void
Cla1Task1 ( void )
{

float f1,f2;
f1 = *(X.b);

//
// Pointer incorrectly dereferenced
// Tries to access location 0x1503 instead of 0x1504
//
f2 = *(X.c);

}

Assume that the C28 compiler will allocate space for X at the top of the section CpuToCla1MsgRam
as follows:

Element Address
X.a 0x1500
X.b 0x1502
X.c 0x1504

The CLA compiler will interpret this structure differently
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Element Address
X.a 0x1500
X.b 0x1502
X.c 0x1503

The CLA compiler treats pointers b and c as 16-bits wide and therefore incorrectly dereferences
pointer c.

The solution to this is to declare a new pointer as follows:

/********************************************************************
Shared Header File

********************************************************************/
typedef union{

float *ptr; //Aligned to lower 16-bits
Uint32 pad; //32-bits

} CLA_FPTR;

typedef struct{
float a;
CLA_FPTR b;
CLA_FPTR c;

} foo;

/********************************************************************
main.c

********************************************************************/
#pragma(X,"CpuToCla1MsgRam") //Assign X to section CpuToCla1MsgRam
foo X;

/********************************************************************
test.cla

********************************************************************/
__interrupt void
Cla1Task1 ( void )
{

float f1,f2;
f1 = *(X.b.ptr);
f2 = *(X.c.ptr); //Correct Access

}

The new pointer CLA_FPTR is a union of a 32-bit integer and a pointer to a float. The CLA compiler
recognizes the size of the larger of the two elements(the 32 bit integer) and therefore aligns the
pointer to the lower 16-bits. Now both the pointers b and c will occupy 32-bit memory spaces and
any instruction that tries to dereference pointer c will access the correct address 0x1504.

5.7.2 Benchmarking

The CLA does not support the clock function and therefore it is not possible to get a direct cycle
count of a particular task. The user can configure the time base module on an ePWM to keep track
of the execution time of a task
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Setup the time base of ePWM1(or any ePWM) to run at SYSCLKOUT in the up-count mode as
shown below:

void
InitEPwm(void)
{

//
// Setup TBCLK
//
EPwm1Regs.TBCTL.bit.CTRMODE = TB_COUNT_UP; // Count up
EPwm1Regs.TBPRD = 0xFFFF; // Set timer period
EPwm1Regs.TBCTL.bit.PHSEN = TB_DISABLE; // Disable phase loading
EPwm1Regs.TBPHS.half.TBPHS = 0x0000; // Phase is 0
EPwm1Regs.TBCTR = 0x0000; // Clear counter
EPwm1Regs.TBCTL.bit.HSPCLKDIV = TB_DIV1; // Clock ratio to SYSCLKOUT
EPwm1Regs.TBCTL.bit.CLKDIV = TB_DIV1;

}

Proceed to define two macros READ_CLOCK and RESTART_CLOCK, the former to freeze the
ePWM timer and copy the elapsed time to a variable, and the latter to restart the ePWM timer.

#define READ_CLOCK(X) __meallow();\
EPwm1Regs.TBCTL.bit.CTRMODE = TB_FREEZE;\
X = EPwm1Regs.TBCTR;\
__medis();

#define RESTART_CLOCK __meallow();\
EPwm1Regs.TBCTL.bit.CTRMODE = TB_FREEZE;\
EPwm1Regs.TBCTR = 0;\
EPwm1Regs.TBCTL.bit.CTRMODE = TB_COUNT_UP;\
__medis();

Define a variable e.g. ulCycleCount to hold the cycle count

#pragma DATA_SECTION(ulCycleCount,"Cla1ToCpuMsgRAM");
unsigned long ulCycleCount;

Place the macro RESTART_CLOCK at the beginning of a task to restart the ePWM timer and place
READ_CLOCK at the end of the task to read the value of the timer. The elapsed time will be give
you the cycle count plus a minimal overhead from the two macros

__interrupt void
Cla1Task1 ( void )
{

//
// Local Variables
//
float a;

__mdebugstop();
RESTART_CLOCK;
a = 10;
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...

...

...
READ_CLOCK(ulCycleCount);

}

5.7.3 Mixing C and Assembly Tasks

It is possible to implement some tasks in assembly while some in C. In a .asm you can declare the
task with a symbol e.g. (_Cla1Task1) and must assign it to the memory section Cla1Prog. Define
a symbol at the head of the section e.g. _Cla1Prog_ASM_start

.sect "Cla1Prog"
_Cla1Prog_ASM_start:

.align 2
_Cla1Task1:

...

...

...
MSTOP

_Cla1Task1End:

The C tasks are defined in the usual way. The only difference between the two is the manner in
which the MVECT’s are initialized

For assembly tasks the MVECT is as follows:

Cla1Regs.MVECT1 = (Uint16) (&Cla1Task1 - &Cla1Prog_ASM_start)*sizeof(Uint32);

while for C tasks, it is:

Cla1Regs.MVECT1 = (Uint16)((Uint32)&Cla1Task1 - (Uint32)&Cla1Prog_Start);

where Cla1Prog_Start is a linker defined variable which must be declared in a .c file with the
storage classifier extern
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6 CLA ’C’ Example Applications
These examples demonstrate the use of the C compiler, programming model and coding practices
to generate efficient code.

Notes

All examples require the F2806x header files
All examples run at max SYSCLOCK of 80MHz. This is the default setting assuming the input
clock is derived from the 10MHz internal clock.
C code for the CLA is in the files with the .cla extension

6.1 ACOS Table-Lookup Algorithm

This example implements a table lookup method of determining the arccosine of a value.

Watch Variables

y - Accumulated results (angles in radians)

Memory Allocation

CLA1 Math Tables (RAML2)
• CLAacosinTable - Lookup table

CLA1 to CPU Message RAM
• fResult - Result of the lookup algorithm

CPU to CLA1 Message RAM
• fVal - Sample input to the lookup algorithm

6.2 ASIN Table-Lookup Algorithm

This example implements a table lookup method of determining the arcsine of a value.

Watch Variables

y - Accumulated results (angles in radians)

Memory Allocation

CLA1 Math Tables (RAML2)
• CLAasinTable - Lookup table

CLA1 to CPU Message RAM
• fResult - Result of the lookup algorithm

CPU to CLA1 Message RAM
• fVal - Sample input to the lookup algorithm
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6.3 ATAN Table-Lookup Algorithm

This example implements a table lookup method of determining the arctangent of a value.

Watch Variables

y - Accumulated results (angles in radians)

Memory Allocation

CLA1 Math Tables (RAML2)

• CLAatan2Table - Lookup table

CLA1 to CPU Message RAM

• fResult - Result of the lookup algorithm

CPU to CLA1 Message RAM

• fNum - Numerator of sample input
• fDen - Denominator of sample input

6.4 CRC8 Table-Lookup Algorithm

This example implements a table lookup method of determining the 8-bit CRC of a message se-
quence. The polynomial used is 0x07

Watch Variables

crc8_msg1 - CRC of message 1

crc8_msg2 - CRC of message 2

crc8_msg3 - CRC of message 3

crc8_msg4 - CRC of message 4

fail_flag

Memory Allocation

CLA1 Data RAM 1(RAML2)

• table - CRC Lookup table

CLA1 to CPU Message RAM

• crc8_msg1 - CRC of message 1
• crc8_msg2 - CRC of message 2
• crc8_msg3 - CRC of message 3
• crc8_msg4 - CRC of message 4

CPU to CLA1 Message RAM

• msg1 - Test message 1
• msg2 - Test message 2
• msg3 - Test message 3
• msg4 - Test message 4
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6.5 CRC8 Table-generation Algorithm

This example will generate the lookup table for an 8bit CRC checker with the polynomial 0x07

Watch Variables

table - Lookup table

Memory Allocation

CLA1 Data RAM 1(RAML2)

• table - CRC Lookup table

6.6 Determinant of a 3X3 Matrix

In this example, Task 1 of the CLA will calculate the determinant of a 3x3 matrix

Watch Variables

fDet - Determinant of the 3x3 matrix

Memory Allocation

CLA1 to CPU Message RAM

• fDet - Determinant of the 3x3 matrix

CPU to CLA1 Message RAM

• x - 3x3 input matrix

6.7 Division: Newton Raphson Approximation

In this example, Task 1 of the CLA will divide two input numbers using multiple approximations in
the Newton Raphson method

Watch Variables

Num - Numerator of input

Den - Denominator of input

Res - Result of the division operation

Memory Allocation

CLA1 to CPU Message RAM

• Res - Result of the division operation

CPU to CLA1 Message RAM

• Num - Numerator of input
• Den - Denominator of input
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6.8 10X using a lookup table

In this example, Task 1 of the CLA will calculate the Xth power of 10 using a table lookup method

Watch Variables

Val - Input

ExpRes - Result of 10V al

Memory Allocation

CLA1 Math Tables (RAML2)

• CLAexpTable - Lookup table

CLA1 to CPU Message RAM

• ExpRes - Result of the exponentiation operation

CPU to CLA1 Message RAM

• Val - Test Input

6.9 e
A
B using a lookup table

In this example, Task 1 of the CLA will divide two input numbers using multiple approximations in
the Newton Raphson method and then calculate the exponent of the result using a lookup table

Watch Variables

Num - Numerator of input

Den - Denominator of input

ExpRes - Result of e
Num
Den

Memory Allocation

CLA1 Math Tables (RAML2)

• CLAexpTable - Lookup table

CLA1 to CPU Message RAM

• ExpRes - Result of the exponentiation operation

CPU to CLA1 Message RAM

• Num - Numerator of input
• Den - Denominator of input

6.10 Finite Impulse Response Filter

A 5 tap FIR filter is implemented in Task 1 of the CLA.

Watch Variables
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xResult - Result of the FIR operation

xAdcInput - Simulated ADC input

Memory Allocation

CLA1 Data RAM 1 (RAML2)

• fCoeffs - Filter Coefficients
• fDelayLine - Delay line memory elements

CLA1 to CPU Message RAM

• xResult - Result of the FIR operation

CPU to CLA1 Message RAM

• xAdcInput - Simulated ADC input

6.11 2 Pole 2 Zero Infinite Impulse Response Filter

This example implements a Transposed Direct Form II IIR filter, commonly known as a Biquad. The
input vector is a software simulated noisy signal that is fed to the biquad one sample at a time,
filtered and then stored in an output buffer for storage.

Watch Variables

fBiquadOutput

Memory Allocation

CLA1 Data RAM 1 (RAML2)

• S1_A - Feedback coefficients
• S1_B - Feedforward coefficients

CLA1 to CPU Message RAM

• yn - Output of the Biquad

CPU to CLA1 Message RAM

• xn - Sample input to the filter

The coefficients in this example were generated in MATLAB using “fdatool” as shown in fig.6.1.
The Frequency specification shown in the image is for demonstration purposes only and was not
used to generate the coefficients in the example code.
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Figure 6.1: MATLAB: fdatool

Once the parameters are set and the filter designed, the user can view the coefficients from the
analysis menu shown below

Figure 6.2: Viewing the coefficients
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MATLAB implements IIR filters in cascading “Second Order Section” of the form

Y (z)

X(z)
=

b(0) + b(1)z−1 + b(2)z−2

a(0) + a(1)z−1 + a(2)z−2
(6.1)

In the code, however, the equation is implemented as follows

y(n) =
1

a(0)
× (b(0)x(n) + b(1)x(n− 1) + b(2)x(n− 2) + (−a(1))y(n− 1) + (−a(2))y(n− 2)) (6.2)

The “a” coefficients, with the exception of a(0), must be negated. In the example, the original
coefficients were

Numerator = [0.02008, 0.04017, 0.02008]
Denominator = [1.0, -1.56102, 0.64135]

The “a” coefficients(except a(0)) are negated to fit the second-order structure implemented in code.

#pragma DATA_SECTION(S1_B,"Cla1DataRam1")
float S1_B[]={0.02008, 0.04017, 0.02008};
#pragma DATA_SECTION(S1_A,"Cla1DataRam1")
float S1_A[]={1.0, 1.56102, -0.64135};

Note that a(0) is hardcoded to a constant(1) and, as such, is not required in the coefficient array. It
is present only to facilitate readability of the code.

6.12 Logic Test

In this example, Task 1 of the CLA implements a set of logic
tests. More information about these logic statements can be found at:
http://graphics.stanford.edu/∼seander/bithacks.html#OperationCounting

Watch Variables

cla_pass_count - Logic test pass count

cla_fail_count - Logic test fail count

Memory Allocation

CLA1 to CPU Message RAM

• cla_pass_count - Logic test pass count
• cla_fail_count - Logic test fail count
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6.13 Matrix Multiplication

Task 1 multiplies two 3x3 matrices

Watch Variables

x - 3X3 Input Matrix
y - 3X3 Input Matrix
z - Result of the matrix multiplication

Memory Allocation

CLA1 to CPU Message RAM
• z - Result of the matrix multiplication

CPU to CLA1 Message RAM
• x - 3X3 Input Matrix
• y - 3X3 Input Matrix

6.14 Matrix Transpose

Task 1 calculates the transpose of a 3x3 matrices

Watch Variables

x - 3X3 Input Matrix
z - Transposed Matrix

Memory Allocation

CLA1 to CPU Message RAM
• z - Transposed Matrix

CPU to CLA1 Message RAM
• x - 3X3 Input Matrix

6.15 Primes

Task 1 calculates the set of prime numbers upto a length defined by the user

Watch Variables

in - Input test vector
out - Set of primes

Memory Allocation

CLA1 Data RAM 1 (RAML2)
• out - Set of primes
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6.16 Shell Sort

Task 1 will perform the shell sort iteratively. Task 2 will do the same with mswapf intrinsic and Task
3 will also implement an in-place sort on an integer vector

Watch Variables

vector3 - Input/Output to task 3(in-place sorting)

vector1_sorted - Sorted output Task 1

vector2_sorted - Sorted output Task 2

vector1 - Input vector to task 1

vector2 - Input vector to task 2

Memory Allocation

CLA1 Data RAM 1 (RAML2)

• vector3 - Input/Output to task 3(in-place sorting)

CLA1 to CPU Message RAM

• vector1_sorted - Sorted output Task 1
• vector2_sorted - Sorted output Task 2

CPU to CLA1 Message RAM

• vector1 - Input vector to task 1
• vector2 - Input vector to task 2

6.17 Square Root

Task 1 calculates the square root of a number using multiple iterations of the Newton-Raphson
approximation

Watch Variables

fVal - Input value

fResult -
√
fV al

Memory Allocation

CLA1 to CPU Message RAM

• fResult -
√
fV al

CPU to CLA1 Message RAM

• fVal - Input value
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6.18 Vector Inverse

Task 1 calculates the element-wise inverse of a vector while Task 2 calculates the element-wise
inverse of a vector and saves the result in the same vector

Watch Variables

vector1 - Input vector to task 1

vector1_inverse - Inverse of input vector1

vector2 - Input/Output vector for task 2

Memory Allocation

CLA1 Data RAM 1 (RAML2)

• vector2 - Input/Output vector for task 2

CLA1 to CPU Message RAM

• vector1_inverse - Inverse of input vector1

CPU to CLA1 Message RAM

• vector1 - Input vector to task 1

6.19 Vector Maximum

Task 1 calculates the vector max moving backward through the array. Task 2 calculates the vector
max moving forward through the array. Task 3 calculates the vector max using the ternary operator.
Task 2 calculates the vector max using min/max intrinsics

Watch Variables

vector1 - Input vector to task 1

vector2 - Input vector to task 2

vector3 - Input vector to task 3

vector4 - Input vector to task 4

max1 - Maximum value in vector 1

index1 - Index of the maximum value in vector 1

max2 - Maximum value in vector 2

index2 - Index of the maximum value in vector 2

max3 - Maximum value in vector 3

index3 - Index of the maximum value in vector 3

max4 - Maximum value in vector 4

min4 - Minimum value in vector 4

Memory Allocation

CLA1 to CPU Message RAM

• max1 - Maximum value in vector 1
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• index1 - Index of the maximum value in vector 1
• max2 - Maximum value in vector 2
• index2 - Index of the maximum value in vector 2
• max3 - Maximum value in vector 3
• index3 - Index of the maximum value in vector 3
• max4 - Maximum value in vector 4
• min4 - Minimum value in vector 4

CPU to CLA1 Message RAM

• vector1 - Input vector to task 1
• vector2 - Input vector to task 2
• vector3 - Input vector to task 3
• vector4 - Input vector to task 4
• length1 - Length of vector 1
• length2 - Length of vector 2

6.20 Vector Minimum

Task 1 calculates the vector min moving backward through the array. Task 2 calculates the vector
min moving forward through the array. Task 3 calculates the vector min using the ternary operator.

Watch Variables

vector1 - Input vector to task 1

vector2 - Input vector to task 2

vector3 - Input vector to task 3

min - Minimum value in vector 1

index1 - Index of the minimum value in vector 1

min2 - Minimum value in vector 2

index2 - Index of the minimum value in vector 2

min3 - Minimum value in vector 3

index3 - Index of the minimum value in vector 3

Memory Allocation

CLA1 to CPU Message RAM

• min1 - Minimum value in vector 1
• index1 - Index of the minimum value in vector 1
• min2 - Minimum value in vector 2
• index2 - Index of the minimum value in vector 2
• min3 - Minimum value in vector 3
• index3 - Index of the minimum value in vector 3

CPU to CLA1 Message RAM

• vector1 - Input vector to task 1
• vector2 - Input vector to task 2
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• vector3 - Input vector to task 3
• length1 - Length of vector 1
• length2 - Length of vector 2
• length3 - Length of vector 3
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7 Development System Utilities
These are tools that run on the development system, not on the embedded target. They are pro-
vided to assist in the development of firmware for C2000 microcontrollers.

These tools reside in the MWare/tools subdirectory of C2000Ware within the current version of
f2806x folder

USB Dynamic Link Library

Description:
TIUSBDLL is a simple Windows dynamic link library offering low level packet read and write
functions for some USB-connected ControlSUITE example applications. The DLL is written
above the Microsoft WinUSB interface and is intended solely to ensure that various Windows-
side example applications can be built without having to use WinUSB header files. These
header files are not included in the Visual Studio tools and are only shipped in the Windows
Device Driver Kit (DDK). By providing this simple mapping DLL which links to WinUSB, the
user avoids the need for a multi-gigabyte download to build the examples.

The source code for this DLL is contained in tools/tiusbdll. A Microsoft Visual Studio
2010 project file is provided to allow the DLL to be built on a PC which has the Windows
Device Driver Kit installed.

USB DFU Library

Description:
TIDFU is a Windows dynamic link library offering a high level interface to the USB Device
Firmware Upgrade functionality provided by the USB boot loader (boot_usb). This DLL is used
by the dfuprog utility and also by the to allow download and upload of application images to or
from a TI-based MCU board via USB.

The source code for this DLL is contained in tools/tidfu. A Microsoft Visual Studio 2010
project file is provided to allow the application to be built.

USB DFU Programmer

Usage:
dfuprog [OPTION]...

Description:
Downloads images to a Texas Instruments microcontroller running the USB Device Firmware
Upgrade boot loader. Additionally, this utility may be used to read back the existing application
image or a subsection of flash and store it either as raw binary data or as a DFU-downloadable
image file.

The source code for this utility is contained in tools/dfuprog. A Microsoft Visual Studio
project file is provided to allow the application to be built.
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Arguments:
-e specifies the address of the binary.
-u specifies that an image is to be uploaded from the board into the target file. If absent, the

file will be downloaded to the board.
-c specifies that a section of flash memory is to be cleared. The address and size of the block

may be specified using the -a and -l parameters. If these are absent, the entire writable
area of flash is erased.

-f FILE specifies the name of the file to download or, if -u is given, to upload.
-b specifies that an uploaded file is to be stored as raw binary data without the DFU file wrap-

per. This option is only valid if used alongside -u.
-d specifies that the VID and PID in the DFU file wrapper should be ignored for a download

operation.
-s specifies that image verification should be skipped following a download operation.
-a ADDR specifies the address at which the binary file will be downloaded or from which an

uploaded file will be read. If a download operation is taking place and the source file
provided is DFU-wrapped, this parameter will be ignored.

-l SIZE specifies the number of bytes to be uploaded when used in conjunction with -i or the
number of bytes of flash to erase if used in conjunction with -c.

-i NUM specifies the zero-based index of the USB DFU device to access if more than one is
currently attached to the system. If absent, the first device found is used.

-x specifies that destination file for an upload operation should be overwritten without prompt-
ing if it already exists.

-w specifies that the utility should wait for the user to press a key before it exits.
-v displays verbose output during the requested operation.
-h displays this help information.
-? displays this help information.

Example:
The following example writes binary file program.bin to the device flash memory at address
0x1800:

dfuprog -f program.bin -a 0x1800

The following example writes DFU-wrapped file program.dfu to the flash memory of the second
connected USB DFU device at the address found in the DFU file prefix:

dfuprog -i 1 -f program.dfu

The following example uploads (reads) the current application image into a DFU-formatted file
appimage.dfu:

dfuprog -u -f appimage.dfu

USB Bulk Data Transfer Example

Description:
usb_bulk_example is a Windows command line application which communicates with the
C2000Ware usb_dev_bulk example. The application finds the C2000 device on the USB bus
then, if found, prompts the user to enter strings which are sent to the application running on the
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C2000 board. This application then inverts the case of the alphabetic characters in the string
and returns the data back to the USB host where it is displayed.

The source code for this application is contained in tools/usb_bulk_example. The binary
can be found in the tools/usb_bulk_example/debug directory. A Microsoft Visual Studio
project file is provided to allow the application to be built.
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8.1 Introduction

The command line processor allows a simple command line interface to be made available in an
application, for example via a UART. It takes a buffer containing a string (which must be obtained
by the application) and breaks it up into a command and arguments (in traditional C “argc, argv”
format). The command is then found in a command table and the corresponding function in the
table is called to process the command.

This module is contained in utils/cmdline.c, with utils/cmdline.h containing the API def-
initions for use by applications.

8.2 API Functions

8.3 Programming Example

The following example shows how to process a command line.

//
// Code for the "foo" command.
//
int
ProcessFoo(int argc, char *argv[])
{

//
// Do something, using argc and argv if the command takes arguments.
//

}

//
// Code for the "bar" command.
//
int
ProcessBar(int argc, char *argv[])
{

//
// Do something, using argc and argv if the command takes arguments.
//

}

//
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// Code for the "help" command.
//
int
ProcessHelp(int argc, char *argv[])
{

//
// Provide help.
//

}

//
// The table of commands supported by this application.
//
tCmdLineEntry g_sCmdTable[] =
{

{ "foo", ProcessFoo, "The first command." },
{ "bar", ProcessBar, "The second command." },
{ "help", ProcessHelp, "Application help." }

};

//
// Read a process a command.
//
int
Test(void)
{

unsigned char pucCmd[256];

//
// Retrieve a command from the user into pucCmd.
//
...

//
// Process the command line.
//
return(CmdLineProcess(pucCmd));

}
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9.1 Introduction

The UART standard IO module provides a simple interface to a UART that is similar to the standard
IO package available in the C library. Only a very small subset of the normal functions are provided;
UARTprintf() is an equivalent to the C library printf() function and UARTgets() is an equivalent to
the C library fgets() function.

This module is contained in utils/uartstdio.c, with utils/uartstdio.h containing the API
definitions for use by applications.

9.1.1 Unbuffered Operation

Unbuffered operation is selected by not defining UART_BUFFERED when building the UART stan-
dard IO module. In unbuffered mode, calls to the module will not return until the operation has been
completed. So, for example, a call to UARTprintf() will not return until the entire string has be placed
into the UART’s FIFO. If it is not possible for the function to complete its operation immediately, it
will busy wait.

9.1.2 Buffered Operation

Buffered operation is selected by defining UART_BUFFERED when building the UART standard IO
module. In buffered mode, there is a larger UART data FIFO in SRAM that extends the size of the
hardware FIFO. Interrupts from the UART are used to transfer data between the SRAM buffer and
the hardware FIFO. It is the responsibility of the application to ensure that UARTStdioIntHandler()
is called when the UART interrupt occurs; typically this is accomplished by placing it in the vector
table in the startup code for the application.

In addition providing a larger UART buffer, the behavior of UARTprintf() is slightly modified. If the
output buffer is full, UARTprintf() will discard the remaining characters from the string instead of
waiting until space becomes available in the buffer. If this behavior is not desired, UARTFlushTx()
may be called to ensure that the transmit buffer is emptied prior to adding new data via UARTprintf()
(though this will not work if the string to be printed is larger than the buffer).

UARTPeek() can be used to determine whether a line end is present prior to calling UARTgets() if
non-blocking operation is required. In cases where the buffer supplied on UARTgets() fills before a
line termination character is received, the call will return with a full buffer.

Tue Oct 29 00:38:03 IST 2024 133



UART Standard IO Module

9.2 API Functions

9.3 Programming Example

The following example shows how to use the UART standard IO module to write a string to the
UART “console”.

//
// Configure the appropriate pins as UART pins; in this case, PA0/PA1 are
// used for UART0.
//
SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);
GPIOPinTypeUART(GPIO_PORTA_BASE, GPIO_PIN_0 | GPIO_PIN_1);

//
// Initialize the UART standard IO module.
//
UARTStdioInit(0);

//
// Print a string.
//
UARTprintf("Hello world!\n");
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A.1 Interrupt Hardware Priority Overview

With the PIE block enabled, the interrupts are prioritized in hardware by default as follows:
Global Priority (CPU Interrupt level):

CPU Interrupt Hardware Priority
Reset 1(Highest)
INT1 5
INT2 6
INT3 7
INT4 8
INT5 9
INT6 10
INT7 11
... ...
INT12 16
INT13 17
INT14 18
DLOGINT 19(Lowest)
RTOSINT 20
reserved 2
NMI 3
ILLEGAL -
USER1 -(Software Interrupts)
USER2 -
... ...

CPU Interrupts INT1 - INT14, DLOGINT and RTOSINT are maskable interrupts. These interrupts
can be enabled or disabled by the CPU Interrupt enable register (IER).

Group Priority (PIE Level):
If the Peripheral Interrupt Expansion (PIE) block is enabled, then CPU interrupts INT1 to INT12 are
connected to the PIE. This peripheral expands each of these 12 CPU interrupt into 8 interrupts.
Thus the total possible number of available interrupts in the PIE is 96. Note, not all of the 96 are
used on a 2806x device.

Each of the PIE groups has its own interrupt enable register (PIEIERx) to control which of the 8
interrupts (INTx.1 - INTx.8) are enabled and permitted to issue an interrupt.
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CPU PIE
Interrupt Group PIE Interrupts

Highest————–Hardware Priority Within the Group—————-Lowest
INT1 1 INT1.1 INT1.2 INT1.3 INT1.4 INT1.5 INT1.6 INT1.7 INT1.8
INT2 2 INT2.1 INT2.2 INT2.3 INT2.4 INT2.5 INT2.6 INT2.7 INT2.8
INT3 3 INT3.1 INT3.2 INT3.3 INT3.4 INT3.5 INT3.6 INT3.7 INT3.8

... etc ...

... etc ...
INT12 12 INT12.1 INT12.2 INT12.3 INT12.4 INT12.5 INT12.6 INT12.7 INT4.8

Table A.1: PIE Group Hardware Priority

A.2 F2806x Interrupt Priorities

The PIE block is organized such that the interrupts are in a logical order. Interrupts that typically
require higher priority, are organized higher up in the table and will thus be serviced with a higher
priority by default.

The interrupts in a 2806x system can be categorized as follows (ordered highest to lowest priority):

1. Non-Periodic, Fast Response
These are interrupts that can happen at any time and when they occur, they must be serviced
as quickly as possible. Typically these interrupts monitor an external event.

On the 2806x, such interrupts are allocated to the first few interrupts within PIE Group 1 and
PIE Group 2. This position gives them the highest priority within the PIE group. In addition,
Group 1 is multiplexed into the CPU interrupt INT1. CPU INT1 has the highest hardware
priority. PIE Group 2 is multiplexed into the CPU INT2 which is the 2nd highest hardware
priority.

2. Periodic, Fast Response
These interrupts occur at a known period, and when they do occur, they must be serviced as
quickly as possible to minimize latency. The A/D converter is one good example of this. The
A/D sample must be processed with minimum latency.

On the 2806x, such interrupts are allocated to the group 1 in the PIE table. Group 1 is
multiplexed into the CPU INT1. CPU INT1 has the highest hardware priority

3. Periodic
These interrupts occur at a known period and must be serviced before the next interrupt.
Some of the PWM interrupts are an example of this. Many of the registers are shadowed, so
the user has the full period to update the register values.

In the 2806x PIE module, such interrupts are mapped to group 2 - group 5. These groups
are multiplexed into CPU INT3 to INT5 (the ePWM and eCAP), which are the next lowest
hardware priority.

4. Periodic, Buffered
These interrupts occur at periodic events, but are buffered and hence the processor need
only service such interrupts when the buffers are ready to filled/emptied. All of the serial ports
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(SCI/ SPI/ I2C/ CAN/ McBSP) either have FIFOs or multiple mailboxes such that the CPU has
plenty of time to respond to the events without fear of losing data.

In the 2806x, such interrupts are mapped to INT6, INT8, and INT9, which are the next lowest
hardware priority.

A.3 Software Prioritization of Interrupts - The DSP28 Ex-
ample

The user will probably find that the PIE interrupts are organized where they should be for most
applications. However, some software prioritization may still be required for some applications.

Recall that the basic software priority scheme on the C28x works as follows:

Global Priority
This priority can be managed by manipulating the CPU IER register. This register controls the
16 maskable CPU interrupts (INT1 - INT16).

Group Priority
This can be managed by manipulating the PIE block interrupt enable registers (PIEIERx).
There is one PIEIERx per group and each control the 8-interrupts multiplexed within that group.

The DSP28 software prioritization of interrupt example demonstrates how to configure the Global
priority (via IER) and group priority (via PIEIERx) within an ISR in order to change the interrupt
service priority based on user assigned levels. The steps required to do this are:

1. Set the global priority
Modify the IER register to allow CPU interrupts with a higher user priority to be serviced.

2. Set the Group priority
Modify the appropriate PIEIERx register to allow group interrupts with a higher user set priority
to be serviced.

3. Enable interrupts

The DSP28 software prioritized interrupts example provides a method using mask values that are
configured during compile time to allow you to manage this easily.

To setup software prioritization for the DSP28 example, the user must first assign the desired global
priority levels and group priority levels.

This is done in the F2806x_SWPrioritizedIsrLevels.h file as follows:

1. User assigns global priority levels
INT1PL - INT16PL
These values are used to assign a priority level to each of the 16 interrupts controlled by the
CPU IER register. A value of 1 is the highest priority while a value of 16 is the lowest. More
then one interrupt can be assigned the same priority level. In this case the default hardware
priority would determine which would be serviced first. A priority of 0 is used to indicate that
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the interrupt is not used.

2. User assigns PIE group priority levels
GxyPL (where x = PIE group number 1 - 12 and y = interrupt number 1 - 8)

These values are used to assign a priority level to each of the 8 interrupts within a PIE group.
A value of 1 is the highest priority while a value of 8 is the lowest. More then one interrupt can
be assigned the same priority level. In this case the default hardware priority would determine
which would be serviced first. A priority of 0 is used to indicate that the interrupt is not used.

Once the user has defined the global and group priority levels, the compiler will generate mask
values that can be used to change the IER and PIEIERx registers within each ISR. In this manner
the interrupt software prioritization will be changed. The masks that are generated at compile time
are:

IER mask values
MINT1 - MINT16

The user assigned INT1PL - INT16PL values are used at compile time to calculate an IER
mask for each CPU interrupt. This mask value will be used within an ISR to allow CPU inter-
rupts with a higher priority to interrupt the current ISR and thus be serviced at a higher priority
level.

PIEIERxy mask values
MGxy (where x = PIE group number 1 - 12 and y = interrupt number 1 - 8)

The assigned group priority levels (GxyPL) are used at compile time to calculate PIEIERx
masks for each PIE group. This mask value will be used within an ISR to allow interrupts
within the same group that have a higher assigned priority to interrupt the current ISR and
thus be serviced at a higher priority level.

A.3.1 Using the IER/PIEIER Mask Values

Within an interrupt service routine, the global and group priority can be changed by software to
allow other interrupts to be serviced. The procedure for setting an interrupt priority using the mask
values created in the F2806x_SWPrioritizedIsrLevels.h is the following:

1. Set the global priority
Modify IER to allow CPU interrupts from the same PIE group as the current ISR.
Modify IER to allow CPU interrupts with a higher user defined priority to be serviced.

2. Set the group priority
Save the current PIEIERx value to a temporary register.
The PIEIER register is then set to allow interrupts with a higher priority within a PIE group
to be serviced.

3. Enable interrupts
Enable all PIE interrupt groups by writing all 1’s to the PIEACK register
Enable global interrupts by clearing INTM

4. Execute ISR. Interrupts that were enabled in steps 1-3 (those with a higher software priority)
will be allowed to interrupt the current ISR and thus be serviced first.
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5. Restore the PIEIERx register
6. Exit

A.3.2 Example Code

The sample C code below shows an EV-A Comparator 1 Interrupt service routine software
prioritization written in C. This interrupt is connected to PIE group 2 interrupt 1.

//
// EPWM1_TZINT_ISR - EPWM1 Trip Zone is connected to PIEIER2_1
// (use MINT2 and MG21 masks)
//
#if (G21PL != 0)
interrupt void
EPWM1_TZINT_ISR(void)
{

//
// Set interrupt priority
//
volatile Uint16 TempPIEIER = PieCtrlRegs.PIEIER2.all;
IER |= M_INT2;
IER &= MINT2; // Set "global" priority
PieCtrlRegs.PIEIER2.all &= MG21; // Set "group" priority
PieCtrlRegs.PIEACK.all = 0xFFFF; // Enable PIE interrupts
EINT;

//
// Insert ISR Code here
//

//
// for now just insert a delay
//
for(i = 1; i <= 10; i++)
{

}

//
// Restore registers saved
//
DINT;
PieCtrlRegs.PIEIER2.all = TempPIEIER;

//
// Add ISR to Trace
//
ISRTrace[ISRTraceIndex] = 0x0021;
ISRTraceIndex++;

}
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#endif

CMP1INT_ISR:
ASP
ADDB SP,#1
CLRC OVM,PAGE0
MOVW DP,#0x0033
MOV AL,@36
MOV *-SP[1],AL
OR IER,#0x0002
AND IER,#0x0002
AND @36,#0x000E
MOV @33,#0xFFFF
CLRC INTM

User code goes here...

SETC INTM
MOV AL,*-SP[1]
MOV @36,AL
SUBB SP,#1
NASP
IRET

The interrupt latency is approx 22 cycles.

/∗!
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B.1 Introduction

To compensate the internal oscillator, the Texas Instruments factory takes measurements of the
internal oscillator and temperature sensor. It then calculates a reference point for the temperature
sensor and oscillator trim and calculates an oscillator trim slope. The trim slope can be used
to adjust the oscillator fine trim as the temperature sensor reading moves away from that of the
reference point.

The reference point for the internal oscillator consists of two pieces of data. The first is the temper-
ature sensor reading at that point. The second is the oscillator trim values to get 10.0MHz at that
temperature. This trim itself is composed of two parts: the fine trim and the coarse trim. Only the
fine trim will be adjusted by the compensation procedure. The coarse trim remains the same no
matter what temperature the device is at.

The oscillator compensation slope contains the information needed to adjust the oscillator fine trim
from the reference fine trim as the temperature moves away from the reference temperature. This
slope has the units of oscillator fine trim steps / ADC codes (temperature sensor output).

If X is considered to be the temperature sensor reading and Y is considered to be the oscillator fine
trim, then the basic oscillator compensation equation is

Y1 = m ∗ (X1 −X0) + Y0 (B.1)

where,
Y1 is the oscillator fine trim at the current temperature
Y0 is the oscillator fine trim at the reference temperature
X1 is the temperature sensor reading at the current temperature
X0 is the temperature sensor reading at the reference temperature
m is the oscillator compensation slope, which is change in oscillator fine trim

change in temperature sensor reading

This is equivalent to a line with equation Y = mX + b:
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Figure B.1: Oscillator Reference

Figure B.2: Oscillator Fine Trim Compensation for change in Temperature
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B.2 Oscillator Compensation Functions Available in the
Header Files and Peripheral Examples Package

B.2.1 OTP Functions

The following functions in DSP<Device>_OscComp.c are programmed in OTP and return variables
stored in OTP used for oscillator compensation.

Function Call: getRefTempOffset()
OTP address: 0x3D7EA2
Returns: Reference Temperature Offset
This is the temperature sensor reading of the reference point for oscillator compensation.

Function Call: getOsc1FineTrimOffset()
OTP address: 0x3D7E93
Returns: Oscillator 1 Fine Trim Offset
This is the fine trim of the reference point for oscillator 1. This is the fine trim required to get
10.0MHz when the temperature sensor reads the value of “High Temperature Offset”.

Function Call: getRefTempOffset()
OTP address: 0x3D7EA2
Returns: Reference Temperature Offset

Function Call: getOsc2FineTrimOffset ()
OTP address: 0x3D7E9C
Returns: Oscillator 2 Fine Trim Offset
This is the fine trim of the reference point for oscillator 2. This is the fine trim required to get
10.0MHz when the temperature sensor reads the value of “High Temperature Offset”.

Function Call: getOsc1FineTrimSlope()
OTP address: 0x3D7E90
Returns: Oscillator 1 Fine Trim Slope
This is the slope of the oscillator temperature characteristic determined by the factory for internal
oscillator 1. Units are oscillator fine trim steps / ADC codes (temperature sensor output). This
variable is stored as a Q0.15 fixed point number - e.g. if the slope = -0.04, then this value is stored
as -0.04*(215) = -1311. Note that this will require us to use fixed point math to compensate the
oscillator.

Function Call: getOsc2FineTrimSlope()
OTP address: 0x3D7E99
Returns: Oscillator 2 Fine Trim Slope
This is the slope of the oscillator temperature characteristic determined by the factory for internal
oscillator 2. Units are oscillator fine trim steps / ADC codes (temperature sensor output). This
variable is stored as a Q0.15 fixed point number - e.g. if the slope = -0.04, then this value is stored
as -0.04*(215) = -1311. Note that this will require us to use fixed point math to compensate the
oscillator.
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Function Call: getOsc1CoarseTrim()
OTP address: 0x3D7E96
Returns: Oscillator 1 Coarse Trim
This is the coarse trim to always use for oscillator 1 when doing oscillator compensation.

Function Call: getOsc2CoarseTrim()
OTP address: 0x3D7E9F
Returns: Oscillator 2 Coarse Trim
This is the coarse trim to always use for oscillator 2 when doing oscillator compensation.

B.2.2 Oscillator Compensation User Functions

The following functions use the ADC temperature sensor sample as a parameter and update the
internal oscillator coarse and fine trim value while compensating for temperature. These functions
can be called directly via user application code.

Function Call: Osc1Comp(int16 sensorSample)
This function uses the temperature sensor sample reading to perform internal oscillator 1 compen-
sation with reference values stored in OTP.

Function Call: Osc2Comp(int16 sensorSample)
This function uses the temperature sensor sample reading to perform internal oscillator 2 compen-
sation with reference values stored in OTP.
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C.1 Introduction

This document describes the updates to the Scale Factor Optimization (SFO) V6 library files
packaged with the C/C++ Header Files and Peripheral Examples software package.

The updates are applicable to the following files:

SFO_TI_Build_V6x.lib (where “x” represents the alphabetical revision letter of the library).

SFO_V6.h

C.2 Library Change Overview

Table C.1 lists the change(s) made to each library revision.

REVISION CHANGES MADE
0 Original library release
b Changes:

Library re-released as
SFO_TI_Build_V6b.lib

Errors Fixed:
The SFO_V6() function now properly
updates the HRMSTEP register with
MEP_ScaleFactor after calibration is
complete.

Table C.1: SFO Library V6 Change Overview

C.3 Known Advisories in Library Versions

Table C.2 lists the known advisories in early library revisions and workarounds required in user
code to account for these errors.
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Advisory HRMSTEP Register not Updated with calculated
MEP_ScaleFactor

Revision(s) Affected 0
Details The library function, SFO_V6(), does not prop-

erly update the HRMSTEP register with the
newly calculated MEP_ScaleFactor value after
SFO_COMPLETE status has been reached.

Workaround After SFO_COMPLETE status has been reached
on a call to SFO_V6(), user must manually update
the HRMSTEP register with the newly calculated
MEP_ScaleFactor Value.

Example:

if (SFO_V6(n)==SFO_COMPLETE) {
EALLOW;
EPwm1Regs.HRMSTEP = MEP_ScaleFactor;
EDIS;

}

Table C.2: SFO V6 Library Advisories in Early Software Revisions
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